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Preface 

This document contains information regarding the installation of the following products: Oracle 
Transportation Management, Global Trade Management, Fusion Transportation Intelligence and Oracle 

In-Memory Logistics Command Center. There are additional, Logistics Command Center-specific 
installation instructions detailed in the Logistics Command Center Installation Guide. This manual does 
not cover the installation of the operating system, any other Oracle components (e.g. the Oracle 
database or Oracle HTTP Server) or any third-party components (e.g. a third-party rating engine). 

Change History 

Date Document Revision Summary of Changes 

12/2012 -01 Initial Release. 

02/2013 -02 Updated database init parameters in the section “Initial 
Parameters” 

Updated FTI installation section based on issues seen by 
customers and support. 

06/2013 -03 Added instructions for installing In-Memory Logistics Command 
Center. 

07/2013 -04 Added new FTI section titled Creating Business Intelligence Roles 
in OBIEE 

Added new FTI section called Deploying Multiple RPDs in a Single 
OBIEE11g  

Add information about property glog.security.userSession.enabled 
to the FTI installation section. 

Added information on setting up FTI with a RAC database. Add 
new steps the ODI and OBIEE configuration sections. 

Added new section on Manually Merging FTI and OBIA. 

Added new chapter 6: Integrating with Oracle E-Business Suite 
Financials 

Update section titled Installing Other Languages for Oracle FTI 

Reports with new file paths for OBIEE 11g. 
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Date Document Revision Summary of Changes 

12/2013 -05 Updated for 6.3.3. 

Added information about GTI. 

Added note about downloading JAXP. 

Removed PART_5 from the list of required tablespaces in the 
"Required Tablespaces for OTM Database" section. 

Added new section titled Installing Global Trade Intelligence 
(GTI). 

Updated section Installing Fusion Transportation Intelligence 
(FTI) to include new properties and new VPD profile information. 

Removed section titled Installing Other Languages for Oracle GTI 
Reports since translations for GTI reports are not available in 6.3. 
They will be available in a later release. 

05/2014 -06 Updated for 6.3.4 

Added new subsection Creating New GTI Reports in Installing 
Global Trade Intelligence (GTI) chapter. 

Note added to AIX software installation section that KSH93 needs 
to be linked to /bin/ksh. 

Added new sub-section to Installing Oracle Fusion Transportation 
Intelligence (FTI) titled Creating New FTI Reports. Also added 

new sentence to aa_webserver property in the section OTM 
Properties. 

Added new sub-section to Installing Oracle Global Trade 
Intelligence (GTI) titled Creating New GTI Reports. Also added 
new sentence to aa_webserver property in the section OTM 

Properties. 

09/2014 -07 Added DB user: DIR_XML_USER 

Updated the Archive Setup section. 

Added the following note to both the FTI section Installing Oracle 
Data Integrator (ODI) and GTI section Installing Oracle Data 
Integrator (ODI): 

Note: Installing the ODI agent in the database tier provides 
better performance than installing it in the application tier. 

12/2014 -08 Updated for 6.3.6 by adjusting the results in the Verify Database 
Structure section. 

03/2015 -09 Updated for 6.3.7 by adjusting the results in the Verify Database 
Structure section. 
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1. Installation Requirements 

Oracle Enterprise Linux Installation Requirements 

It is HIGHLY recommended that you make available personnel who are familiar with the installation 

and configuration of UNIX based applications. Also, it is recommended that you have an administrator 
familiar with the creation and support of Oracle Database instances. A Network Administrator may be 
necessary at times, especially during the configuration of systems that will be accessed through 
firewalls, VPN, etc. 

You must run the installer as a non-root user, though root access may be required to start the 
application (see the Oracle Transportation Management Security Guide for more info on Privileged 

Ports). The user that runs the installer must have full rights to the installation directory. 

Red Hat Linux 

Red Hat AS/ES 5 & 6 are also supported platforms, but OTM has not been certified on them. In this 
guide, wherever Oracle Enterprise Linux Server release 5 or 6 is referenced, simply replace it with Red 
Hat AS/ES 5 or 6. Any Red Hat-only instructions will be clearly marked as such. 

Minimum Hardware Requirements 

Note: This section only details the minimum hardware required to run the base OTM 

application. It does not take into account additional OTM components or third-party 
components and it is not a configuration for high volume or complex implementations. To 

determine the correct configuration for your production, test, and development 

environments, you should work with your hardware and/or implementation consultants. 

Web User 

You must have a computer capable of running one of the supported browsers (see the Oracle 
Transportation Management Technical Architecture Guide for a list of supported browsers). Many 

factors will affect the performance experience of the end-user, including: CPU type & speed, operating 
system version, available memory, hard drive speed, network card speed, and network bandwidth 
between the browser and the web server. 

Note: Popup Blockers may prevent your browser from working correctly with OTM. If you 

experience any problems, try disabling them before contacting Technical Support. 

Note: If you want to view the results generated by the Load Configuration feature, a VRML 
plug-in for your Web Browser is needed. OTM has been tested with the Cortona plug-in for 

Internet Explorer, available at: www.cortona3d.com/Products/Viewer/Cortona-3D-
Viewer.aspx. 

Test and Development Server 

 Combined Web & App: 2 x 3.0 GHz dual-core Xeon CPU, 12 GB RAM, 80 GB disk. 

Note: For the database server, please see the documentation associated with that product. 

Production Servers 

 Web Server: 2 x 2.5 GHz quad-core Xeon CPU w/ 18 MB cache, 8 GB RAM, 80 GB disk. 

 Application Server: 2 x 2.5 GHz quad-core Xeon CPU w/ 18 MB cache, 12 GB RAM, 80 GB disk. 

Note: For the database server, please see the documentation associated with that product. 
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Software Requirements 

 64-bit Oracle Enterprise Linux Server 5.5 or later with the latest recommended patches, OR 

 64-bit Oracle Enterprise Linux Server 6 or later with the latest recommended patches 

 Oracle 11gR2 (11.2.x) Database Enterprise Edition 

o a standard installation is required 

 Oracle WebLogic Server Standard Edition 11gR1 (10.3.6.x) 

o a standard installation is required 

 Oracle WebLogic HTTP Server 11gR1 (11.1.1.6+) 

o a standard installation is required 

 Integration Server - EAI solution (optional) 

The following additional software is distributed with OTM: 

 Tomcat Java Servlet Server 7.0.47 

 64-bit JRockit JDK 1.6.0_65 (R28.2.9) 

Preparing to Install OTM 

Before you begin the installation process, ensure that the following is complete: 

 A compatible operating system is installed (see above) along with any patch bundles 

recommended by the OS vendor. 

 The size of the swap space on your server is equal to or greater than the amount of memory it 

contains. 

 All OTM servers are time-synced using a process like NTP. This is critical to the proper 

operation and troubleshooting of an OTM instance. 

 Oracle 11gR2 (11.2.x) Database Client (Administrator install) has been installed and 

configured to connect to your database. 

Pre-Install Setup 

1. Update kernel parameters as needed for the Database Client. This is covered in the Oracle 

Database installation documentation. Restart the server. 

Installing WebLogic on the Application Server 

Install WebLogic Server version 11gR1 as per its documentation. Note the BEA Home directory (e.g. 
/opt/bea) and the WL Home directory (e.g. /opt/bea/weblogic11g). 

Note: The user that OTM runs as must have read access to the WebLogic install directory 

and all of its sub-directories. 

Installing Oracle HTTP Server on the Web Server 

Install Oracle HTTP Server version 11gR1 as per its documentation. Note the BEA Home directory (e.g. 

/opt/bea) and the Oracle HTTP Server Home directory (e.g. /opt/bea/Oracle_WT1). 

Note: The user that OTM runs as must have read access to the Oracle HTTP Server install 
directory and all of its sub-directories. 

In addition, after Oracle HTTP Server (OHS) is installed, an OHS instance needs to be created for use 
with the OTM Web instance; please see the OHS documentation for more information on how to do 
that. Note the OHS Instance Name (e.g. instance1) and the OHS Component Name (e.g. otm635) 

created during this process, along with the port number OHS is listening on (which can be found in the 
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$OHS/instances/instance1/config/OHS/otm635/httpd.conf file, where $OHS, instance1 and 

otm635 are, respectively, the OHS Home directory, OHS Instance Name and OHS Component Name 

noted earlier). 

Installing OTM 

Follow the instructions in the Installing OTM chapter to finish your OTM installation.  

Solaris Installation Requirements 

It is HIGHLY recommended that you make available personnel who are familiar with the installation 
and configuration of UNIX based applications. Also, it is recommended that you have an administrator 
familiar with the creation and support of Oracle Database instances. A Network Administrator may be 

necessary at times, especially during the configuration of systems that will be accessed through 
firewalls, VPN, etc. 

You must run the installer as a non-root user, though root access may be required to start the 
application (see the Oracle Transportation Management Security Guide for more info on Privileged 
Ports). The user that runs the installer must have full rights to the installation directory. 

Minimum Hardware Requirements 

Note: This section only details the minimum hardware required to run the base OTM 

application. It does not take into account additional OTM components or third-party 

components and it is not a configuration for high volume or complex implementations. To 
determine the correct configuration for your production, test, and development 

environments, you should work with your hardware and/or implementation consultants. 

Web User 

You must have a computer capable of running one of the supported browsers (see the Oracle 

Transportation Management Technical Architecture Guide for a list of supported browsers). Many 
factors will affect the performance experience of the end-user, including: CPU type & speed, operating 
system version, available memory, hard drive speed, network card speed, and network bandwidth 
between the browser and the web server. 

Note: Popup Blockers may prevent your browser from working correctly with OTM. If you 

experience any problems, try disabling them before contacting Technical Support. 

Note: If you want to view the results generated by the Load Configuration feature, a VRML 
plug-in for your Web Browser is needed. OTM has been tested with the Cortona plug-in for 
Internet Explorer, available at: www.cortona3d.com/Products/Viewer/Cortona-3D-
Viewer.aspx. 

Test and Development Servers – Solaris SPARC 

 Combined Web & App: 1 x 2.85 GHz eight-core SPARC T4-1 w/4 MB cache, 12 GB RAM, 80 GB 

disk space. 

Note: For the database server, please see the documentation associated with that product. 

Production Servers – Solaris SPARC 

 Web Server: 1 x 2.85 GHz eight-core SPARC T4-1 w/4 MB cache, 8 GB RAM, 80 GB disk 

space. 
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 Application Server: 1 x 2.85 GHz eight-core SPARC T4-1 w/4 MB cache, 12 GB RAM, 80 GB 

disk space. 

Note: For the database server, please see the documentation associated with that product. 

Test and Development Server – Solaris x86 

 Combined Web & App: 2 x 3.0 GHz dual-core Xeon CPU, 6 GB RAM, 80 GB disk. 

Note: For the database server, please see the documentation associated with that product. 

Production Servers – Solaris x86 

 Web Server: 2 x 2.5 GHz quad-core Xeon CPU w/ 18 MB cache, 6 GB RAM, 80 GB disk. 

 Application Server: 2 x 2.5 GHz quad-core Xeon CPU w/ 18 MB cache, 8 GB RAM, 80 GB disk. 

Note: For the database server, please see the documentation associated with that product. 

Software Requirements 

 64-bit Solaris 10 or 11 with the latest recommended patches 

o Solaris 10: OTM only supports the SPARC architecture 

o Solaris 11: OTM supports both SPARC and x86 architectures 

 Oracle 11gR2 (11.2.x) Database Enterprise Edition 

o a standard installation is required 

 Oracle WebLogic Server Standard Edition 11gR1 (10.3.6.x) 

o a standard installation is required 

 Oracle WebLogic HTTP Server 11gR1 (11.1.1.6+) 

o a standard installation is required 

 Integration Server - EAI solution (optional) 

 

The following additional software is distributed with OTM: 

 Tomcat Java Servlet Server 7.0.47 

 64-bit HotSpot 1.6.0_45 (20.45-b01) 

Preparing to Install OTM 

Before you begin the installation process, ensure that the following is complete: 

 A compatible operating system is installed (see above) along with any patch bundles 

recommended by the OS vendor. 

 The size of the swap space on your server is equal to or greater than the amount of memory it 

contains. 

 All OTM servers are time-synced using a process like NTP. This is critical to the proper 

operation and troubleshooting of an OTM instance. 

 Oracle 11gR2 (11.2.x) Database Client (Administrator install) has been installed and 

configured to connect to your database. 

Pre-Install Setup 

1. Update kernel parameters as needed for the Database Client. This is covered in the Oracle 

Database installation documentation. Restart the server. 
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Installing WebLogic on the Application Server 

Install WebLogic Server version 11gR1 as per its documentation. Note the BEA Home directory (e.g. 
/opt/bea) and the WL Home directory (e.g. /opt/bea/weblogic11g). 

Note: The user that OTM runs as must have read access to the WebLogic install directory 

and all of its sub-directories. 

Installing Oracle HTTP Server on the Web Server 

Install Oracle HTTP Server version 11gR1 as per its documentation. Note the BEA Home directory (e.g. 
/opt/bea) and the Oracle HTTP Server Home directory (e.g. /opt/bea/Oracle_WT1). 

Note: The user that OTM runs as must have read access to the Oracle HTTP Server install 

directory and all of its sub-directories. 

In addition, after Oracle HTTP Server (OHS) is installed, an OHS instance needs to be created for use 
with the OTM Web instance; please see the OHS documentation for more information on how to do 
that. Note the OHS Instance Name (e.g. instance1) and the OHS Component Name (e.g. otm635) 

created during this process, along with the port number OHS is listening on (which can be found in the 
$OHS/instances/instance1/config/OHS/otm635/httpd.conf file, where $OHS, instance1 and 

otm635 are, respectively, the OHS Home directory, OHS Instance Name and OHS Component Name 

noted earlier). 

Installing OTM 

Follow the instructions in the Installing OTM chapter to finish your OTM installation.  

Windows 2008/2012 Server Installation Requirements 

It is HIGHLY recommended that you make available personnel who are familiar with the installation 

and configuration of Windows-based applications. It is also recommended that you have an 
administrator familiar with the creation and support of Oracle Database instances. A Network 

Administrator may be necessary at times, especially during the configuration of systems that will be 
accessed through firewalls, VPN, etc. 

You must be logged in as Administrator or someone with Administrative privileges to install OTM 
successfully. 

Minimum Hardware Requirements 

Note: This section only details the minimum hardware required to run the base OTM 

application. It does not take into account additional OTM components or third-party 

components and it is not a configuration for high volume or complex implementations. To 
determine the correct configuration for your production, test, and development 

environments, you should work with your hardware and/or implementation consultants. 

Web User 

You must have a computer capable of running one of the supported browsers (see the Oracle 

Transportation Management Technical Architecture Guide for a list of supported browsers). Many 
factors will affect the performance experience of the end-user, including: CPU type & speed, operating 
system version, available memory, hard drive speed, network card speed, and network bandwidth 
between the browser and the web server. 
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Note: Popup Blockers may prevent your browser from working correctly with OTM. If you 

experience any problems, try disabling them before contacting Technical Support. 

Note: If you want to view the results generated by the Load Configuration feature, a VRML 
plug-in for your Web Browser is needed. OTM has been tested with the Cortona plug-in for 

Internet Explorer, available at: www.cortona3d.com/Products/Viewer/Cortona-3D-
Viewer.aspx. 

Test and Development Servers 

 Combined Web & App: 2 x 3.0 GHz dual-core Xeon CPU, 12 GB RAM, 80 GB disk 

Note: For the database server, please see the documentation associated with that product. 

Production Servers 

 Web Server: 2 x 2.5 GHz quad-core Xeon CPU w/ 18 MB cache, 8 GB RAM, 80 GB disk. 

 Application Server: 2 x 2.5 GHz quad-core Xeon CPU w/ 18 MB cache, 12 GB RAM, 80 GB disk. 

Note: For the database server, please see the documentation associated with that product. 

Software Requirements for OTM Server Configurations 

 64-bit Windows Server 2012 Datacenter Edition with the latest Service Packs, OR 

 64-bit Windows Server 2012 Standard Edition with the latest Service Packs, OR 

 64-bit Windows Server 2008 R2 Enterprise x64 Edition with the latest Service Packs, OR 

 64-bit Windows Server 2008 Standard Edition with the latest Service Packs 

 Oracle 11gR2 (11.2.x) Database Enterprise Edition 

o a standard installation is required 

 Oracle WebLogic Server Standard Edition 11gR1 (10.3.6.x) 

o a standard installation is required 

 Oracle WebLogic HTTP Server 11gR1 (11.1.1.6+) 

o a standard installation is required 

 Integration Server - EAI solution (optional) 

 

The following additional software is distributed with OTM: 

 Tomcat Java Servlet Server 7.0.47 

 64-bit JRockit JDK 1.6.0_65 (R28.2.9) 

Preparing to Install OTM 

Before you begin the installation process, ensure that the following is already complete: 

 A compatible operating system is installed (see above) and configured for high performance. 

 Virtual memory is set to 1.5 to 2 times the amount of physical memory in the system. 

 All OTM server machines are time-synced using a process like NTP. This is critical to the 

proper operation and troubleshooting of an OTM instance. 

 Oracle 11gR2 (11.2.x) Database client (Administrator install) has been installed and 

configured to connect to your database. 
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Installing WebLogic on the Application Server 

Install WebLogic Server version 11gR1 as per its documentation. Note the BEA Home directory (e.g. 
D:\product\bea) and the WL Home directory (e.g. D:\product\bea\weblogic11g). 

Note: The user that OTM runs as must have read access to the WebLogic install directory 

and all of its sub-directories. 

Installing Oracle HTTP Server on the Web Server 

Install Oracle HTTP Server version 11gR1 as per its documentation. Note the BEA Home directory (e.g. 
D:\product\bea) and the Oracle HTTP Server Home directory (e.g. D:\product\bea\Oracle_WT1). 

Note: The user that OTM runs as must have read access to the Oracle HTTP Server install 

directory and all of its sub-directories. 

In addition, after Oracle HTTP Server (OHS) is installed, an OHS instance needs to be created for use 

with the OTM Web instance; please see the OHS documentation for more information on how to do 
that. Note the OHS Instance Name (e.g. instance1) and the OHS Component Name (e.g. otm635) 

created during this process, along with the port number OHS is listening on (which can be found in the 
$OHS/instances/instance1/config/OHS/otm635/httpd.conf file, where $OHS, instance1 and 

otm635 are, respectively, the OHS Home directory, OHS Instance Name and OHS Component Name 

noted earlier). 

Installing OTM 

Follow the instructions in the Installing OTM chapter to finish your OTM installation. You must be 
logged in as Administrator or someone with Administrative privileges to install OTM successfully. 

AIX Installation Requirements 

It is HIGHLY recommended that you make available personnel who are familiar with the installation 
and configuration of UNIX based applications. Also, it is recommended that you have an administrator 
familiar with the creation and support of Oracle Database instances. A Network Administrator may be 

necessary at times, especially during the configuration of systems that will be accessed through 
firewalls, VPN, etc. 

You must run the installer as a non-root user, though root access may be required to start the 
application (see the Oracle Transportation Management Security Guide for more info on Privileged 
Ports). The user that runs the installer must have full rights to the installation directory. 

Minimum Hardware Requirements 

Web User 

You must have a computer capable of running one of the supported browsers (see the Oracle 

Transportation Management Technical Architecture document for a list of supported browsers). Many 
factors will affect the performance experience of the end-user, including: CPU type & speed, operating 

system version, available memory, hard drive speed, network card speed, and network bandwidth 
between the browser and the web server. 

Note: Popup blockers may prevent your browser from working correctly with OTM. If you 

experience any problems, try disabling them before contacting Technical Support. 

Note: If you want to view the results generated by the Load Configuration feature, a VRML 
plug-in for your Web Browser is needed. OTM has been tested with the Cortona plug-in for 



Copyright © 2001, 2015, Oracle and/or its affiliates. All rights reserved. 1-8 

Internet Explorer, available at: www.cortona3d.com/Products/Viewer/Cortona-3D-

Viewer.aspx. 

Test, Development and Production Servers 

Please consult the hardware vendor for more information on hardware sizing. 

Software Requirements 

 64-bit AIX 7.1 with the latest recommended patches 

o Korn shell version 93 or later linked to /bin/ksh 

 Oracle 11gR2 (11.2.x) Database Enterprise Edition 

o a standard installation is required 

 Oracle WebLogic Server Standard Edition 11gR1 (10.3.6.x) 

o a standard installation is required 

 Oracle WebLogic HTTP Server 11gR1 (11.1.1.6+) 

o a standard installation is required 

 Integration Server - EAI solution (optional) 

 Java 1.6 JDK 

The following additional software is distributed with OTM: 

 Tomcat Java Servlet Server 7.0.47 

Preparing to Install OTM 

Before you begin the installation process, ensure that the following is complete: 

 A compatible operating system is installed (see above) along with any patch bundles 

recommended by the OS vendor. 

 The size of the swap space on your server is equal to or greater than the amount of memory it 

contains. 

 All OTM servers are time-synced using a process like NTP. This is critical to the proper 

operation and troubleshooting of an OTM instance. 

 Oracle 11gR2 (11.2.x) Database Client (Administrator install) has been installed and 

configured to connect to your database. 

 Java Development Kit 1.6 (see note below). 

Java Development Kit (JDK) 

Oracle does not provide a JDK for this platform, but it is necessary to run the application; this will 
need to be obtained by you and installed onto the system prior to OTM being installed. A full JDK is 
required; a simple Java Runtime Environment (JRE) will not suffice. The installation directory for the 
JDK will need to be supplied to the OTM installer. Although the OTM installer will check to make sure 

the programs exist and are executable, it will not check that the correct version is installed. The 
application will fail to run unless the proper JDK version is supplied. The OTM installer will create a 
symbolic link from this supplied directory to one name “jdk” inside of the OTM install directory. 

Note: Unlike other JDK vendors, IBM does not ship a library needed by the application. For 

each web server, after installing the IBM JDK (but before installing the application) please 
do the following: 

1. Go to http://jaxp.java.net and download JAXP 1.4.6 

2. Extract the contents of the JAR file, e.g.: 
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$ CLASSPATH= java –jar JAXP_146.jar 

3. Get the jaxp-ri.jar file from the lib directory and copy it to the 

<otm_install_dir>/glog/gc3webapp/WEB-INF/lib/3rdparty directory 

4. Proceed with the standard application installation. 

Pre-Install Setup 

1. Update kernel parameters as needed for the Database Client. This is covered in the Oracle 

Database installation documentation. Restart the server. 

Installing WebLogic on the Application Server 

Install WebLogic Server version 11gR1 as per its documentation. Note the BEA Home directory (e.g. 
/opt/bea) and the WL Home directory (e.g. /opt/bea/weblogic11g). 

Note: The user that OTM runs as must have read access to the WebLogic install directory 

and all of its sub-directories. 

Installing Oracle HTTP Server on the Web Server 

Install Oracle HTTP Server version 11gR1 as per its documentation. Note the BEA Home directory (e.g. 
/opt/bea) and the Oracle HTTP Server Home directory (e.g. /opt/bea/Oracle_WT1). 

Note: The user that OTM runs as must have read access to the Oracle HTTP Server install 

directory and all of its sub-directories. 

In addition, after Oracle HTTP Server (OHS) is installed, an OHS instance needs to be created for use 
with the OTM Web instance; please see the OHS documentation for more information on how to do 

that. Note the OHS Instance Name (e.g. instance1) and the OHS Component Name (e.g. otm635) 

created during this process, along with the port number OHS is listening on (which can be found in the 
$OHS/instances/instance1/config/OHS/otm635/httpd.conf file, where $OHS, instance1 and 

otm635 are, respectively, the OHS Home directory, OHS Instance Name and OHS Component Name 

noted earlier). 

Installing OTM 

Follow the instructions in the Installing OTM chapter to finish your OTM installation.  

HP-UX Installation Requirements 

It is HIGHLY recommended that you make available personnel who are familiar with the installation 
and configuration of UNIX based applications. Also, it is recommended that you have an administrator 
familiar with the creation and support of Oracle Database instances. A Network Administrator may be 
necessary at times, especially during the configuration of systems that will be accessed through 
firewalls, VPN, etc. 

You must run the installer as a non-root user, though root access may be required to start the 
application (see the Oracle Transportation Management Security Guide for more info on Privileged 
Ports). The user that runs the installer must have full rights to the installation directory. 

Minimum Hardware Requirements 

Web User 

You must have a computer capable of running one of the supported browsers (see the Oracle 
Transportation Management Technical Architecture Guide for a list of supported browsers). Many 
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factors will affect the performance experience of the end-user, including: CPU type & speed, operating 

system version, available memory, hard drive speed, network card speed, and network bandwidth 
between the browser and the web server. 

Note: Popup blockers may prevent your browser from working correctly with OTM. If you 

experience any problems, try disabling them before contacting Technical Support. 

Note: If you want to view the results generated by the Load Configuration feature, a VRML 
plug-in for your Web Browser is needed. OTM has been tested with the Cortona plug-in for 
Internet Explorer, available at: www.cortona3d.com/Products/Viewer/Cortona-3D-
Viewer.aspx. 

Test, Development and Production Servers 

Please consult the hardware vendor for more information on hardware sizing. 

Software Requirements 

 64-bit HP-UX 11iv3 with the latest recommended patches 

 Oracle 11gR2 (11.2.x) Database Enterprise Edition 

o a standard installation is required 

 Oracle WebLogic Server Standard Edition 11gR1 (10.3.6.x) 

o a standard installation is required 

 Oracle WebLogic HTTP Server 11gR1 (11.1.1.6+) 

o a standard installation is required 

 Integration Server - EAI solution (optional) 

 

The following additional software is distributed with OTM: 

 Tomcat Java Servlet Server 7.0.47 

Preparing to Install OTM 

Before you begin the installation process, ensure that the following is complete: 

 A compatible operating system is installed (see above) along with any patch bundles 

recommended by the OS vendor. 

 The size of the swap space on your server is equal to or greater than the amount of memory it 

contains. 

 All OTM servers are time-synced using a process like NTP. This is critical to the proper 

operation and troubleshooting of an OTM instance. 

 Oracle 11gR2 (11.2.x) Database Client (Administrator install) has been installed and 

configured to connect to your database. 

 Java Development Kit 1.6 (see note below) 

Java Development Kit (JDK) 

Oracle does not provide a JDK for this platform, but it is necessary to run the application; this will 
need to be obtained by you and installed onto the system prior to OTM being installed. A full JDK is 
required; a simple Java Runtime Environment (JRE) will not suffice. The installation directory for the 
JDK will need to be supplied to the OTM installer. Although the OTM installer will check to make sure 
the programs exist and are executable, it will not check that the correct version is installed. The 

application will fail to run unless the proper JDK version is supplied. The OTM installer will create a 
symbolic link from this supplied directory to one name “jdk” inside of the OTM install directory. 
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Pre-Install Setup 

1. Update kernel parameters as needed for the Database Client. This is covered in the Oracle 

Database installation documentation. Restart the server. 

Installing WebLogic on the Application Server 

Install WebLogic Server version 11gR1 as per its documentation. Note the BEA Home directory (e.g. 
/opt/bea) and the WL Home directory (e.g. /opt/bea/weblogic11g). 

Note: The user that OTM runs as must have read access to the WebLogic install directory 

and all of its sub-directories. 

Installing Oracle HTTP Server on the Web Server 

Install Oracle HTTP Server version 11gR1 as per its documentation. Note the BEA Home directory (e.g. 
/opt/bea) and the Oracle HTTP Server Home directory (e.g. /opt/bea/Oracle_WT1). 

Note: The user that OTM runs as must have read access to the Oracle HTTP Server install 
directory and all of its sub-directories. 

In addition, after Oracle HTTP Server (OHS) is installed, an OHS instance needs to be created for use 
with the OTM Web instance; please see the OHS documentation for more information on how to do 
that. Note the OHS Instance Name (e.g. instance1) and the OHS Component Name (e.g. otm635) 

created during this process, along with the port number OHS is listening on (which can be found in the 
$OHS/instances/instance1/config/OHS/otm635/httpd.conf file, where $OHS, instance1 and 

otm635 are, respectively, the OHS Home directory, OHS Instance Name and OHS Component Name 

noted earlier). 

Installing OTM 

Follow the instructions in the Installing OTM chapter to finish your OTM installation.
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2. Installing OTM 

It is HIGHLY recommended that you make available personnel who are familiar with the installation 
and configuration of Windows or UNIX based applications (depending on operating system you are 

installing on.) Also, we recommend that, in the case of the Oracle Database, that you have on hand an 
administrator familiar with the creation and support of Oracle Database instances. A Network 
Administrator may be necessary at times – especially during the configuration of systems that will be 
accessed through firewalls, VPN, etc. 

Note: Sections below that contain operating system-specific options are marked with 

[AIX], [Linux], etc. 

Multiple Products, Single Installer 

The Oracle Transportation Management installer can be used to install many different products, 

depending on what software you have licensed. These products can be broken into the following broad 
family groups: Oracle Transportation Management, Global Trade Management and Logistics Command 
Center. All of these product families, and the products under them, share a single installer binary and 
you will be prompted to tell the installer which product you will be installing. Unless specifically noted, 
all options below pertain to all products. 

Note: Sections below that contain product-specific options are marked with [OTM], 
[GTM], [LCC] or some combination thereof. 

Because of the universal nature of the installer, file names, directory names, window titles and the like 
may only reference a single product (i.e. Oracle Transportation Management) however they will apply 
to all products unless otherwise indicated.  

The Logistic Command Center is more complex architecturally than a simple Oracle Transportation 

Management or Global Trade Management installation. Before installing any Logistics Command 
Center component please carefully review the architecture overview in the “Architectural Overview” 

section of the Logistics Command Center Administration Guide. 

Note: Sections below that contain component-specific options are marked with [LCC 

Controller] or [LCC Pool] as appropriate. 

Explanation of Application Layers 

Any given instance of Oracle Transportation Management, Global Trade Management or a component 

of Logistics Command Center is made up of many sub-components that can be grouped into the 
following “layers”: 

 Database layer: where the data actually resides 

 Application layer: where the application logic runs 

 Web layer: the UI that users interact with (Tomcat & Apache) 

 Fusion Transportation Intelligence/Logistics Command Center Analytics layer: where Oracle 

Business Intelligence Enterprise Edition (OBIEE) and Oracle Data Integrator (ODI) run 

 Integration layer: where incoming XML data is handled 

o This is just a normal web instance that you designate as being used for handling 
integration in addition to, or instead of, handling normal user traffic; please see the 

Oracle Transportation Management Integration Guide and the Oracle Transportation 

Management Data Management Guide for alternatives to using web-layer integration. 
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o Whether or not a given web instance is handling user traffic is as simple as whether or 

not users know to access the instance. In order to set up a separate integration web 
server, your upstream processes simply need to know where to send data to and your 

users should not be directed to use it. 

Recommended Installation Configurations 

The application can be installed in various configurations to provide scalability for production 
instances, or to provide for consolidation of system resources for test/development instances. 

Oracle Transportation Management/Global Trade Management 

Production instances of any Oracle Transportation Management or Global Trade Management will 

normally run each of the above component layers on separate servers. For instance, we would see the 
following configuration: 

 Server One: Database layer 

 Server Two: Application Layer 

 Server Three: Web layer 

 Server Four: Integration layer 

 Server Six: Oracle Fusion Transportation Intelligence layer 

The instructions that follow assume that you are installing a production instance of the application 
where the various layers reside on separate servers. If you want to install a test or development 
instance, please see the Installing OTM on a Single Server section. 

Test instances can be consolidated onto fewer servers, depending on the hardware availability within 
your organization. Commonly, we will see the following configuration for test instances: 

 Server One: Database and Oracle Fusion Transportation Intelligence (FTI) layers 

 Server Two: Web, Application and Integration layers 

If the test server has enough resources (Memory/CPU), it is possible to run everything on a single 
system. This should ONLY be done for test instances and is NOT recommended for any production 
level use. Please contact Technical Consulting if you have any questions. 

Logistics Command Center 

Recommendations for Logistics Command Center are a little different because the expected user 
volume for both the controller and the pool servers are dramatically lower than with Oracle 
Transportation Management or Global Trade Management. If user volumes for your instances are 

expected to be high then you may follow the directions for a production instance outlined in the 
previous section for the component in question. Otherwise, the recommendation for an instance of 
Logistics Command Center is as follows: 

 Server One: Database 

 Server Two: Web, Application 

 Server Three: Analytics (not needed for each pool server) 

Note: For LCC pool installations, having a combined Web & Application server install is the 

only option. 

Upgrading From a Previous Version 

Prior releases of Oracle Transportation Management provided two installers, an “upgrade” installer and 

a “fresh” installer. The upgrade installer was used to install the new version of the software on top of 
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an earlier version of the software, whereas the fresh installer laid down the latest code into a new 

directory. Either installer allowed for the migration of custom properties from an earlier release. 

As of version 6.3 there is no longer an upgrade installer provided. Instead, the process of upgrading 
from a prior version is to lay down new code into a new directory and then copy any customizations 

from your previous installation into the new installation. See “Customizations Migration” later in this 
chapter for the specific steps necessary to do that. 

After customizations have been migrated the database needs to be migrated. Please refer to the 
Oracle Transportation Management Migration Guide for further details. 

Important Note: As of version 6.3.1, database connections are made via Service Names instead of 
database SIDs.  If you are upgrading from a previous version, you should ensure that the Service 
Name for their database is the same as the SID; if it’s not, make sure to use the correct value. 

Installer Interface Options 

Depending on the operating system, OTM can be installed using one of three options: GUI, Console, 
and Silent. All installation capabilities are available with all interface options; it’s simply a matter of 
preference and convenience in deciding which one to use. 

GUI Interface 

The GUI option is available on all platforms. It uses the native windowing system (e.g. X11) to interact 
with the user. Under Unix/Linux systems, this requires you to have an X display running, and to have 

the DISPLAY environment variable set correctly. Contact your local System Administrator if you need 
help setting this up. To use this interface, simply run the installer executable with no further options: 

$ ./otmv635_<platform>.bin 

Console Interface 

The Console interface option is available on all platforms except Windows. It runs on the command 
line and interacts with the user through a text-only interface. To use this interface, run the installer 
executable with a single option: 

$ ./otmv635_<platform>.bin –i console 

Silent Installer  

The Silent Installer interface option is available on all platforms except Windows. A file is prepared 
ahead of time answering all of the questions that the installer would normally ask. The installer will 
read it in when it executes and then run completely hands-free. To use the silent installer option, run 
the installer executable with two options, one to select the silent interface and one to specify the 
response file to use:  

$ ./otmv635_<platform>.bin –i silent –f installer.properties 

Installing with the Silent Installer 

Before installing OTM with the silent option, you must locate, rename, and edit the response file. It is 
called example.installer.properties and is located in the same directory as the installer 

executable itself. 
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1. Make a copy of example.installer.properties and save it to a new name (e.g. 

installer.properties). 

2. Edit the new file and fill in the answers as appropriate for your environment. All values are 
documented in the file itself. Note that some sections are only for certain platforms, or are 

specific to the web or application server installs; all should be clearly marked. 

3. Run the installer executable from the command line with the following options: 

$ ./otmv635_<platform>.bin –i silent –f installer.properties 

where <platform> is the name of the platform you are on and installer.properties is the 

name of the file that you edited in the previous step. 

Note: On UNIX/Linux systems, the installer extracts to /tmp, and you will receive an error 
if there is not sufficient room there for the installer to extract itself. If you need to change 

this directory you must set the IATEMPDIR environment variable: 

$ export IATEMPDIR=/some/other/temp/directory 

$ ./otmv635_<platform>.bin –i silent –f installer.properties 

4. Once the installer has finished (5-20 minutes, depending on your operating system and 

hardware) you should see the message: 

Installation Complete. 

Check the bottom of the installation log file, Oracle_OTM_v6.3_GA_InstallLog.log, for any 

errors or warnings (this file should be located in the directory that OTM was installed to). If 
there are any errors, please correct them (they should be self explanatory). If you find that 

you need help, please have the log file handy, along with the Exit Code (found in the log file), 
before contacting Oracle Support. If you do not get the “Installation Complete.” message or 
cannot find the log file, look for a file of the same name in your home directory (i.e. 
$HOME/Oracle_OTM_v6.3_GA_InstallLog.log). 

5. Please refer to the sections at the end of Installing Interactive on the Application Server for 

further post-install activities that need to be done before you can start up the application. 

Note: The silent installer response file contains sensitive information that should be 
safeguarded appropriately. 

Installing Interactively on the Application Server 

Note: Paths shown in this section will be in UNIX format (Ex. /opt/gc3) but should be in 

Windows format for Windows installs (Ex. D:/gc3 or D:\gc3). All directions are generic 
across all operating systems unless explicitly noted. 

1. Start the installer in GUI or console mode, as directed in the section above. 

Note: On UNIX/Linux systems, the installer extracts to /tmp, and you will receive an error 

if there is not sufficient room there for the Installer to extract itself. If you need to change 
this directory you must set the IATEMPDIR environment variable: 

$ export IATEMPDIR=/some/other/temp/directory 

$ ./otmv635_<platform>.bin –i console 

2. Read the installation notice and click Next. 

3. Choose the installation directory (e.g. /opt/otm or /opt/otm635 to denote version). If you are 

installing more than one OTM instance on a server, each instance must be installed into a 

different directory. 

4. Select the instance installation type and click Next. 
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a. OTM Instance – select this for Oracle Transportation Management or Global Trade 

Management installations 

b. LCC Controller Instance – select this for Logistics Command Center controller 

installations 

c. LCC Pool Instance – select this for Logistics Command Center pool server installations; 

see the Logistics Command Center Administration Guide for an architectural 

overview of the Logistics Command Center application 

5. [OTM & LCC Controller] Choose ‘App Server’ to install the application server only and click 

Next. 

Note: Only combined web & application installs are supported for LCC Pool installs. See 

the “Installing OTM on a Single Server” section below for more details. 

6. Read the instructions for filling out the required data and click Next. 

7. [AIX, HPUX only] External JDK 

a. Enter the path to your Java Development Kit (see Preparing to Install OTM above) 

8. General Settings 

a. Enter the Web Server External Fully Qualified Domain Name (e.g. 
otmweb.oracle.com). This would work if ‘otmweb’ is the server name and ‘oracle.com’ 

is the domain name. If your site were accessed through a load-balancer or NAT device, 

this would be the external URL (outside your network). If not, then this would be the 
FQDN of your web server from within your network. Please contact your Network 

Administrator if you have any questions about this. 

b. Enter the Web Server External Port. If your site is accessed through a load-balancer or 

NAT device, this is the external port. If not, then this is the port of your web server (in 

which case see the note below for more information on what this value should be). 

c. Select the Web Server External Protocol. If your site were accessed through a load-

balancer or NAT device, this would be the protocol used in the external URL (outside 

your network). If not, then this would be the protocol used by the internal web server. 

d. Click Next. 

9. General Settings (continued) 

a. Enter the Web Server Fully Qualified Domain Name. This may or may not be the same 

as the Web Server External FQDN. 

b. Enter the Web Server Port. This must match the port number that Oracle HTTP Server 

(OHS) is listening on, which can be found in the 

$OHS/instances/instance1/config/OHS/otm635/httpd.conf file (where $OHS, 
instance1 and otm635 are, respectively, the OHS Home directory, OHS Instance 

Name and OHS Component Name noted earlier), unless port redirection is being used 

(see the “Admin Privileges” section of the Oracle Transportation Management Security 

Guide). 

c. Enter the Fully Qualified Domain Name of your application server, which is the name of 

your server and the domain name (e.g. otmapp.oracle.com). 

d. Enter the Application Server Port. This is usually 7001. 

e. Click Next. 

10. General Settings (continued) 

a. Enter the Database Server Fully Qualified Domain Name that is the name of your 

database server and the domain name (e.g. otmdb.oracle.com).  

b. Enter the Database Server Port. This is usually 1521. 

c. Enter the Database Connect String. This is the DB connect string as setup in your 
tnsnames.ora file under the Oracle client installation. Contact your Oracle 

Administrator for this information.  
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d. Enter the Database Service Name. This may or may not be the same as the Connect 

String; contact your Oracle Administrator for this information. 

e. Enter Oracle Home Path where you installed the Oracle client 

(/u01/app/oracle/product/11g, for instance). 

f. Click Next. 

11. General Settings (continued) 

a. Enter the URL Prefix, if your web server is running behind a reverse-proxy or SSO 

solution. Otherwise, you can accept the default. 

b. Enter SMTP Server Fully Qualified Domain Name. This server name is necessary to 

send email notifications from within OTM. Please contact your Network Administrator 

for this information. 

c. Enter the Default Reply-To Email Address that all email notifications will appear to 

come from. This must map to a real mailbox and will allow you to check for bounced 

messages or delivery failures. 

d. Click Next. 

12. App Server Settings  

a.  Enter the BEA Home Path (e.g. /opt/bea). 

13. App Server Settings (continued) 

a. Enter the Application Server IP Address. The application server will be bound to this IP 
address specifically. If you are installing more than one OTM instance on a server, 

each instance must be bound to a different IP address. Please contact your Network or 

UNIX Administrators for more information on creating virtual IP addresses within a 

server. 

b. Enter the Application Server Path, which is the directory that you installed the 

Application server software into (e.g. /opt/bea/weblogic11g). 

c. Enter the Application Server memory in megabytes, which is the amount of system 

memory that the application server memory uses. This default is 4096MB, but may be 

higher depending on your configuration. 

Note: If this value is lower than 4096MB, the application server may not start. Also, please 

take into consideration whether the server will be used for test/development or production, 

and what system resources are available. 

d. Enter the Application Server SSL Port. This is usually 7002. 

e. Enter the Application Server Launcher Port. This is 32001 by default. Because the 

Launcher binds to localhost (127.0.0.1), this port must be unique across all Launchers 

installed on the same server. 

f. Click Next. 

14. [Windows only] App Server Settings: Service Name 

a. Enter the name that you’d like to use for the OTM Application Server Service name 

(e.g. otmapp63). This name must be unique across all services for a given server. 

b. Click Next. 

15.  [AIX only] App Server Settings (continued) 

a. Enter the number of logical CPUs in the server. This is used to set a JVM performance 

parameter. 

b. Click Next. 

16. [LCC Controller] Base Database Connection Settings 

a. Enter the Database Server Fully Qualified Domain Name for the Logistics Command 

Center base database, including the domain name (e.g. lccbase.oracle.com).  
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b. Enter the Database Server Port for the Logistics Command Center base database. This 

is usually 1521. 

c. Enter the Database Service Name for the Logistics Command Center base database. 

Contact your Oracle Administrator for this information.  

d. Click Next. 

17. [LCC Pool] Server Manager Settings 

a. Enter the port number that the remote server manager will listen on (default: 21557). 

b. Enter the remote server manager Launcher port number (default: 32100). Because 

the Launcher binds to localhost (127.0.0.1), this port must be unique across all 

Launchers installed on the same server. 

c. Enter the Fully Qualified Domain Name for the Logistics Command Center controller 

server. 

d. Click Next. 

18. WebLogic System Password 

a. Enter the WebLogic ‘system’ user password. See the Oracle Transportation 

Management Security Guide for more information. 

b. Click Next. 

19. App-to-Web Authentication Password 

a. Enter the password for authenticating App-to-Web communication. See the Oracle 

Transportation Management Security Guide for more information. 

b. Click Next. 

20. GLOGDBA Database User Password 

a. Enter the password for the database user ‘glogdba’. See the Oracle Transportation 

Management Security Guide for more information. 

b. Click Next. 

21. GLOGLOAD Database User Password 

a. Enter the password for the database user ‘glogload’ . See the Oracle Transportation 

Management Security Guide for more information. 

b. Click Next. 

22. [LCC Controller] Base Database LC2DBA User Password 

a. Enter the password for the Logistics Command Center base database user ‘lc2dba’. 

See the Logistics Command Center Administration Guide for more information. 

b. Click Next. 

23. [LCC Controller] Pool Database Common GLOGDBA Password 

a. Enter the common password for the Logistics Command Center database user 
‘glogdba’ for the Pool schemas. See the Logistics Command Center Administration 

Guide for more information. 

b. Click Next. 

24. [UNIX Only] UNIX Settings 

a. Enter the user name that the OTM programs will run under (e.g. otm or otm63). 

b. Enter the group name that the OTM programs will run under (e.g. otm or otm63). 

c. Click Next. 
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Note: The installer will try to verify the user and group names that you enter against the 

/etc/passwd and /etc/group files. If the installer cannot verify these names (e.g. you 
mistyped them or you use a tool such as LDAP or NIS to manage users and groups on this 

server), you will be prompted to correct them or validate that they are correct and continue 

with the installation. Similarly, the installer will use the /etc/passwd file to look up the 
home directory of the user you entered; if it cannot determine what the home directory is 

or cannot locate the actual directory, you will be prompted to correct it or verify that it is 

accurate and continue the installation. 

25. [UNIX Only] UNIX Settings (continued) 

a. Enter the home directory of the user specified previously. 

b. Click Next. 

26. Migration Custom Properties 

a. Choose whether or not to migrate custom settings from a previous OTM installation 

(3.7 or later). If you answer yes, you’ll need to choose the directory where your old 

glog.properties file is located.  

b. Click Next. 

Installing Optional Components 

1. Choose the optional components with which the application will integrate. Depending on what 

you choose, the installer may prompt for additional configuration information. 

a. [Console Install Only] Enter all components that you wish to integrate with using a 

comma-separated list (no spaces). 

b. The actual options presented will depend on which application and components are 

being installed. The sections below outline the installation details presented assuming 

that the option was available for your configuration and then chosen. 

Integrating with Oracle Fusion Transportation Intelligence 

If you are integrating with Oracle Fusion Transportation Intelligence (FTI), enter the following: 

2. FTI Server Integration 

a. Fully Qualified Domain Name of the Oracle FTI web server. 

b. Port number of the Oracle FTI web server. 

c. Fully Qualified Domain Name of the Oracle FTI database server. 

d. Port that Oracle is using on the Oracle FTI database server (usually 1521). 

e. Click Next. 

3. FTI Server Integration (continued) 

a. Oracle FTI database schema name (e.g. hdowner). 

b. Oracle FTI database SID. 

c. Oracle FTI database username (e.g. hdowner). 

d. Click Next. 

4. FTI Database Password 

a. Enter the Password for the Oracle FTI database user. 

b. Click Next. 

5. Oracle Data Integrator (ODI) Integration 

a. Fully Qualified Domain Name of the Oracle Data Integrator Master Repository Server. 

b.  Port number of the Oracle Data Integrator Master Repository Server (usually 1521). 

c. Oracle SID for the Oracle Data Integrator Master Repository.  
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d. Click Next. 

6. ODI Integration (continued) 

a. Fully Qualified Domain Name of the Oracle Data Integrator Agent Server. 

b. Port number of the Oracle Data Integrator Agent Server (usually 20910). 

c. Oracle Data Integrator Work Repository Code. 

d. Click Next. 

7. ODI Agent Password 

a. Enter the password for the Oracle Data Integrator Agent. See the Oracle 

Transportation Management Security Guide for more information. 

Integrating with Logistics Command Center Analytics 

If you are integrating with Oracle Logistics Command Center (LCC), enter the following: 

8. LCC Analytics Server Integration 

a. Fully Qualified Domain Name of the Analytics web server. 

b. Port number of the Analytics web server (default: 9704). 

c. Protocol used by the Analytics web server (http or https, default: http) 

d. Click Next. 

9. LCC Analytics Oracle Data Integrator (ODI) Integration 

a. Fully Qualified Domain Name of the Oracle Data Integrator Agent Server. 

b. Port number of the Oracle Data Integrator Agent Server (default: 20910). 

c. Oracle Data Integrator Work Repository Code (default: LC2_WORK). 

d. Click Next. 

10. LCC Analytics ODI Agent Password 

a. Enter the password for the Oracle Data Integrator Agent. See the Logistics Command 

Center Security Guide for more information. 

 

Using a Replicated Operational Database 

If you are using a Replicated Operational Database (ROD), enter the following: 

11. Replicated Operation Database Integration 

a. Fully Qualified Domain Name of the ROD Server. 

b. Port that Oracle is using on the ROD server (usually 1521). 

c. Connect String for the ROD database. 

d. Service Name of the ROD database. 

e. Click Next. 

Integrating with MapViewer 

If you are integrating with a MapViewer instance, enter the following: 

12. Oracle MapViewer 

a. Fully Qualified Domain Name of your MapViewer server. 

b. Service Name (data source name) of your MapViewer instance. 

c. Base Map name for your MapViewer instance. 

d. Click Next. 
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Integrating with Oracle Spatial 

If you are integrating with an Oracle Spatial server, enter the following: 

13. Oracle Spatial 

a. Fully Qualified Domain Name of the Oracle Spatial server. 

b. Port number of the Oracle Spatial server. 

c. The full path and name of the Route servlet for US/Canada that the Oracle Spatial 

server hosts. 

d. The full path and name of the Route servlet for Western Europe that the Oracle Spatial 

server hosts. 

e. The full path and name of the GeoCode servlet that the Oracle Spatial server hosts. 

f. Click Next. 

Integrating with FAXMaker or RightFax 

If you are integrating with FAXMaker or RightFax, enter the following: 

14. Fax Server Integration 

a. Phone number that faxes will seem to originate from. 

b. Email address that the fax server polls. 

c. Click Next. 

Integrating with SMC RateWare 

If you are integrating with SMC RateWare server, enter the following: 

15. SMC RateWare Server Integration 

a. SMC RateWare Fully Qualified Domain Name. 

b. SMC RateWare Server Port (usually 23700). 

c. Click Next. 

16. SMC RateWare Server Integration (continued) 

a. Indicate whether or not you are running SMC RateWare Version 1.2.325 (or later) or 

SMC Carrier Connect. 

b. Click Next. 

Integrating with SMC RateWareXL 

If you are integrating with SMC RateWareXL, enter the following: 

17. SMC RateWareXL Integration 

a. SMC RateWareXL Username. 

b. SMC RateWareXL Password. 

c. SMC RateWareXL License Key. 

d. Click Next. 

Integrating with PCMiler WorldWide 

If you are integrating with PCMiler WorldWide, enter the following: 

18. PCMiler Server Integration 

a. Fully Qualified Domain Name of the PCMiler WorldWide server. 
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b. PCMiler WorldWide port (usually 8145). 

c. Click Next. 

Integrating with PCMiler Rail 

If you are integrating with PCMiler Rail, enter the following: 

19. PCMiler Rail Integration 

a. Fully Qualified Domain Name of the PCMiler Rail server 

b. PCMiler Rail port (usually 2001) 

c. Click Next. 

Integrating with Rand McNally IntelliRoute Server 

If you are integrating with Rand McNally IntelliRoute Server, enter the following: 

20. Rand McNally IntelliRoute Server Integration 

a. IP address of the Rand McNally IntelliRoute server. 

b. Rand McNally IntelliRoute server port (usually 1998). 

c. IntelliRoute user name setup during the IntelliRoute server installation (e.g. otm). 

d. IntelliRoute password setup during the IntelliRoute server installation. 

e. IntelliRoute location setup during the IntelliRoute server installation. 

f. Click Next. 

Integrating with Rand McNally MileMaker Server 

If you are integrating with Rand McNally MileMaker Server, enter the following: 

21. RandMcNally MileMaker Server Integration 

a. Enter the Fully Qualified Domain Name of the MileMaker server. 

b. Enter the MileMaker server port (usually 1031). 

c. Click Next. 

Integrating with Kewill’s FlagShip Server 

If you are integrating with Kewill’s FlagShip server, enter the following: 

22. Kewill Flagship Server Integration 

a. Fully Qualified Domain Name of the Kewill FlagShip server. 

b. FlagShip server port (usually 1200). 

c. Enter the Oracle Transportation Management Location Refnum Qualifier GID used to 

cross-reference with the Kewill data. 

d. Click Next. 

23. Please review the summary before continuing and click Next when ready to proceed. The file 

copy process may take some time – please be patient. 

Continuing Installation after Optional Sub-components Are Installed 

1. Once the files are copied, the installation program prompts you to begin configuring OTM. This 

step takes a few minutes (typically one to five minutes).  

2. [Windows Only] When finished, you must restart your entire server before attempting to 

start OTM. 
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Startup Scripts (UNIX Only) 

A generic startup script is provided for your use: 

$OTM/install/weblogic/glogapp-wl 

This can be used as-is or modified however you’d like to meet your organization’s specific needs. It is 
recommended that you make a copy of script before making any changes, so that the original is 
always available for comparison. Note that this script is capable of being used in most /etc/init.d-

type automatic startup environments. 

[LCC Pool] A generic startup script is provided for the remote server manager: 

$OTM/atf/bin/atfserver.sh 

This can be used as-is or modified however you’d like to meet your organization’s specific needs. It is 

recommended that you make a copy of script before making any changes, so that the original is 
always available for comparison. Note that this script is capable of being used in most /etc/init.d-

type automatic startup environments. 

Installing Interactively on the Web Server  

Note: Paths shown in this section will be in UNIX format (Ex. /opt/gc3) but should be in 
Windows format for Windows installs (Ex. D:/gc3 or D:\gc3). All directions are generic 

across all operating systems unless explicitly noted. 

1. Start the installer in GUI or console mode, as directed in the section above. 

Note: On UNIX/Linux systems, the installer extracts to /tmp, and you will receive an error 
if there is not sufficient room there for the installer to extract itself. If you need to change 

this directory you must set the IATEMPDIR environment variable: 

$ export IATEMPDIR=/some/other/temp/directory 

$ ./otmv635_<platform>.bin –i console 

2. Read the installation notice and click Next. 

3. Choose the installation directory (e.g. /opt/otm or /opt/otm635 to denote version). If you are 

installing more than one OTM instance on a server, each instance must be installed into a 

different directory. 

4. Select the instance installation type and click Next. 

a. OTM Instance – select this for Oracle Transportation Management or Global Trade 

Management installations 

b. LCC Controller Instance – select this for Logistics Command Center controller 

installations 

c. LCC Pool Instance – select this for Logistics Command Center pool server installations; 

see the Logistics Command Center Administration Guide for an architectural overview 

of the Logistics Command Center application 

5. [OTM & LCC Controller] Choose “Web Server” to install the Web Server only and click Next. 

Note: Only combined web & application installs are supported for LCC Pool installs. See 

the “Installing OTM on a Single Server” below for more details. 

6. Read the instructions for filling out the required data and click Next. 

7. [AIX, HPUX only] External JDK 

a. Enter the path to your Java Development Kit (see Preparing to Install OTM above) 
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8. General Settings 

a. Enter the Web Server External Fully Qualified Domain Name (e.g. 

otmweb.oracle.com). This would work if ‘otmweb’ is the server name and ‘oracle.com’ 
is the domain name. If your site were accessed through a load-balancer or NAT device, 

this would be the external URL (outside your network). If not, then this would be the 

FQDN of your web server from within your network. Please contact your Network 

Administrator if you have any questions about this. 

b. Enter the Web Server External Port. If your site is accessed through a load-balancer or 

NAT device, this is the external port. If not, then this is the port of your web server (in 

which case see the note below for more information on what this value should be). 

c. Select the Web Server External Protocol. If your site were accessed through a load-
balancer or NAT device, this would be the protocol used in the external URL (outside 

your network). If not, then this would be the protocol used by the internal web server. 

d. Click Next. 

9. General Settings (continued) 

a. Enter the Web Server Fully Qualified Domain Name. This may or may not be the same 

as the Web Server External FQDN. 

b. Enter the Web Server Port. This must match the port number that Oracle HTTP Server 
(OHS) is listening on, which can be found in the 

$OHS/instances/instance1/config/OHS/otm635/httpd.conf file (where $OHS, 

instance1 and otm635 are, respectively, the OHS Home directory, OHS Instance 
Name and OHS Component Name noted earlier) , unless port redirection is being used 

(see the “Admin Privileges” section of the Oracle Transportation Management Security 

Guide). 

c. Enter the Fully Qualified Domain Name of your application server, which is the name of 

your server and the domain name (e.g. otmapp.oracle.com). 

d. Enter the Application Server Port. This is usually 7001. 

e. Click Next. 

10. General Settings (continued) 

a. Enter the Database Server Fully Qualified Domain Name that is the name of your 

database server and the domain name (e.g. otmdb.oracle.com).  

b. Enter the Database Server Port. This is usually 1521. 

c. Enter the Database Connect String. This is the DB connect string as setup in your 

tnsnames.ora file under the Oracle client installation. Contact your Oracle 

Administrator for this information.  

d. Enter the Database Service Name. This may or may not be the same as the Connect 

String; contact your Oracle Administrator for this information. 

e. Enter Oracle Home Path where you installed the Oracle client 

(/u01/app/oracle/product/11g, for instance). 

f. Click Next. 

11. General Settings (continued) 

a. Enter the URL Prefix, if your web server is running behind a reverse-proxy or SSO 

solution. Otherwise, you can accept the default. 

b. Enter SMTP Server Fully Qualified Domain Name. This server name is necessary to 

send email notifications from within OTM. Please contact your Network Administrator 

for this information. 

c. Enter the Default Reply-To Email Address that all email notifications will appear to 
come from. This must map to a real mailbox and will allow you to check for bounced 

messages or delivery failures. 

d. Click Next. 
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12. Web Server Settings 

a. Enter the Web Server IP Address. Apache will be bound to this IP address. If you are 

installing more than one OTM instance on a server, each instance must be bound to a 
different IP address. Please contact your Network or UNIX Administrators for more 

information on creating virtual IP addresses within a server. 

b. Enter the Web Server SSL Port (usually 443). 

c. Enter the Tomcat Data Port (usually 8009). 

d. Enter the Tomcat Shutdown Port (usually 8007).  

Note: This port must be unique for every OTM instance on a physical server, since it binds 

to 127.0.0.1. 

e. Enter the Oracle HTTP Server BEA Home Path (e.g. /opt/bea). 

f. Click Next. 

13. Web Server Settings (continued) 

a. Enter the Tomcat Memory in Megabytes. This is the amount of system memory that 

Tomcat will use. This is 4096MB by default, but may be higher or lower, depending on 

your configuration.  

Note: If this value is lower than 4096MB, Tomcat may not start. Also, please be sure 
to note whether this server will be used for test/development or production, and what 
system resources it has available. 

b. Enter the Oracle HTTP Server Path (e.g. /opt/bea/weblogic11). 

c. Enter the Oracle HTTP Server Instance Home (e.g. 

/opt/bea/Oracle_WT1/instances/instance1). 

d. Enter the Oracle HTTP Server instance Component Name (e.g. otm63) 

e. Enter the Web Server Launcher Port. This is 32000 by default. Because the Launcher 
binds to localhost (127.0.0.1), this port must be unique across all OTM installations on 

the same server. 

f. Click Next. 

14. [Windows only] Web Server Settings: Service Name 

a. Enter the name that you’d like to use for the OTM Servlet Server Service name (e.g. 

otmwebtomcat63). This name must be unique across all services for a given server. 

b. Click Next. 

15. [AIX only] Web Server Settings (continued) 

a. Enter the number of logical CPUs in the server. This is used to set a JVM performance 

parameter. 

b. Click Next. 

16. [LCC Controller] Base Database Connection Settings 

a. Enter the Database Server Fully Qualified Domain Name for the Logistics Command 

Center base database, including the domain name (e.g. lccbase.oracle.com).  

b. Enter the Database Server Port for the Logistics Command Center base database. This 

is usually 1521. 

c. Enter the Database Service Name for the Logistics Command Center base database. 

Contact your Oracle Administrator for this information.  

d. Click Next. 

17. [LCC Pool] Server Manager Settings 

a. Enter the port number that the remote server manager will listen on (default: 21557). 
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b. Enter the remote server manager Launcher port number (default: 32100). Because 

the Launcher binds to localhost (127.0.0.1), this port must be unique across all 

Launchers installed on the same server. 

c. Enter the Fully Qualified Domain Name for the Logistics Command Center controller 

server. 

d. Click Next. 

18. WebLogic System Password 

a. Enter the WebLogic ‘system’ user password. See the Oracle Transportation 

Management Security Guide for more information. 

b. Click Next. 

19. App-to-Web Authentication Password 

a. Enter the password for authenticating App-to-Web communication. See the Oracle 

Transportation Management Security Guide for more information. 

b. Click Next. 

20. GLOGDBA Database User Password 

a. Enter the password for the database user ‘glogdba’ . See the Oracle Transportation 

Management Security Guide for more information. 

b. Click Next. 

21. GLOGLOAD Database User Password 

a. Enter the password for the database user ‘glogload’ . See the Oracle Transportation 

Management Security Guide for more information.  

b. Click Next. 

22. [LCC Controller] Base Database LC2DBA User Password 

a. Enter the password for the Logistics Command Center base database user ‘lc2dba’. 

See the Logistics Command Center Administration Guide for more information. 

b. Click Next. 

23. [LCC Controller] Pool Database Common GLOGDBA Password 

a. Enter the common password for the Logistics Command Center database user 

‘glogdba’ for the Pool schemas. See the Logistics Command Center Administration 

Guide for more information. 

b. Click Next. 

24.  [UNIX Only] UNIX Settings 

a. Enter the user name that the OTM programs will run under (e.g. otm or otm63). 

b. Enter the group name that the OTM programs will run under (e.g. otm or otm63). 

c. Click Next. 

Note: The installer will try to verify the user and group names that you enter against the 
/etc/passwd and /etc/group files. If the installer cannot verify these names (e.g. you 

mistyped them or you use something like LDAP or NIS to manage users and groups on this 

server), you will be prompted to correct them or validate that they are correct and continue 

with the installation. Similarly, the installer will use the /etc/passwd file to look up the 

home directory of the user you entered; if it cannot determine what the home directory is 

or cannot locate the actual directory, you will be prompted to correct it or verify that it is 
accurate and continue the installation. 

25. [UNIX Only] UNIX Settings (continued) 

a. Enter the home directory of the user specified previously. 

b. Click Next. 

26. Migration Custom Properties 
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a. Choose whether or not to migrate custom settings from a previous OTM installation 

(3.7 or later). If you answer yes, you’ll need to choose the directory where your old 

glog.properties file is located.  

b. Click Next. 

Installing Optional Components 

1. Choose the optional components with which the application will integrate. Depending on what 

you choose, the installer may prompt for additional configuration information. 

a. [Console Install Only] Enter all components that you wish to integrate with using a 

comma-separated list (no spaces). 

b. The actual options presented will depend on which application and components are 
being installed. The sections below outline the installation details presented assuming 

that the option was available for your configuration and then chosen. 

Integrating with Oracle Fusion Transportation Intelligence 

If you are integrating with Oracle Fusion Transportation Intelligence (FTI), enter the following: 

2. FTI Server Integration 

a. Fully Qualified Domain Name of the Oracle FTI web server. 

b. Port number of the Oracle FTI web server. 

c. Fully Qualified Domain Name of the Oracle FTI database server. 

d. Port that Oracle is using on the Oracle FTI database server (usually 1521). 

e. Click Next. 

3. FTI Server Integration (continued) 

a. Oracle FTI database schema name (e.g. hdowner). 

b. Oracle FTI database SID. 

c. Oracle FTI database username (e.g. hdowner). 

d. Click Next. 

4. FTI Database Password 

a. Enter the Password for the Oracle FTI database user. 

b. Click Next. 

5. Oracle Data Integrator (ODI) Integration 

a. Fully Qualified Domain Name of the Oracle Data Integrator Master Repository Server. 

b.  Port number of the Oracle Data Integrator Master Repository Server (usually 1521). 

c. Oracle SID for the Oracle Data Integrator Master Repository.  

d. Click Next. 

6. ODI Integration (continued) 

a. Fully Qualified Domain Name of the Oracle Data Integrator Agent Server. 

b. Port number of the Oracle Data Integrator Agent Server (usually 20910). 

c. Oracle Data Integrator Work Repository Code. 

d. Click Next. 

7. ODI Agent Password 

a. Enter the password for the Oracle Data Integrator Agent. See the Oracle 

Transportation Management Security Guide for more information. 
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Integrating with Logistics Command Center Analytics 

If you are integrating with Oracle Logistics Command Center (LCC), enter the following: 

8. LCC Analytics Server Integration 

a. Fully Qualified Domain Name of the Analytics web server. 

b. Port number of the Analytics web server (default: 9704). 

c. Protocol used by the Analytics web server (http or https, default: http) 

d. Click Next. 

9. LCC Analytics Oracle Data Integrator (ODI) Integration 

a. Fully Qualified Domain Name of the Oracle Data Integrator Agent Server. 

b. Port number of the Oracle Data Integrator Agent Server (default: 20910). 

c. Oracle Data Integrator Work Repository Code (default: LC2_WORK). 

d. Click Next. 

10. LCC Analytics ODI Agent Password 

a. Enter the password for the Oracle Data Integrator Agent. See the Logistics Command 

Center Security Guide for more information. 

 

Using a Replicated Operational Database 

If you are using a Replicated Operational Database (ROD), enter the following: 

11. Replicated Operation Database Integration 

a. Fully Qualified Domain Name of the ROD Server 

b. Port that Oracle is using on the ROD server (usually 1521) 

c. Connect String for the ROD database 

d. Service Name of the ROD database 

e. Click Next. 

Integrating with MapViewer 

If you are integrating with a MapViewer instance, enter the following: 

12. Oracle MapViewer 

a. Fully Qualified Domain Name of your MapViewer server. 

b. Service Name (data source name) of your MapViewer instance. 

c. Base Map name for your MapViewer instance. 

d. Click Next. 

Integrating with Oracle FTI 

If you are integrating with Oracle Fusion Transportation Intelligence (FTI), enter the following: 

13. FTI Server Integration 

a. Fully Qualified Domain Name of the Oracle FTI web server. 

b. Port number of the Oracle FTI web server. 

c. Fully Qualified Domain Name of the Oracle FTI database server. 

d. Port that Oracle is using on the Oracle FTI database server (usually 1521). 
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e. Click Next. 

14. FTI Server Integration (continued) 

a. Oracle FTI database schema name (e.g. hdowner). 

b. Oracle FTI database SID. 

c. Oracle FTI database username (e.g. hdowner). 

d. Click Next. 

15. FTI Database Password 

a. Enter the Password for the Oracle FTI database user. 

b. Click Next. 

16. Oracle Data Integrator (ODI) Integration 

a. Fully Qualified Domain Name of the Oracle Data Integrator Master Repository Server. 

b.  Port number of the Oracle Data Integrator Master Repository Server (usually 1521). 

c. Oracle SID for the Oracle Data Integrator Master Repository.  

d. Click Next. 

17. ODI Integration (continued) 

a. Fully Qualified Domain Name of the Oracle Data Integrator Agent Server. 

b. Port number of the Oracle Data Integrator Agent Server (usually 20910). 

c. Oracle Data Integrator Work Repository Code. 

d. Click Next. 

18. ODI Agent Password 

a. Enter the password for the Oracle Data Integrator Agent. See the Oracle 

Transportation Management Security Guide for more information. 

19. Please review the summary before continuing and click Next when ready to proceed. The file 

copy process may take some time – please be patient. 

Continuing Installation after Optional Sub-components are Installed 

1. Once the files are copied, the installation program prompts you to begin configuring OTM. This 

step takes a few minutes (typically one to five minutes). 

2. [Windows Only] When finished, you must restart your entire server before attempting to 

start OTM. 

Startup Scripts (UNIX Only) 

A generic startup script is provided for your use: 

$OTM/install/ohs/glogweb-wl 

This can be used as-is or modified however you’d like to meet your organization’s specific needs. It is 

recommended that you make a copy of script before making any changes, so that the original is 
always available for comparison. Note that this script is capable of being used in most /etc/init.d-

type automatic startup environments. 

[LCC Pool] A generic startup script is provided for the remote server manager: 

$OTM/atf/bin/atfserver.sh 

This can be used as-is or modified however you’d like to meet your organization’s specific needs. It is 
recommended that you make a copy of script before making any changes, so that the original is 
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always available for comparison. Note that this script is capable of being used in most /etc/init.d-

type automatic startup environments. 

Customizations Migration 

If you are upgrading from a previous version of Oracle Transportation Management and have any 
customizations in the system other than custom properties in the glog.properties file, you must copy 

those customizations from your old instance to your new instance. See the “Instructions on 
Upgrading” section in the Oracle Transportation Management Administration Guide for more details on 
what exactly needs to be copied. In order to facilitate this copying, a migration script can be 
generated based on your specific setup by following the directions below. 

After the Oracle Transportation Management code has been installed and patched with the latest Roll-
Up code and the database migrations have been completed, you will need to create the customization 
migration script. This script is either a shell script or a batch file depending on which operating system 

you are installing on (UNIX or Windows, respectively). Once this script is created it should be reviewed 

and adapted as needed for your specific setup, then it should be run. This must be done on every 
application and web server being upgraded. 

In order to migrate customizations from a prior release, the following resources must be accessible 
from the new install: 

 the prior release’s database 

 the prior release’s code installation (or a copy of it) with the database connection information 

properly configured 

The following abbreviations will be used in the instructions below: 

 $NEWOTM:  the directory where the new version of Oracle Transportation Management is 

installed 

 $OLDOTM: the directory where the previous version of Oracle Transportation Management is 

installed 

To create and run the customizations migration script, do the following: 

1. Log in as the user that the new version will use. 

a. This user will need full read access to $OLDOTM directory structure. 

2. Change directory to $NEWOTM/install 

3. Create the migration script based on your specific setup. 

a. Execute the following script (depending on operating system) to run a Java program to 

create the customization script: 

i. [Unix] ./create_migration_script.sh $OLDOTM [<script name>] 

ii. [Windows] create_migration_script.cmd $OLDOTM [<script name>] 

b. This Java program will read the database to determine potential locations of 

customized files (see the “Instructions on Upgrading” section in the Oracle 

Transportation Management Administration Guide for more details). 

c. The script creation program takes one mandatory parameter and one optional 
parameter. The mandatory parameter is the value of $OLDOTM; the optional parameter 

is the name of the script to be generated (default value is 

migrate_customizations.sh or migrate_customizations.cmd, depending on the 

operating system). 

4. Carefully review the generated script to make sure it is appropriate for your specific setup (see 

the “Instructions on Upgrading” section in the Oracle Transportation Management 

Administration Guide for more details). 
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5. Once the script is reviewed, run the generated script while still in the $NEWOTM/install 

directory. 

a. Assuming the default script name was used, this would be one of the following, 

depending on operating system: 

i. [Unix] ./migrate_customizations.sh 

ii. [Windows] migrate_customizations.cmd 

6. Test the various customizations out thoroughly before rolling into production 

Installing OTM on a Single Server 

You can install OTM on a single server for testing and development purposes. 

You can install them as separate instances, in which case you simply run the above steps multiple 
times on the same server, once for each new instance. Please ensure that port numbers are unique for 
services that bind to the same IP address. 

You can also install a combined Web and Application instance at once. Follow the directions for 
“Installing Interactively on the Application Server” but choose “Web & App Server” on the “Choose 
Install Type” screen. You will be presented with prompts that combine both of the sections “Installing 

Interactively on the Application Server” and “Installing Interactively on the Web Server”. 

Installing More Than One Instance of OTM on a Single Server 

Oracle does not support installing more than one version of OTM onto a single server (or virtual 
server) unless each instance is bound to a different IP address. This can be accomplished by having 
separate network cards, each with their own IP address, or using virtual IP addresses. Please contact 
your System Administration team for the configuration and maintenance of this. 

Configuration and Log Files 

Information on the various configuration files and logging options has been move to the Oracle 
Transportation Management Security Guide. 

Starting & Stopping OTM Servers 

Please see the section “Starting & Stopping Oracle Transportation Management Servers” in the 
Administration Guide. 
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3. Installing OTM on the Database Server 

You should have your Database Administrator install the Oracle database and fine-tune it for 
performance. Once Oracle is installed, follow these steps to complete the process. 

These steps outline the procedures to set up an Oracle database for OTM. It requires that Oracle 
Database Server 11gR2 be installed and be patched with the latest recommended patch updates and 
an Oracle database be created. Please note that the OTM database scripts are located under 
<otm_install_path>/glog/oracle/script8 on the OTM Application server.  

Requirements 

Oracle Version: 11.2.x Database Enterprise Edition 

Oracle Options: Jserver, JAccelerator, Partitioning Oracle Instance Character Set:
 UTF8 

Initial Parameters 

The following initial parameters must be set:  

Open_cursors = 3000 (or greater) 

Please refer to the init.ora file in <otm_install_path>/glog/oracle/script8 for recommendations on 
other parameters. 

Create Tablespaces 

The following tablespaces are required to be created first. As the database grows, more datafiles 
should be added to accommodate the application. For performance purposes, all tablespaces should be 

on different physical disks (if available) or on RAID 0+1 storage.  

Required Tablespaces for OTM Database 

Tablespace Initial File Size 

ARCHIVE 1 GB 

DATA  1.5 GB 

INDX 3 GB 

REPORT 1 GB 

REPORTINDX 1 GB 

BPL_DAY1 1 GB 

BPL_DAY2 1 GB 

BPL_DAY3 1 GB 

BPL_DAY4 1 GB 
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Tablespace Initial File Size 

BPL_DAY5 1 GB 

BPL_DAY6 1 GB 

BPL_DAY7 1 GB 

PART_1 1 GB 

PART_2 1 GB 

PART_3 1 GB 

PART_4 1 GB 

MSG_PART_TBS1  1 GB 

LOB1 1 GB 

LOB2 1 GB 

LOB3 1 GB 

LOB4 1 GB 

LOB5 1 GB 

LOB6 1 GB 

LOB7 1 GB 

MSG_LOB_TBS1 1 GB 

TEMP 1 GB 

 

These tablespaces should be created first. A database administrator can write a script to create the 
tablespaces or use the provided procedure, which is described below. We recommend all OTM 
tablespaces are locally managed with automatic segment space management. 

The sizes specified above are minimal for the successful installation of the OTM database. LOB 
tablespaces are used to hold LOB objects, which are usually very space consuming. If the database is 
being used immediately with integrations, we recommend double the size of these tablespaces at the 

creation time. We also recommend giving 20% - 50% more space to the other tablespaces. 

Using Provided Procedure to Create Tablespaces 

We provide a SQL script, create_gc3_tablespaces.sql, to create all tablespaces of the OTM database. 
When you run this script, you are prompted for options, which are explained below. All of the 
tablespaces are locally managed with uniform size set as 5MB for LOB tablespaces and 1MB for the 
others. Only one datafile is created for each tablespace. The datafiles of all tablespaces are created in 
the same directory that you specify. If you want to create dictionary-managed tablespaces, and/or 
create tablespaces in different file systems/directories, you should run the script with Execute Now 
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option set to N. This way the process will generate create tablespaces statements in a log file. You can 

modify the statements and run them later manually. 

This script creates LOB tablespaces with 16 KB block size. This is the recommended block size for 
optimal performance. In order to create a tablespace with 16 KB block size, you should have the 

following init.ora parameter set if your database standard block size is not 16 KB. Change the cache 
size as needed for your database. 

db_16k_cache_size = 104857600 # 100MB for 16k block buffers 

 To run the script, log in to the database as user SYS and run script:  

create_gc3_tablespaces.sql. 

Create Tablespace Options 

 Parameter Default Option (Y/N) 

This process sets the following parameters with default values. If you do not want to use these values, 
you should enter N. The default is Y. 

file size: 1GB 
maximum file size(if auto extend is on): 2GB  

 Parameter Value Option 

If you choose N for Parameter Default Option, you can enter values you want for the above 
parameters. Otherwise, just press Enter. 

 Autoextend Option 

 Enter N if you do not want your datafiles to be autoextended. Default is Y. 

 Datafile directory 

Enter full path of datafiles directory. The trailing slash (/) for UNIX/Linux or back-slash (\) should be 
included. 

 Executing-Now Option 

Enter Y if you want to let the process to create tablespaces for you. Otherwise the process will 
generate create statements in the log file. Default is N. 

Create OTM Database Structure and Public Data 

These steps will create database users, structure and load public data. These steps will create 
following users on the database:  

 ARCHIVE 

 GLOGDBA 

 GLOGOWNER 

 GLOGLOAD 

 REPORTOWNER 

 GLOBALREPORTUSER 

 DIR_XML_USER 

The database users created have a password that matches their userid. 
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1. Set environment variable ORACLE_SID to your database SID. If the ORACLE_SID is not set 

within the system environment, you must set this within your current command prompt by 
typing “export ORACLE_SID=<your ORACLE_SID>”. You can check that this variable is active 

by typing “echo $ORACLE_SID”. You should see your ORACLE_SID displayed. 

2. Set environment variable NLS_LANG to: <LANGUAGE>_<TERRITORY>.UTF8. Here <LANGUAGE> is 

used for Oracle messages, day names, and month names. <TERRITORY> specifies conventions 
for default calendar, monetary, numerical format. For example, if in USA, you can set the 

parameter to AMERICAN_AMERICA.UTF8. For more information on NLS_LANG see the Oracle 

National Language Support Guide. 

3. Change to the <otm_install_path>/glog/oracle/script8 directory on the OTM application 

server.  

4. Create database users by running create_glog_users.sql script. This script will prompt for 

passwords; it will create user with the password that was entered. 

5. In SQL*Plus, as user SYS run: 

@create_glog_users.sql 

6. Create database schemas by running create_all script. This process is run at the host 
command line; Two command scripts are provided and the script you use is dependent on 

your operating system: 

UNIX shell script: 
 

./create_all.sh 

 

or 
 

Windows command line script: 

create_all.cmd  

7. Enter database connection ID, SYS user password, DBA user name that can create users 
(other than SYS user), password, and property file location information when prompted. It will 

also prompt for ARCHIVE, GLOGOWNER and REPORTOWNER user password. 

8. After the process has run, verify in the create_all_<dbsid>_<timestamp>.log file (located in 

the same directory as source) that there are no errors. Contact Technical Support if you find 

any errors like “ORA-“ or “Package Body created with compilation errors”. 

9. Also review the log file called import_content_<dbsid>_<timestamp>.log for errors (located 

in the same directory as the SQL script). Look for errors by searching key words like “ORA-“, 

“Caught exception”,”SP2-“, or “<Error>“ within the log file. Contact Technical Support if you 

find any errors. 

10. In SQL*Plus, as user GLOGOWNER run: 

@recompile_invalid_objects.sql 

After running the recompile_invalid_objects.sql script, you should see the following on the 
screen: 

Invalid objects after Recompile… 

0 

If the number of invalid objects is not zero, run the recompile_invalid_objects.sql script 

again. If you still have invalid objects after the second run, copy the script output from the 
command prompt window, paste into a text file, and forward it to Technical Support. 

Reset Sequences 

1. In SQL*Plus as the GLOGOWNER user, run: 

Set serverout on size 1000000 
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Execute domainman.reset_sequence; 

Verify Database Structure 

1. Change to the <otm_install_path>/gc3/glog/oracle/script8 directory on the OTM 

application server. 

2. In SQL*Plus, as user GLOGOWNER run: 

Select count(*) from all_objects where status=’INVALID’ and owner in 

(’GLOGOWNER’,’REPORTOWNER’,’GLOGLOAD’) and Object_name not like ’BIN$%’; 

The result should be: 

COUNT(*) 

       0 

3. Run: 

Select namespace from dba_context where schema = ’GLOGOWNER’; 

The result should be: 

NAMESPACE 

GL_USER_CTX  

4. Run: 

select object_owner, count(*) from dba_policies  

where object_owner in ('GLOGOWNER','REPORTOWNER') 

group by object_owner; 

The result should be: 

OBJECT_OWNER COUNT(*) 

GLOGOWNER 15192 

REPORTOWNER 138 

Archive Setup 

OTM stores archived orders and shipments in the separate schema named ARCHIVE.  The ARCHIVE 
schema is located on the transactional (OLTP) database by default.  Optionally, ARCHIVE schema can 
be moved to the Replicated Operational Database (ROD).  The upgrades/patches will automatically 
keep the archive objects in sync as new tables and columns are added into OLTP schemas.  Data is 
copied to the ARCHIVE schema when the OTM Data Purge process is run. 

Moving Archiving from OLTP to ROD 

Initially, archiving gets implemented on the OLTP database, you can move it to the ROD database. 
You will need the following to move archiving from OLTP to ROD database. 

 Export the archive schema 

 Login to OTLP database as system and run ‘drop user archive cascade’ 

 Run @create_archive_user.sql on the ROD as glogowner 

 Import archive schema onto the ROD database 
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 Create six database links as described below: 

 

1. On OLTP database as a GLOGOWNER, create a database link named “ROD.GC3” which 

connects to ROD database as glogowner user 

2. On OLTP database as a GLOGOWNER, create a database link named “ODS.GC3” which 

connects to ROD database as a glogowner user 

3. On OLTP database as a REPORTOWNER, create a database link named “ROD.GC3” which 

connects to ROD database as a glogowner user 

4. On OLTP database as REPORTOWNER, create a database link named “ODS.GC3” which 

connects to ROD database as a reportowner user 

5. On ROD database as a GLOGOWNER, create a database link named “OLTP.GC3” which 

connects to OLTP database as glogowner user 

6. On ROD database as a REPORTOWNER, create a database link named “OLTP.GC3” which 

connects to OLTP database as glogowner user 

 Login to ROD as glogowner and run @create_archive_objects.sql which will recreate the 

triggers and set up grants. 
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4. Installing Oracle Fusion Transportation Intelligence (FTI)  

OTM delivers the Oracle Fusion Transportation Intelligence (FTI) solution which includes the following 
components. For more details about these components and Oracle FTI, see the Oracle Fusion 

Transportation Intelligence Reference Guide. 

 Oracle Fusion Transportation Intelligence Extract Transform & Load (ETL): Pre-packaged ETL 

process deployed on an Oracle Data Integrator (ODI) instance 

 Oracle Fusion Transportation Intelligence Historical Database (HD): The analytics database for 

the Oracle Fusion Transportation Intelligence application 

 Oracle Fusion Transportation Intelligence Metadata: Delivered as advanced_analytics.rpd file 

 Oracle Fusion Transportation Intelligence Canned Reports: Delivered as aa_webcat.zip 

The steps required for installing and configuring Oracle FTI installation are detailed in this chapter. 

Note: Prerequisites for installing Oracle FTI are that you have experience with installing 

Oracle databases, OTM administration, OBI EE administration, ODI administration, and 

experience with Oracle ETL.  

Note: If you are installing Global Trade Intelligence or GTI, please see the next section, 

Installing Global Trade Intelligence (GTI). Although the installation of GTI is basically the 

same as FTI, there are some small differences. 

Installing Oracle FTI Historical Database (HD) 

Preparing OTM Database for FTI 

Operational Database 

Run the load_status_script.sql file. The script loads the READY_TO_LOAD status type with a status 

value of NOT_READY_TO_LOAD to all shipments, order bases, and order releases in OTM. This may 
take time depending on how many business objects are in the database. 

To run the script, complete the following: 

1. Log in to the OTM OLTP database as glogowner. 

2. In SQL*Plus, as user GLOGOWNER, run the following script: 

<otm_install_path>/glog/oracle/script8/advanced_analytics/load_status_script

.sql 

Replicated Operational Database (ROD) Considerations 

The deployment architecture of Oracle FTI supports the following deployment choices for customers: 

1. Load Historical Database using ROD 

 
In this deployment, a ROD (that maintains a snapshot of the OTM OLTP database) is used. The 

Oracle FTI ETL jobs will connect to the ROD to load the Historical Database thereby de-

coupling the OTM OLTP database from the ETL process. 

2. Load Historical Database using OLTP (Online Transaction Processing Database). 
 

In this deployment, the Oracle FTI ETL jobs will connect directly to the OTM OLTP database to 

load the Historical Database adding to additional database workload on the OTM OLTP 

database. 
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It is strongly recommended that you use a ROD to achieve performance gains and to efficiently 

balance the load on the OTM OLTP database. 

Historical Database (HD) Considerations 

The Historical Database (HD) schema can be created on a separate database beginning with OTM 6.2. 
This schema can also share the ROD or the OLTP database. 

Creating Historical Database (HD), Users, and Packages 

The create_aa_all.sql calls the CSV load utility. This utility obtains the details of an Oracle FTI 

database from the glog.properties file. The connection details for Oracle FTI are requested during the 
OTM installation. If you did not enter any values at the time of installation, you have to modify the 
glog.properties file and edit the following properties. 

1. Edit the properties included in the section of the glog.properties file titled “## Fusion 

Transportation Intelligence (FTI) – optional”. 

2. If necessary, remove the # so that these properties are no longer commented out. 

3. Specify the appropriate values based on the explanation in the following table: 

Note: Based on your answers during the OTM installation, these properties may already be 
set or may be commented out. 

Property Description 

glog.fti.dbserver Specify the fully qualified domain name of the Oracle FTI 
database server (this will contain the HDOWNER database 
schema). 

glog.fti.database.port Specify the port number of the FTI database server. 

glog.fti.database.schema Specify the name of the schema hosting the FTI database. 
This should typically be HDOWNER unless a different schema 
name is used. 

Example: HDOWNER 

glog.database.fti.sid Specify the Oracle FTI database SID/service name. 

glog.database.fti.user Oracle FTI database user name. An example and the default 
is HDOWNER. 

glog.database.fti.password Specify the password of the HDOWNER user in the FTI 
database. 

glog.fti.connectstring Specify the database connection string for the FTI Historical 

database. 

Do not change from the default of 
jdbc:oracle:thin:@$glog.fti.dbserver$glog.fti.databa

se.port$. 
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Creating FTI Tablespaces 

FTI requires two tablespaces: DATA and INDX. You should execute the create_aa_tablespaces.sql 

script to create the tablespaces required for the HD. 

1. On the database (as per your deployment architecture discussed above) where you want to 

install Oracle FTI, log into SQL*Plus as user SYS and run the following script: 

<otm_install_path>\glog\oracle\script8\advanced_analytics\create_aa_table

spaces.sql 

2. The script asks a series of questions: 

a. Review the default parameters listed and select Y to use the default or N to change 

them. 

b. Enter the file size. 
 

You can use K or M. Press ENTER to use the FTI default. 

c. Please enter maximum file size. 

 

It must greater than (file_size + 250M). Hit "ENTER" if you use FTI/GTI default. 

d. Enter Y or N to set auto extend on for data files. 

 

The default is Y. 

e. Enter the directory where you want the data files to be located including trailing 

"/" or "\". 

f. Enter Y or N to create tablespaces now. 

 

The default is N. 

Creating FTI Database Users 

1. Log into the database (as per your deployment architecture discussed above) where you want 

to install Oracle FTI. 

2. Using SQL*Plus, as user SYS, run the following script from the directory: 

<otm_install_path>\glog\oracle\script8\advanced_analytics\create_aa_users

.sql 

3. You see an explanation of what the script will do followed by some questions. 

a. Press the ENTER key to continue. 

b. Enter SYS password to login as SYSDBA. 

c. Enter Connection ID for the database to which you are connection as SYSDBA.  

 

This is specified in the glog.database.fti.sid property. 

4. Enter password for user HDOWNER. 
 

This is specified in the glog.database.fti.password property. 

 

Creating FTI Database Structure and Public Data 

1. Log into the database (as per your deployment architecture discussed above) where you want 

to install Oracle FTI. 

2. Using SQL*Plus, as user SYS, run the following script from the directory: 

<otm_install_path>\glog\oracle\script8\advanced_analytics\create_aa_all.sql 
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3. You see an explanation of what the script will do followed by some questions: 

a. Enter your Connection ID to the Oracle FTI Historical Database (HD) when prompted. 

 

This is specified in the glog.database.fti.sid property. 

b. Enter your SYS user password for the FTI database login as sysdba. 

 

This is the HDOWNER user password of your FTI database. See 

glog.database.fti.password. 

c. Enter GLOGOWNER user password of your OLTP database. 

 

The OLTP database is your OTM database. 

d. Enter connection string to the OLTP database when prompted. 
 

The OLTP database is your OTM database. 

e. Enter Y or N depending on machine type (UNIX or Windows). 

f. Enter path of directory where glog.properties file is located. 

4. After the process has run, verify in the create_aa_all.log file that there are no errors. 

 
Contact Technical Support if you find any errors like “ORA-“ or “Package Body created with 

compilation errors”. Also verify that csvone_aa_W_LOCALIZED_STRING_G.log file does not 

have any errors like “ORA-“, “Caught exception”,”SP2-“, or “<Error>”. Contact Technical 

Support if you find any other errors. 

 

Creating Oracle Data Integrator Database Users 

Now, you create the following Oracle Data Integrator users required for FTI. When you run the 
create_odi_users.sql script, you will be prompted for the password for each user listed below. 

 ftiodimaster 

 ftiodiwork 

 ftiodistage 

Note: Make note of the new passwords you enter for the Oracle Database Intelligence 

database users. You will need these in the ODI deployment steps for FTI in the subsequent 

sections. 

To create these users, complete the following: 

1. Log into the database (as per your deployment architecture discussed above) where you want 

to create the ODI related repositories for Oracle FTI. 

2. Using SQL*Plus, as user SYS, run the following script from the directory: 

<otm_install_path>\glog\oracle\script8\advanced_analytics\create_odi_user

s.sql 

3. You see an explanation of what the script will do followed by some questions: 

a. Enter SYS password to login as SYSDBA. 

b. Enter the Connection ID of the database to which you are logging in as SYSDBA.  

 

This will typically be the same database on which you installed the HDOWNER schema. 

c. Enter password for user ftiodimaster. 
 

Make note of this password because you will need it later in the FTI installation 

process. 
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d. Enter password for user ftiodiwork. 

 
Make note of this password because you will need it later in the FTI installation 

process. 

e. Enter password for user ftiodistage. 

 
Make note of this password because you will need it later in the FTI installation 

process. 

Installing Oracle Data Integrator (ODI) 

Certain files required for Oracle Data Integrator installations are available under 
<otm_install_path>/fti. If Oracle Data Integrator is installed on a different server than OTM, please 

copy these files to a folder where the installing user has write permissions. 

Note: The minimum settings required for installing Oracle Data Integrator for Oracle FTI 

are listed below. Refer to the Oracle Data Integrator Installation Manual for detailed 

instructions on how to install Oracle Data Integrator. 

Note: Installing the ODI agent in the database tier provides better performance than 

installing it in the application tier. 

Prerequisites: JDK version 1.6 installed. 

1. Execute ./runInstaller in Linux or setup.bat in Windows to start the ODI install. 

 

Installer will complete the pre-installer checks and ask for JDK home location.  

2. Enter the JDK 1.6 home directory. 

Note: JDK must be version 1.6. 

3. On the Welcome screen of the Oracle Data Integrator installation wizard, click Next >. 

4. On the Select Installation Type screen, select the Developer Installation option and 

Standalone Installation option. 

Note: Do not select the Java EE Installation option. 

5. Click Next >. 

6. On the Prerequisite Check screen, once the checks are completed, click Next >. 

7. On the Specify Installation Location screen, enter the absolute path for the Oracle home 

location (referred to later as ODI_HOME). 

Note: The specified directory must be an empty directory or an existing Oracle Data 

Integrator home location. 

8. Click Next >. 

9. On the Repository Configuration screen, select Skip Repository Configuration. 

10. Click Next >. 

11. On the Specify Agent Details screen, enter the Agent Name: FTI_AGENT. 

12. Specify Agent Port: 20910. 

13. Click Next >. 

14. On the Specify Security Updates screen, choose how you want to be notified about security 

issues: 

a. If you want to be notified about security issues through email, enter your email 

address in the Email field. 
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b. If you want to be notified about security issues through My Oracle Support, select the 

My Oracle Support option. Enter your email address in the Email field and enter your 

My Oracle Support Password. 

c. If you do not want to be notified about security issues, leave all fields empty. 

 

You will see the following message: "My Oracle Support Username/E-mail address not 
specified". 

 

Click Yes to continue. 

15. Verify the information on the Installation Summary screen. 

16. Click Save to save your configuration information to a file.  
 

This information includes port numbers, installation directories, URLs, and component names 

which you may need to access at a later time. 

17. Back in the Installation Summary screen, click Install. 

18. On the Configuration Progress screen, click Next >. 

19. On the Installation Completed screen, click Finish to complete the installation. 

 

Configuring ODI for Oracle FTI ETL 

Creating a New Oracle Data Integrator Repository Login 

Next, you create a login to connect to the Oracle Data Integrator repository. 

1. Open ODI Studio: 

a. In the Windows Start Menu, select Programs > Oracle Data Integrator > ODI 

Studio, or 

b. Also in Windows, launch <ODI_HOME>/oracledi/client/odi.exe or 

c. In Linux, run <ODI_HOME>/oracledi/client/odi.sh 

2. Open the New Gallery by choosing File > New. 

3. In the New Gallery window, in the Categories tree, select ODI.  

4. From the Items list, select Create a New ODI Repository Login. 

5. Click OK.  
 

The Repository Connection Information Screen opens. 

6. In the Oracle Data Integrator Connection section enter the following: 

a. Login name: A generic alias (for example: DEVREP) 

b. User: SUPERVISOR (use capitals) 

c. Password: Refer to the ODI Installation Guide for the ODI SUPERVISOR user 

password and enter that here. 

7. In the Database Connection (Master Repository) section enter the following: 

a. User: ftiodimaster 

b. Password: Enter the password for ftiodimaster user. 
 

(This is the password for the ftiodimaster user that you entered when you ran the 

create_odi_users.sql script. Creating Oracle Data Integrator Database Users. See 

Enter password for user ftiodimaster.) 

c. Drivers List: Choose Oracle JDBC Driver 
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d. URL (standard server configuration only): Enter the complete JDBC URL for the 

master repository data server. 
 

For example: jdbc:oracle:thin:@<FTI DB SERVER NAME>:<FTI DB PORT>:<FTI DB 

SID> 
 

See the following glog.properties for these settings: glog.fti.dbserver, 

glog.fti.database.port and glog.database.fti.sid. 

e. URL (RAC configuration only): Enter the RAC SCAN listener address and the service 
name as part of the URL as follows: 

 

For example: jdbc:oracle:thin:@<RAC SCAN LISTENER ADDRESS>:<PORT 

NUMBER>/<RAC DB SERVICE NAME> 

Note: Don’t click on Test Connection button to test the connection; because the 

master repository is not yet created. 

8. In the Work Repository section, enter the following: 

a. Select the Master Repository Only option. 

b. Click OK. 

c. Select Yes to make this the default login. 

d. Click OK again. 

 

Creating and Importing the Master Repository 

Next, you create the tables and the automatically import the definitions for the new ODI master 
repository. Due to performance, it is recommended that you have separate FTI ODI repositories 
instead of incorporating them along with other ODI applications. 

 The user completing this procedure must have write access to the folder that contains the 

FTI_ETL_MASTER.zip and FTI_ETL_WORK.zip files. 

 These files are available under <otm_install_path>/fti 

 If Oracle Data Integrator is installed on a different server, please copy these files to a folder 

where the installing user has write permissions. 

To create and import the master repository, complete the following: 

1. Open ODI Studio: 

a. In the Windows Start Menu, select Programs > Oracle Data Integrator > ODI 

Studio, or 

b. Also in Windows, launch <ODI_HOME>/oracledi/client/odi.exe, or 

c. In Linux, run <ODI_HOME>/oracledi/client/odi.sh 

2. Select File > New to open a new gallery. 

3. In the New Gallery window, in the Categories tree, select ODI.  

4. From the Items list, select Master Repository Import Wizard.  

5. Click OK. 

6. In the Database Connection section, complete the following: 

a. Login information: Since you selected ODI in step 3 above, the first five fields (Login 

through Password will be pre-populated based on what you set in the previous section 

Creating a New Oracle Data Integrator Repository Login). 
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Note: Do not click on Test Connection button to test the connection; because 

the master repository is not yet created. 

b. DBA User:<System User> 

c. DBA Password: <System User Password> 

7. In the Repository Configuration section, complete the following: 

a. ID: A specific ID for the new repository. 

 

You should choose a number greater than 100 and less than 600. Always remember to 
choose different numbers for the development, QA, user acceptance, and production 

environments. This will affect imports and exports between repositories. 

b. Select the Use a Zip File check box. 

c. Export Zip File path: Choose the file FTI_ETL_MASTER.zip. 

 
This file is located in <otm_install_path>/fti/etl/odi/. 

 

If OTM is on a different server, then chose the location where you copied this file on 

the ODI server. 

d. Technology: From the list, choose Oracle. 

8. Click Finish to begin master repository creation. 

 

This process may take up to 10 minutes. 

9. Validate the JDBC URLs for source and target databases by completing the following for each 

schema listed below: 

 ORACLE_FTI: (QA or PROD or UAT) Environment’s historical database hdowner 

schema mapped to global context. Enter the JDBC URL of the FTI production/QA/UAT 

database which contains the HDOWNER schema.  
 

See the following glog.properties for these settings: glog.fti.dbserver, 

glog.fti.database.port and glog.database.fti.sid. 

 ORACLE_FTI_DEV: Development environment’s historical database hdowner schema 
mapped to development context.  

 

Note: If you do not have a development environment, you do not need to specify this 

URL. 

 ORACLE_OTM: (QA or PROD or UAT) Environment’s OTM glogowner schema mapped 

to global context. 

 

This is the JDBC URL for your OTM server. 

 ORACLE_OTM_DEV: Development environment’s OTM glogowner schema mapped to 

development context.  

 
Note: If you do not have a development environment, you do not need to specify this 

URL. If the target database is a RAC, make sure to use the SCAN listener and service 

name in the URL. 

10. To validate the URLs, complete the following for each schema listed above: 

a. Click on the Connect To Repository… link. 

b. In the Login Name list, choose the ODI repository login (see Oracle Data 

Integrator Connection ). 

c. Click OK. 

d. Click on Topology tab. 

e. Go to the Physical Architecture pane and expand Technologies > Oracle. 
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f. Double-click the schema name (for example, ORACLE_FTI). 

g. Click the JDBC tab. 

h. Enter the corresponding JDBC URL for each schema. 

 
The JDBC URL should be in the form of jdbc:oracle:thin:@<DB SERVER>:<DB 

PORT>:<DB SID>. See the explanations in step 9 above to determine what URL to use 

for each schema. 

11. Next, for each schema listed above make sure connection to the data server is set up correctly 

as follows: 

a. Click Definition tab. 

b. In the Connection section, for the ORACLE_FTI and ORACLE_FTI_DEV schemas, 

enter the following: 

i. User: ftiodistage 

 

You created this when Creating Oracle Data Integrator Database Users. 

ii. Password: <password for the ftiodistage user>. 

 

This is the password for the ftiodistage user that you entered when you ran 
the create_odi_users.sql script. Creating Oracle Data Integrator Database 

Users. See Enter password for user ftiodistage. 

c. In the Connection section for the ORACLE_OTM and ORACLE_OTM_DEV schemas, 

enter the following: 

i. User: glogdba 

ii. Password: <password for the glogdba user> 
 

Refer to your OTM administrator for this information. 

12. Click the Save All button. 

13. Expand Agents and double-click the FTI_AGENT agent. 

14. In the Host field, give the server name or the IP address of the machine where you 

installed ODI. 

15. Click the Save All button. 

 

Creating the Work Repository 

To create a work repository, complete the following: 

1. In the Topology Navigator, go to the Repositories panel. 

2. Right-click the Work Repositories node and select New Work Repository. 

3. In the Create Work Repository wizard, specify the Oracle Data Integrator work repository 

connection details as follows:  

a. Technology: Choose Oracle.  

 

The default is Oracle. 

b. JDBC Driver: oracle.jdbc.OracleDriver 

c. JDBC URL (standard server configuration only): The complete path of the data 
server to host the work repository.  

 

For example: jdbc:oracle:thin:@<FTI DB SERVER>:<FTI DB PORT>:<FTI DB SID> 
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d. JDBC URL (RAC configuration only): Enter the RAC SCAN listener address and the 

service name as part of the URL as follows: 
 

For example: jdbc:oracle:thin:@<RAC SCAN LISTENER ADDRESS>:<PORT 

NUMBER>/<RAC DB SERVICE NAME> 

e. User: ftiodiwork 
 

You created this when Creating Oracle Data Integrator Database Users. 

f. Password: Enter the password for ftiodiwork user. 

 
(This is the password for the ftiodiwork user that you entered when you ran the 

create_odi_users.sql script. See Creating Oracle Data Integrator Database Users and 

Enter password for user ftiodiwork.) 

4. Click Test Connection to check the connection is working. 

5. Click Next >. 

6. Specify the Oracle Data Integrator work repository details:  

a. ID: Give a unique number to your repository, from 1 to 500. 

b. Note: It is strongly recommended that this ID is unique and not used for any other 

work repository, as it affects imports and exports between repositories  

c. Name: Give a unique name to your work repository (for example: FTI_WORK). Try to 

have only letters or numbers. Don’t use special characters and spaces in between the 

words.  

d. Password: leave blank 

e. Work Repository Type: Choose Development from the list. 

Note: It is recommended that you select a Work Repository Type of 
Development since this type allows you to make changes to the work repository 

in the future. If you select a work repository type of Production, then you will 

not be able to edit the work repository. 

7. Click Finish. 

 

The Create Login dialog box opens. 

8. Click No. 

9. Click Save in the toolbar. 

Importing the Work Repository 

To import the work repository, complete the following: 

1. If you connected to the master repository only, disconnect by clicking: ODI > Disconnect 

<Login name>. 

2. On the Designer tab, click Connect to Repository… 

3. On the Oracle Data Integrator Login screen, click the pencil icon to edit the Login Name. 

4. On the Repository Connection Information screen in the Work Repository section, select the 

Work Repository option. 

5. Search for and select the name of the Name that you entered in the previous section, 

Creating the Work Repository. 

6. Click OK on the Repository Connection Information screen. 

7. Click OK on the Oracle Data Integrator Login screen. 

8. Connect to the work repository. 
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9. From Designer tab, click the Connect Navigator icon, then select Import > Work 

Repository. 

10. Specify an Import Mode of Synonym Mode INSERT_UPDATE. 

11. Select the Import From a Zip File check box. 

12. Choose FTI_ETL_WORK.zip.  
 

This file is located in <otm_install_path>/fti/etl/odi/. 

 

If OTM is on a different server, then chose the location where you copied this file on the ODI 

server. 

13. Click OK to import the work repository. 

 

This process may take up to 40 minutes. Do not close or kill the process. 

Note: During this process you may get a dialog box saying that the ID <object ID> 

does not exist. Click OK to create it. 

Starting the Oracle Data Integrator Agent Process 

Configuring the Oracle Data Integrator Agent 

To configure the Oracle Data Integrator agent, complete the following: 

Note: To encode passwords, use <ODI_HOME>\oracledi\agent\bin\encode.sh in Linux or 
<ODI_HOME>\oracledi\agent\bin\encode.bat in Windows. 

1. Navigate to <ODI_HOME>\oracledi\agent\bin 

2. Open the file odiparams.sh in Linux or odiparams.bat in Windows. 

3. Set the values for following parameters as shown below: 

Parameter Value Description 

ODI_MASTER_DRIVER oracle.jdbc.OracleDriver Must be set to this value. 

ODI_MASTER_URL jdbc:oracle:thin:@<FTI DB 

SERVER>:<FTI DB PORT>:<FTI 

DB SID> 

Enter the same value that you set up 
previously for your FTI database URL 
(standard server configuration 
only): Enter the complete JDBC URL for. 

ODI_MASTER_USER ftiodimaster Enter the same value that you set up 

previously for the ftiodimaster User. 

ODI_MASTER_ENCODE

D_PASS 

<Use encoded password> This is the encoded version of the 
password for the ftiodimaster user that 
you entered when you ran the 
create_odi_users.sql script. 

Refer to Creating Oracle Data Integrator 
Database Users. 

ODI_SUPERVISOR SUPERVISOR Enter the same value that you set up 
previously for the Login name 
instructions. 



Copyright © 2001, 2015, Oracle and/or its affiliates. All rights reserved. 4-12 

ODI_SUPERVISOR_EN

CODED_PASS 

<Use encoded password> This is the encoded version of the 

Password for the SUPERVISOR user that 

you set up previously. 

ODI_SECU_WORK_REP FTI_WORK This is the Name that you specified 
when creating the work repository 
previously. 

 

Starting the Oracle Data Integrator Agent 

To start the Oracle Data Integrator agent, complete the following: 

1. In ODI Studio, go to the Topology Tab > Physical Architecture. 

2. Expand Agents. 

3. Double click on FTI_AGENT. 

4. Enter Host and save it.  

Note: Host is machine name/IP Address of machine where you installed ODI. 

5. Navigate to <ODI_HOME>\oracledi\agent\bin 

6. Start the Oracle Data Integrator agent as follows: 

a. UNIX: Run ./agent.sh -NAME=FTI_AGENT 

b. Windows: Run ./agent.bat -NAME=FTI_AGENT 

c. To run in the background process on UNIX, use following command: 

nohup ./agent.sh –NAME=FTI_AGENT & 

Note: You must set the parameter of NAME to the Agent Name of the ODI agent 

(the default is FTI_AGENT) which you defined in topology manager’s physical 

architecture Agent section. 

Installing Oracle Business Intelligence Enterprise Edition (OBIEE) 

For detailed installation steps of OBIEE on your preferred operating system, please refer to the 
corresponding OBIEE installation documentation. 

Oracle FTI is officially certified only for OBIEE deployed using WebLogic. If you need to use a web 
application server of your choice, then please refer the OBIEE documentation for the compatibility of 
OBIEE on your choice of web application server and also for detailed deployment instructions. 

Installing OTM and FTI on Single Server 

OTM and Oracle FTI can be installed on the same server by following these guidelines. Skip this 
section if you choose to have OTM and FTI on different machines. 

The server machine must be a multi-homed system (two hostnames/IP addresses) which means a 
single server with two network cards. 

 Primary hostname: should contain the OBIEE install 

 Secondary hostname: should contain the OTM install 

Guidelines for Installing OTM and FTI on Single Server 

1. OTM should be brought down to unblock the default WebLogic Admin port (7001). 
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2. Install OBIEE per the OBIEE installation instructions. See Installing OBIEE. 

Note: By default OBIEE uses the primary hostname and default port (7001) for 

installation. 

3. Stop OBIEE per the OBIEE installation instructions. 

4. Restart the server. 

5. Start OTM. 

6. Restart OBIEE per the OBIEE installation instructions. 

 

Creating Repository Schema Using the Repository Creation Utility 

Prior to installing OBIEE, you need to download and run the Repository Creation Utility (RCU). You can 

download this tool from the Oracle Technology Network. 

Refer the Document "Oracle® Fusion Middleware Installation Guide for Oracle Business Intelligence 
11g Release 1 (11.1.1)" section "3 Oracle Business Intelligence Requirements" and sub-section 
"Create Database Schemas Using the Repository Creation Utility (RCU)" for details on running the 
RCU. 

1. Download the Repository Creation Utility from OTN. 

2. Run the RCU utility to create the repository schemas necessary for OBIEE and FTI. 

3. In the RCU, select the Oracle Business Intelligence Component. 

 

This action automatically selects the Metadata Services (MDS) schema (under the AS Common 
Schemas group) and Oracle Business Intelligence (BIPLATFORM) schema, which are required 

by Oracle Business Intelligence. 

4. Note the schema names and passwords created by the RCU.  

 

These will be used during the OBIEE installation. The schema names should be unique (for 

example, Yourname_MDS and Yourname_BIPLATFORM). 

Installing OBIEE 

1. Select simple install while installing OBIEE 11g. 

Refer to the chapter “Installing Oracle Business Intelligence” in “Oracle® Fusion Middleware 
Installation Guide for Oracle Business Intelligence 11g Release” document for complete details. 

Note: When the installation completes, the WebLogic server and Oracle BI server start by default 

and a browser window opens to the home page. For example, 

http://<hostname>:7001/analytics/saw.dll?Answers. 

Configuring OBIEE for Oracle FTI 

Once you successfully installed OBIEE, complete this section to deploy the Oracle FTI components 

(metadata & reports). This section also contains details on the various other configurations required in 
the OBIEE and OTM applications to complete the Oracle FTI deployment. Please perform the 
configuration steps in the following sequence: 

 Creating RPTAPP and OLTP Database Connections 

 Configuring FTI Metadata Repository Password 

 Configuring FTI Metadata Repository  

 Copying FTI Web Catalog to OBIEE  



Copyright © 2001, 2015, Oracle and/or its affiliates. All rights reserved. 4-14 

 Deploying FTI Metadata Repository & Web Catalog to OBIEE  

 

Creating RPTAPP and OLTP Database Connections 

On the OBIEE server, create two new database connections with the name RPTAPP and OLTP: 

 RPTAPP should connect to the Oracle FTI historical database. 

 OLTP should connect to OTM database. 

To do this, complete the following: 

1. Open the <OBIEE_INSTALL_PATH>\Oracle_BI1\network\admin\tnsnames.ora file.  

Note: Only complete these steps in the exact tnsnames file listed above. 

2. For a standard database connection, add the following into the tnsnames.ora file: 

RPTAPP = 

(DESCRIPTION = 

  (ADDRESS_LIST = 

    (ADDRESS = (PROTOCOL = TCP)(HOST = <FTI HD Host>)(PORT = <FTI HD Port>)) 

    ) 

  (CONNECT_DATA = 

    (SID = <FTI HD SID>) 

  ) 

) 

 

OLTP = 

(DESCRIPTION = 

  (ADDRESS_LIST = 

    (ADDRESS = (PROTOCOL = TCP)(HOST = <OTM OLTP DB Host>)(PORT = <OTM OLTP Port>)) 

    ) 

  (CONNECT_DATA = 

    (SID = <OTM OLTP DB SID>) 

  ) 

) 

3. For a standard database connection, update the following entries to correspond with your FTI 

configuration: 

a. Under RPTAPP, set the following: 

i. (HOST =<FTI HD Host>) should be the FTI DB server name as specified in 

numerous places: glog.fti.dbserver, URL (standard server configuration 

only): Enter the complete JDBC URL for. 

ii. (SID = <FTI HD SID>) should be the FTI DB SID as specified in numerous 
places: glog.database.fti.sid, URL (standard server configuration only): 

Enter the complete JDBC URL for. 

iii. (PORT = <FTI HD Port>) should be the FTI DB Port as specified in numerous 

places: glog.fti.database.port, URL (standard server configuration only): 

Enter the complete JDBC URL for. 

b. Under OLTP, set the following: 

i. (HOST =<OTM OLTP DB Host>) should be the OTM DB server name as 

determined during the OTM install. 

ii. (SID = <OTM OLTP DB SID>) should be the OTM DB SID as determined during 

the OTM install. 
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iii. (PORT = <OTM OLTP Port>) should be the OTM DB Port as determined during 

the OTM install. 

4. For a RAC database connection set the RPTAPP as shown below: 

RPTAPP = 

(DESCRIPTION = 

(ADDRESS = (PROTOCOL = TCP)(HOST = <RAC SCAN LISTENER ADDRESS>)(PORT = <SCAN 

LISTENER PORT NUMBER>)) 

(CONNECT_DATA =  

(SERVER = DEDICATED) 

(SERVICE_NAME = <RAC SERVICE NAME>)) 

) 

a. Under RPTAPP, set the following: 

i. (HOST =<RAC SCAN LISTENER ADDRESS>) should be the RAC SCAN listener 

address. 

ii. (PORT = <SCAN LISTENER PORT NUMBER>) should be the RAC SCAN listener 

port number. 

iii. (SERVICE_NAME = <RAC DB SERVICE NAME>) should be service name of the 

RAC database server. 

b. Set the OLTP up as detailed for a standard database connection. 

5. Open the user.cmd file.  

 
This file is located in 

<OBIEE_INSTALL_PATH>\instances\instance1\bifoundation\OracleBIApplication\corea

pplication\setup. as follows: 

6. Add the following to the line REM set TNS_ADMIN=: 

<OBIEE_INSTALL_PATH>\Oracle_BI1\network\admin; 

When OBIEE loads the Oracle Fusion Transportation Intelligence metadata, it will connect to the HD 

and OLTP databases using the RPTAPP and OTLP tnsname entries only. 

 

Configuring FTI Metadata Repository Password 

The metadata repository file advanced_analytics.rpd that is shipped with FTI is set with the default 

password transportationintelligence1. 

Warning: For security reasons, it is strongly recommended that you change this default password 

to a secured password before deploying it in OBIEE. 

To change the default repository password, complete the following: 

1. On a Windows machine, download and install Oracle Business Intelligence Developer Client 

Tools Installer (11.1.1.7.1). It is available for download from the Oracle Technology Network. 

Note: This must be a Windows system since the BI Administration tool is only available for 

Windows.  

2. Copy <otm_install_path>/fti/advanced_analytics.rpd to the Windows system where the 

BI Administration tool is installed. 

3. Provide the default password as shipped for advanced_analytics.rpd file. 

Note: If RPD is read-only, change it to read/write, before opening in BI Administration 

Tool. 
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4. Select File->Change Password. 

5. Enter the old password. 

6. Enter the new password. 

7. Confirm the new password. 

8. Click ok. 

9. Save and close the repository. 

Note: Make note of the modified repository password as this will be needed for the following: 

 Deployment of the advanced_analytics.rpd repository file in OBIEE 

 Configuration/customization of the advanced_analytics.rpd repository 

 

Configuring FTI Metadata Repository 

Before deploying the FTI repository file, you must configure it to connect to the FTI historical database 
and the OTM OLTP database. 

Note: This must be a Windows system since the BI Administration tool is only available for 

Windows. 

To configure these connections, complete the following: 

1. Using BI Administration Tool, open the advanced_analytics.rpd in offline mode. 

2. In Physical Layer, expand each database definition and in each connection pool specify the 

following: 

a. HDOWNER database user’s password where HDOWNER user is set 

b. GLOGDBA database user’s password where GLOGDBA user is set 

3. Save the RPD. 

4. Select No when prompted for Global Consistency. 

 

Copying FTI Web Catalog to OBIEE 

1. Copy the FTI webcatalog from the OTM server: 

<otm_install_path>/fti/aa_webcat.zip 

to the following directory on the OBIEE server: 

<OBIEE_INSTALL_PATH>\instances\instance1\bifoundation\OracleBIPresentatio

nServicesComponent\coreapplication_obips1\catalog\ 

2. Unzip the aa_webcat.zip file. 

 

The aa folder is created. 

3. Unix/Linux: You must give read/write/execute permissions to any user on aa folder. 

4. Copy the file smartway-logo.jpg available in the OTM directory below: 

<otm_install_path>/fti/ 

to the following OBIEE directories: 
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 <OBIEE_INTSALL_PATH>\Oracle_BI1\bifoundation\web\app\res\s_blafp\imag

es 

 <OBIEE_INSTALL_PATH>\user_projects\domains\bifoundation_domain\server

s\AdminServer\tmp\_WL_user\analytics_11.1.1\7dezjl\war\res\s_blafp\im

ages 

Note: The 7dezjl folder might not be present in all the nodes. Instead, the folder name 

might be different. In each node, you need to find out the folder in 

/<OBIEE_INSTALL_PATH>/user_projects/domains/bifoundation_domain/servers/b

i_server1/tmp/_WL_user/analytics_11.1.1/ allowing you to navigate to 

/war/res/s_blafp/images. 

5. Modify the instanceconfig.xml as follows: 

a. Open the file: 
<OBIEE_INSTALL_PATH>\instances\instance1\config\OracleBIPresentationServi

cesComponent\coreapplication_obips1\instanceconfig.xml 

b. Add the following tag in between the <Security> </Security> tag. 

<InIFrameRenderingMode>allow</InIFrameRenderingMode> 

Deploying FTI Metadata Repository & Web Catalog to OBIEE 

1. Copy the FTI advanced_analytics.rpd to a folder that can be accessed by the OBIEE server. 

2. Open a browser and log into the OBIEE EM Console.  

 
You can use the login you created in OBIEE installation to log into the EM console using the 

following URL: http://<obieeserver>:7001/em 

3. Expand the Business Intelligence node on the left and select Coreapplication. 

4. Click on the Deployment tab. 

5. Click on the Repository tab. 

6. Click on Lock and Edit Configuration to change the default settings. 

7. In the Upload BI Server Repository section, click on the Browse… button and locate your 

new RPD file. 

8. Enter the FTI metadata repository password.  
 

You created this when installing OBIEE. 

9. Reenter the password. 

10. In the BI Presentation Catalog section, update the path as follows: 

<OBIEE_INSTALL_DIR>\instances\instance1\bifoundation\OracleBIPresentation

ServicesComponent\coreapplication_obips1\catalog\aa 

11. Optional step: Mail configuration to receive mails from OBIEE: 

a. Click on Mail. 

b. Provide SMTP Server details. 

12. Click Apply in the top-right corner of screen. 

13. Click Activate Changes. 

14. Click on the Overview tab. 

15. Click the blue Restart button. 

16. Click Yes on dialog box to confirm and wait for the message that confirms successful restart.  

With this step, you have completed all the configuration steps in OBIEE. 
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Note: To test that FTI is successfully configured, browse to the following URL: 

http://<obieeserver>:7001/analytics 

Configuring OTM for Oracle FTI 

OTM Properties 

After successfully installing and configuring ODI and OBIEE, follow the instructions below to configure 

the FTI related properties in OTM. 

Note: These properties may already be uncommented out (the # symbols are removed) 
depending on how you complete the OTM installation. If this case, just verify that the 

property values are correct. 

1. Open the file <OTM Install Dir>/glog/config/glog.properties 

2. Remove the # symbols and enter the appropriate values for the properties listed in the table 

below: 

Note: Based on your answers during the OTM installation, these properties may already be 

set or may be commented out. 

Property Name Description 

OBIEE Specific Properties (These are set in glog.properties file.) 

aa_webserver Specify the complete URL of the OBIEE server along with the 
port number. If setting up reverse proxy server (the 
recommended approach), specify the HTTP Server here. See 
Configuring the OTM HTTP Server's Proxy Settings: for more 

details. 

Example: aa_webserver = 

http://myfti.mydomain.com:7001 

Be sure to include the http:// or https:// as applicable. 

As OTM does not pass through the URL on an internal DNS 

name, you will need to open a firewall IP and port so that 
OTM can call the external fully qualified domain name 
(FQDN). After the changes are made, you will need to restart 
the OTM web server. 

allow_advanced_analytics Use this to enable/disable the Fusion Transportation 

Intelligence (FTI) option in OTM. Use the values TRUE or 
FALSE. 

Example: TRUE 

glog.fti.dbserver You set this earlier in the installation process. See 
glog.fti.dbserver. 

glog.fti.database.port You set this earlier in the installation process. See 

glog.fti.database.port. 
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Property Name Description 

glog.database.fti.sid You set this earlier in the installation process. See 
glog.database.fti.sid. 

glog.fti.database.schema You set this earlier in the installation process. See 
glog.fti.database.schema. 

glog.database.fti.user You set this earlier in the installation process. See 
glog.database.fti.user. 

glog.database.fti.password You set this earlier in the installation process. See 
glog.database.fti.password. 

glog.fti.connectstring You set this earlier in the installation process. See 
glog.fti.connectstring. 

glog.security.userSession.enabled To enable navigation from Oracle Transportation 
Management to Fusion Transportation Intelligence without an 
external single sign on (SSO) solution, set this property to 

"true" on the Oracle Transportation Management web server. 

The default is false. 

See the Oracle Transportation Management Security Guide 
for complete details about enabling single sign on. 

ODI Specific Properties (These are set in glog.properties file.) 

glog.odi.agent.server Specify the host name of the server that is running the ODI 

agent. 

glog.odi.agent.port Specify the port number on the server on which the ODI 
agent is running. 

glog.odi.password Specify the password of the ODI login user. See Password. 

Example: The password of SUPERVISOR user. Refer to the 
ODI installation documentation for this password. 

glog.odi.work.repository.code Specify the name of the FTI work repository deployed in the 
ODI server. See Name. 

Note: glog.odi.work.repository.code is the Work 

Repository Name that you specified while creating the work 

repository. 

Example: FTI_WORK 

glog.odi.email.from.address=ftiad

min@yourdomain.com 
Specify from e-mail address to send ETL results. 

Example:ftiadmin@yourdomain.com 
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Creating Business Intelligence Roles in OBIEE or OBIA 

In previous versions of Fusion Transportation Intelligence, the Business Intelligence Roles or BI roles 
were mapped to groups in OBIEE. Since OBIEE no longer uses groups, the BI roles must be mapped to 
roles. Due this change, the following BI Roles have been deprecated and replaced with the 
corresponding default OBIEE role: 

 DEVELOPER is replaced with OBIEE role of BIAuthor 

 EXECUTIVE is replaced with OBIEE role of BIConsumer 

 OPERATIONAL is replaced with OBIEE role of BIConsumer 

 PRESENTATION SERVER ADMINISTRATOR is replaced with OBIEE role of BIAdministrator 

Refer to the OBIEE document “Oracle® Fusion Middleware System Administrator's Guide for Oracle 
Business Intelligence Enterprise Edition 11g Release 1 (11.1.1) section C.2.2 "Working with Catalog 
Groups” for details on why groups are replaced by roles. 

You need to create the following BI Roles on the OBIEE/OBIA-WebLogic server: 

 LSP CUSTOMER 

 LSP HOST 

 SERVPROV 

 NO ACCESS 

Note: The spelling of the BI Roles in FTI and the spelling of the roles in OBIEE/OBIA-

WebLogic server MUST be identical. 

You need to add these roles in your local OBIEE instance as guided by Oracle® Fusion Middleware 
Application Security Guide 11g Release 1 (11.1.1) section 7.3.2 Migrating Policies with the Command 
migrateSecurityStore. 

First, let’s review the two main files that you will use in this process: 

 system-jazn-data.xml – is the master file for all roles. You have a version of this file which 

OBIEE installed and a version specific to Fusion Transportation Intelligence. Use the process 

below to merge the two versions of this file. 

 jps-config.xml – contains the paths of the system-jazn-data.xml file which has to be modified 

and the system-jazn-data.xml file which has the roles that are shipped. 

1. To add the FTI Business Intelligence Roles to your local OBIEE instance, complete the 

following: 

a. Back-up the OBIEE/OBIA roles configuration files in your OBIEE/OBIA installation path 

as follows: 

b. Copy the file, system-jazn-data.xml, and paste it to a local folder. This is 

your backup.  

 

This file is located:  

OBIEE_HOME\user_projects\domains\bifoundation_domain\config\fmwcon

fig\ 

c. Copy the file, jps-config.xml, and paste it to a local folder. This is your 

backup. 
 

This file is located: 

OBIEE_HOME\user_projects\domains\bifoundation_domain\config\fmwcon

fig\ 

d. Create a folder called OBIEE_BI_ROLES in your local machine. 
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e. Copy the two files mentioned above, system-jazn-data.xml and jps-

config.xml to the new OBIEE_BI_ROLES folder.  
 

This should be a separate folder from the backup folder. So you will have two 

copies of these files: 1 as a backup and the other copy in the 

OBIEE_BI_ROLES folder. 

2. Next, locate the system-jazn-data.xml and jps-config.xml files that shipped with Fusion 

Transportation Intelligence. 

a. system-jazn-data.xml is located in GC3\glog_deploy\report\advanced_analytics\ 

b. jps-config.xml is located in GC3\glog_deploy\report\advanced_analytics\ 

c. Create a folder called OTM_BI_ROLES in your local machine. 

d. Copy both of these files to the newly created OTM_BI_ROLES folder. 

3. Edit the file \OTM_BI_ROLES\jps-config.xml to set it up for the merge and modify the path of 

system-jazn-data.xml file in the jps-config.xml as follows.  

a. In the following line, add the path to the system-jazn-data.xml file that you copied to 

the OTM_BI_ROLES folder: 

<serviceInstance name="srcpolicystore.xml" 

provider="policystore.xml.provider" location="\OTM_BI_ROLES\system-

jazn-data.xml">             

<description>File Based Policy Store Service Instance</description>         

</serviceInstance> 

b. In the following line, add the path to the system-jazn-data.xml file that you copied to 

the OBIEE_BI_ROLES folder: 

<serviceInstance name="policystore.xml" 

provider="policystore.xml.provider" location="\OBIEE_BI_ROLES\system-

jazn-data.xml">             

<description>File Based Policy Store Service Instance</description>         

</serviceInstance> 

Next, you need to merge the files in the OTM_BI_ROLES and the OBIEE_BI_ROLES folders. This 
process will merge the roles from \OTM_BI_ROLES \system-jazn-data.xml file to the 
\OBIEE_BI_ROLES \system-jazn-data.xml file. 

4. Go to OBIEE_HOME\oracle_common\common\bin. 

5. Execute wlst command in script as follows: 

a. At the command prompt, execute wlst.cmd for Windows and wlst.sh for unix. 

b. Then execute the following commands: 

i. For unix: 

migrateSecurityStore(type="appPolicies", srcApp="obi", 

configFile="/OTM_BI_ROLES/jps-config.xml ", src="sourceFileStore", 

dst="targetFileStore", overWrite="false") 

ii. For Windows: 

migrateSecurityStore(type="appPolicies", srcApp="obi", 

configFile="\OTM_BI_ROLES\jps-config.xml ", src="sourceFileStore", 

dst="targetFileStore", overWrite="false") 

6. Once this completes, copy the merged file and overwrite the existing files in OBIEE as follows: 

a. Copy the modified \OBIEE_BI_ROLES\system-jazn-data.xml file. 

b. Replace and overwrite the system-jazn-data.xml file located in 

OBIEE_HOME\user_projects\domains\bifoundation_domain\config\fmwconfig\ 
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7. Restart all the WebLogic components. 

Configuring FTI Support of URL Redirects on OTM Shipment IDs 

To facilitate looking-up of corresponding shipments in OTM, FTI reports support URL redirects on 
shipment IDs. To build the URL, FTI uses the parameter OTM_WEB_SERVER that can be configured in 
OTM. 

To configure this in OTM, complete the following: 

1. Log into OTM as DBA.ADMIN. 

2. Navigate to Business Process Automation > Power Data > Document Generation > 

Report Common Properties 

3. Edit the property OTM_WEB_SERVER. 

4. Change the default value from data content to the correct OTM URL which will be similar to the 

one shown below: 

 http://<OTM Hostname>/GC3 

 

For example: http://myhost.mydomain.com/GC3 

5. Click Finish to complete the configuration change in OTM. 

6. For this configuration change to reflect in FTI, the ROD refresh job (if a ROD is in use) must be 

executed.  

 

If a ROD is not in use this step is not applicable. 

7. Restart the OBIEE services and then access the FTI Dashboard Reports. 

Note: This configuration step must be done when configuring FTI for the first time to the 

OTM application or whenever the OTM application’s web server is modified. 

Deploying Multiple RPDs in a Single OBIEE11g Installation 

This section provides instructions how to deploy two repository (RPD) files in a single installation of 
OBIEE. For complete details on the OBIEE installation, see the ORACLE® FUSION MIDDLEWARE 

INSTALLATION GUIDE FOR ORACLE BUSINESS INTELLIGENCE 11G RELEASE 1 (11.1.1), chapter 2 
Recommended Installation Scenarios for Oracle Business Intelligence. Specifically, refer to the 
sub section 2.2.3.2 Installing Multiple, Standalone Oracle Business Intelligence Instances on 
a Single Computer. 

You can establish multiple instances of OBIEE on single installation of OBIEE on the same computer. 
In this process, an additional WebLogic domain is created which establishes the connection between 
Oracle BI Home and the second instance of OBIEE. 

Pre-requisites: 

Installation of OBIEE on the machine has already been completed. As a result, you have an OBIEE 

directory, which already has an instance generated, and OracleBI Home directory. 

Generating a Second Instance of OBIEE 

Complete the following steps to generate a second instance of OBIEE in single OBIEE installation 

directory: 

1. Create new schema using the RCU utility for the new instance. 

a. Run the command rcu.bat to create the new schema. 
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2. Run the batch file config.bat present in the path below to use the Configuration Assistance to 

generate another instance of OBIEE: 

Á Middlewarehome > OracleBI1>bin>config.bat 

3. Click Next until you see a window to select Create New BI System. 

4. Select the Create New BI System option. 

5. Enter a different name for Domain Name.  
 

For example: bifoundation_domain2 

6. Enter the WebLogic user name and password. 

7. Click Next. 

8. Click Next again. 

9. Enter the Connect string. 

10. Enter the schema name and password created using RCU in first step for BIPLATFORM 

Schema_Username and password. 

11. Click Next. 

12. Enter the same schema name and password created using RCU in first step for MDS_SCHEMA. 

13. Click on Next until you see a window which contains the Configure button. 

14. Click the Configure button. 

15. Click Finish. 

Now the second instance of OBIEE is generated in the same OBIEE installation directory. To verify the 
instance was generated, go to the following path: 

 Middlewarehom > instances 

After following the above mentioned steps, the following URLs are generated to access both of the 
instances: 

Instance1     Instance2 

 http://localhost:7001/em   http://localhost:7002/em 

 http://localhost:7001/analytics       http://localhost:9704/analytics 

 http://localhost:7001/console   http://localhost:7002/console 

This allows you to utilize two individual instances of OBIEE to host two different RPDs and their 

respective web catalog files using the respective URLs for each instance. 

Note: It is recommended to open the URLs of both instances in separate browsers.  

Manually Merging FTI and OBIA 

This section details how to manually merge FTI with Oracle Business Intelligence Applications (OBIA). 

The merging process is comprised of the three steps listed below. 

 Merging FTI and OBIA Security Roles 

 Manually Merging OBIA Metadata with FTI Metadata 

 Manually Merging the OBIA Web Catalog with FTI Web Catalog 

Prerequisites 

The following are required prior to completing the merge process: 
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 OTM is already installed. 

 FTI is installed and configured except for the OBIEE deployment which is covered in the 

section titled “Deploying FTI Metadata Repository & Web Catalog to OBIEE”. 

 OBIA is already installed on this machine. 

Merging FTI and OBIA Security Roles 

First, you need to merge the FTI Business Intelligence Roles with the OBIA roles. Follow the steps 
listed in the section titled “Creating Business Intelligence Roles in OBIEE or OBIA”. 

Manually Merging OBIA Metadata with FTI Metadata 

Next, you need to manually merge the FTI metadata and the OBIA metadata. 

For detailed steps, refer to the section “Merging Repositories” -“Performing Full Repository Merges 
without a Common Parent” in the Oracle Business Intelligence Enterprise Edition 11g documentation. 

Note: RPDs created in a newer version of OBIEE/OBIA are not backward compatible! You 

must always merge UP to the higher version of OBIA. For example, if you have two RPDs 

and the FTI RPD is in version 11.1.1.6.8 and the OBIA RPD is version 11.1.1.7, you can 
only merge those RPDs in version 11.1.1.7. The FTI 6.3.2 RPD uses OBIEE 11.1.1.6.8. 

Note: The RPD can only be opened on a Windows machine. See the System Requirements 

and Supported Platforms for Oracle® Business Intelligence Suite Enterprise Edition > Client 
Environment Requirements. 

On a Windows machine, download and install Oracle Business Intelligence Developer Client Tools 
Installer. It is available for download from the Oracle Technology Network. 

Note: This must be a Windows system since the BI Administration tool is only available for 

Windows. 

Prerequisites 

The following variables should be changed before starting the merge process. There are several 
objects variables that overlap between OBIA and FTI. You need to rename several duplicate variables 
for use by FTI as shown below: 

1. Open the BI Administration tool: 

a. If OBIA is installed on a Windows machine the executable is located either at: 

 
All Programs >Oracle Business Intelligence > BI Administration 

 

OR 
 

OBIEE_HOME\Oracle_BI1\bifoundation\server\bin\AdminTool.exe. 

2. Open the FTI RPD using the BI Admin tool. Go to File > Open > Offline. 

3. Provide the password when prompted. 

4. Navigate to Manage > variables > Repository > Dynamic. 

5. Locate the variables CURRENT_MONTH, CURRENT_WEEK, CURRENT_YEAR, and 

CURRENT_QUARTER. 

6. Rename these variables as shown in the table below. 
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Sequence 

Number 

Object Type Object Description 

1 

Repository 

Variable CURRENT_MONTH 

There is a conflict with the CURRENT_MONTH 
object in the FTI RPD and the identically 
named variable is in the OBIA RPD. You must 
rename the FTI variable to end with FTI 

(CURRENT_MONTH_FTI). 

2 
Repository 
Variable CURRENT_WEEK 

There is a conflict with the CURRENT_WEEK 
object in the FTI RPD and the identically 
named variable is in the OBIA RPD. You must 
rename the FTI variable to end with FTI 
(CURRENT_WEEK_FTI). 

3 
Repository 
Variable CURRENT_QUARTER 

There is a conflict with the 
CURRENT_QUARTER object in the FTI RPD and 
the identically named variable is in the OBIA 

RPD. You must rename the FTI variable to end 
with FTI (CURRENT_QUARTER_FTI). 

4 
Repository 
Variable CURRENT_YEAR 

There is a conflict with the CURRENT_YEAR 
object in the FTI RPD and the identically 
named variable is in the OBIA RPD. You must 
rename the FTI variable to end with FTI 
(CURRENT_YEAR_FTI). 

7. Save and close the FTI RPD. 

8. Open the OBIA RPD. 

9. Navigate to Manage-Variables > Session > Variables > System. 

10. Locate the variables USER and loglevel. 

11. Delete both variables. 

Sequence 
Number 

Object Type Object Description 

5 Session Variable LOGLEVEL 
LOGLEVEL has conflicts, OBIA log level has been 
removed 

6 Session Variable USER USER has conflicts, OBIA USER has been removed 

 

Note: If you have customized the OBIA RPD to Authenticate and Authorize the users then follow 
these additional steps: 

12. IF OBIA is using the external table authentication mechanism: 

a. Update the initialization block in Manage > Variables > session > Initialization blocks 

> Authenticate. 

b. Change the query so that the user is authenticated for both FTI and OBIA. 

13. IF OBIA is using ‘ROLES’ variable from RPD to get the ‘ROLES’: 

a. Change the initialization block in Manage > Variables > session > Initialization blocks 

> GET_USER_ROLE.  

b. Changes the query so that the ROLES get assigned for both FTI and OBIA. 

 

Running the Merge Repository Wizard: 

Now, you are ready to run the Merge Repository wizard as follow: 
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1. If using a Linux/Unix machine, you must first copy 

<otm_install_path>/fti/advanced_analytics.rpd to the Windows system where the BI 

Administration tool is installed. 

2. If using a Linux/Unix machine, you must also copy OBIA RPD or Custom RPD to the 

Windows system where the BI Administration tool is installed.  

Note: For the exact name of the OBIA RPD or Custom RPD, please contact your 

OBIEE/OBIA administrator. 

3. Open the BI Administration tool: 

a. If OBIA is installed on a Windows machine the executable is located either at: 

 

All Programs >Oracle Business Intelligence > BI Administration 
 

OR 

 

OBIEE_HOME\Oracle_BI1\bifoundation\server\bin\AdminTool.exe. 

b. If OBIA is installed on a linux machine, then switch to a Windows machine which has 

the BI Administration tool installed and open the BI Administration tool. 

4. Create a new blank repository which will be used during the merge process: 

a. Create a new repository with no contents. 

b. Save it as blank.RPD in a folder. 

5. Open the OBIA RPD via File >Open.  

6. Navigate to File > Merge.  

 

The Merge Repository Wizard opens. 

7. In the Merge Repository Wizard, choose the following options: 

a. Select a Merge Type: of Full Repository Merge. 

b. For Original Master Repository:, select the newly created blank.rpd. 

c. For Modified Repository:, choose the FTI RPD which is titled 

advanced_analytics.rpd. 

d. For Current Repository:, choose the OBIA RPD. 

e. Save the Merged Repository with the name merged rpd. 

8. Click Next. 

9. In the Decision field choose all the Decisions to be current. 

a. Selecting Current keeps the object from the current repository. This is what you must 

select. 

b. If you select Modified, objects are deleted. You should NOT select Modified. 

10. Click finish. 

Note: After completing the merge, you may notice that not all components in OBIA RPD 
have transferred to the merged RPD but all components of FTI RPD have transferred. There 

may be empty folders in physical layer that are not being transferred to the merged 

metadata. You can ignore these empty folders they will have no impact on the reports. 

Manually Merging the OBIA Web Catalog with FTI Web Catalog 

In this procedure, the OBIA dashboards and reports are merged with the FTI dashboards and reports. 

On a Windows machine, download and install Oracle Business Intelligence Developer Client Tools 

Installer. It is available for download from the Oracle Technology Network.  
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Note: This must be a Windows system since the BI Administration tool and Catalog 

Manager is only available for Windows. 

Merging the FTI and OBIA Web Catalogs 

1. If using a Linux/Unix machine, you must first copy <otm_install_path>/fti/aa which is the 

FTI web catalog to the Windows system where the BI Administration tool is installed. 

2. If using a Linux/Unix machine, you must also copy OBIA web catalog to the Windows 

system where the BI Administration tool is installed.  

Note: For the exact name of the OBIA web catalog, please contact your OBIEE/OBIA 

administrator. 

3. Open the Catalog Manager: 

a. Windows ONLY: Open the catalog manager in windows by running either of the 
following: 

 

All Programs ->Oracle Business Intelligence -> Catalog Manager 
 

OR 

 
OBIEE_HOME\instances\instance\bifoundation\ 

OracleBIPresentationServicesComponent\ 

coreapplication_obips1\catalogmanager\runcat.cmd 

b. If OBIA is installed on a linux machine, then switch to a Windows machine which has 

the Catalog Manager installed and open the Catalog Manager. 

4. Select File > Open catalog. 

5. Open the OBIA web catalog in offline mode. 

6. Open another window of Catalog Manager. 

7. Open the FTI web catalog, aa, in the new window. 

8. Copy the shared folder from the FTI web catalog, aa. 

9. Paste it into the OBIA web catalog. 

Note: After pasting the shared folder in the OBIA Catalog in Catalog Manager window, an 

error alert appears with no description. If you click on details button, it shows as 

a“java.lang.NullPointerException” error. You can ignore this error. No errors are seen in 
end reports due to this error. 

Deploying the New OBIA Web Catalog 

1. Linux Only: Copy the newly merged web catalog back to your linux system so that you can 

load the new catalog. 

2. Load the merged catalog in OBIEE server as follows: 

a. Open WebLogic Enterprise Manager (http:<weblogic_host>:<port>/em). 

b. Navigate to Business Intelligence > Coreapplication > deployment > 

Repository > Catalog Location. 

c. Provide the location of the merged OBIA web catalog. 

d. Restart the WebLogic server. 

Note: Refer the following document to restart the WebLogic server “Oracle® Fusion 

Middleware System Administrator's Guide for Oracle Business Intelligence Enterprise 

Edition11g Release 1 (11.1.1)” section 4 Starting and Stopping Oracle Business 
Intelligence. 
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Redefining the Catalog Roles for the FTI Dashboards and Reports 

1. Open OBIEE Analytics using the URL http://<obiee_host>:<port>/analytics. 

2. Navigate to Catalog > Shared Folders >FTI Reports ->Dashboards. 

3. Click on More on the side of the specific dashboard. 

4. Go to permission. 

5. Apply the permissions for each dashboard as defined in the Business Intelligence Roles 

matrix in the OTM help. To find this help topic,  

a. Log into OTM and go to Help > Help. 

b. Click the Search tab. 

c. Search for Business Intelligence Roles. 

d. Click the link to the Business Intelligence Roles help topic. 

e. Refer to the table in that help topic. 

6. Repeat these steps for all of the dashboards. 

7. Navigate to Administration >Manage Privileges. 

8. Deny the access for ‘NO ACCESS’ role to the Dashboard. 

9. Deny the access for ‘NO ACCESS’ and ‘LSP CUSTOMER’ role to the Answers. 

Note: The permissions given for the OBIA Catalog objects are different from what exist in 

FTI.  For example, in OBIA only the BIAuthor role can see the Ad-hoc query .But in FTI, the 

BiConsumer role can see the Ad-hoc query. Please refer to the FTI Reference Guide section 
titled FTI Privileges to see a list of all the objects in OBIEE and the permissions given for 

them in FTI 6.3.2. This may or may not vary from OBIA catalog. So if you see any 

variation, you need to change the permissions in merged catalog to align with FTI. 

Updating the FTI Prompts with New Variables 

Finally, you need to change the FTI prompts which have the older variables CURRENT_MONTH, 

CURRENT_WEEK, CURRENT_QUARTER, and CURRENT_YEAR to use the new prompts of 

CURRENT_MONTH_FTI, CURRENT_WEEK_FTI, CURRENT_QUARTER_FTI, and CURRENT_YEAR_FTI as 
defined in the RPD. 

1. Open OBIEE Analytics using the URL http://<obiee_host>:<port>/analytics. 

2. Navigate to Catalog > Shared Folders >FTI Dashboard Prompts. 

3. Edit the following dashboard prompts and change the default variables given there to the FTI 

specific variables of CURRENT_MONTH_FTI, CURRENT_WEEK_FTI, CURRENT_QUARTER_FTI, 

and CURRENT_YEAR_FTI. 

a. /shared/FTI Dashboard Prompts/YQMW Prompt 

b. /shared/FTI Dashboard Prompts/YQMW Horizontal Prompt 

c. /shared/FTI Dashboard Prompts/YQMW With Week Horizontal Prompt 

d. /shared/FTI Reports/FTI Sample Reports/FTI Deprecated Reports/YQMW With Week 

Horizontal Prompt 

e. /shared/FTI Reports/FTI Sample Reports/FTI Sample Dashboard Prompts/Invoice Cost 

Type Prompt 

f. /shared/FTI Reports/FTI Sample Reports/FTI Sample Dashboard Prompts/Shipment 

Cost Type Prompt 

g. /shared/FTI Reports/FTI Sample Reports/FTI Sample Dashboard Prompts/Shipment 

Order Release Cost Type Prompt 

h. /shared/FTI Reports/FTI Sample Reports/FTI Sample Dashboard Prompts/YQMW Order 

Analysis  Prompt 
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i. /shared/FTI Reports/FTI Sample Reports/FTI Sample Dashboard Prompts/YQMW Quote 

Analysis Prompt 

j. /shared/FTI Reports/FTI Sample Reports/FTI Sample Dashboard Prompts/YQMW 

Shipment Analysis Prompt 

k. /shared/FTI Reports/FTI Sample Reports/FTI Sample Dashboard Prompts/YQMW 

Shipment Claims Prompt 

l. /shared/FTI Reports/FTI Sample Reports/FTI Sample Dashboard Prompts/YQMW 

Shipment Event Analysis Prompt 

m. /shared/FTI Reports/FTI Sample Reports/FTI Sample Dashboard Prompts/YQMW 

Shipment Order Release Line Prompt 

n. /shared/FTI Reports/FTI Sample Reports/FTI Sample Dashboard Prompts/YQMW 

Shipment Order Release Prompt 

o. /shared/FTI Reports/FTI Sample Reports/FTI Sample Dashboard Prompts/YQMW 

Shipment Stop Analysis prompt 

p. /shared/FTI Reports/FTI Sample Reports/FTI Sample Dashboard Prompts/YQMW 

Shipment Stop Delivery Analysis prompt 

q. /shared/FTI Dashboard Prompts/Network YQMW Prompt 

 

Creating New FTI Reports 

It is recommended that you create any new FTI reports by opening the Ad Hoc Query link 
(Transportation Intelligence > Ad Hoc Query) in a new window. This will allow all OBIEE features to 
work properly.  

The other recommendation is to set up a reverse proxy in OTM HTTP Server for OBIEE WebLogic 
server as follows. 

Configuring the OTM HTTP Server's Proxy Settings: 

1. Open OTM HTTP Server's mod_wl_ohs.conf file. 

2. Insert the following proxy request information into the configuration file: 

 ProxyRequest Off 

 <Proxy*> 

   Order deny,allow 

   Allow from all 

 </Proxy*> 

 Location/Oracle BI EE subdirectory 

   ProxyPass http://location of Oracle BI EE server/ 

      Oracle BI EE subdirectory 

   ProxyPassReverse http://location of Oracle BI EE server/ 

      Oracle BI EE subdirectory 

 /Location 

3. Save and close the configuration file. 

4. Test the configuration by using a fully-qualified name to log into Oracle's OBIEE through 

Oracle HTTP Server. 

Installing Other Languages for Oracle FTI 

The translated file for FTI metadata and reports are available as part of an update to 6.3 and these 
files need to be installed as explained in the following sections. 
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Installing Other Languages for Oracle FTI Metadata 

Once you have downloaded the update containing the FTI metadata files for other languages, follow 
the procedure below to install them. 

Note: The other languages content for Oracle FTI metadata will be shipped as csv files with the 

names w_localized_string_g_<lang id>.csv available under the directoy 

<otm_install_path>/glog/oracle/script8/content_advanced_analytics 

1. On the OTM server, go to the directory <otm_install_path>/glog/oracle/script8. 

2. Load other languages for the Oracle FTI metadata data by running update_content_aa. This 

process is run at the host command line rather than from within SQL*Plus. Two command 

scripts are provided and the script you use is dependent on your operating system: 

a. UNIX shell script run: 
 

./update_content_aa.sh <otm_install_path>/glog/config 

b. Windows command line script run: 

 

update_content_aa.cmd <otm_install_path>\glog\config 

3. Review the log file called update_content_aa_<timestamp>.log for errors.  

 

This file is located in the same directory as the SQL script.  
 

Look for errors by searching key words like “ORA-“, “Caught exception”,”SP2-“, or “<Error>“ 

within the log file. 

Installing Other Languages for Oracle FTI Reports 

Once you have downloaded the update containing the FTI report files for other languages, follow the 
procedure below to install them. 

Note: The other languages content for Oracle FTI reports will be shipped as XML files available in 

language-specific folders under the directory 
<otm_install_path>/glog/oracle/script8/content_advanced_analytics. 

1. On the OTM server, go to the directory 

<otm_install_path>/glog/oracle/script8/content_advanced_analytics 

2. Copy the following folders containing the other languages translation XMLs for Oracle FTI 

reports: 

 l_de 

 l_en 

 l_es 

 l_es-mx 

 l_fr 

 l_fr-ca 

 l_it 

 l_ja 

 l_ko 

 l_pt-br 

 l_ru 

 l_zh-cn 
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 l_zh-tw 

3. On the OBIEE server, stop the OBIEE services. 

4. On the OBIEE server, place the copied folders (in Step 2) to the following directory:  

 
ORACLE_INSTANCE\bifoundation\OracleBIPresentationServicesComponent\coreapplicat

ion_obipsn\msgdb\l_xx 

Note: The ‘xx’ in the folder of l_xx may be any language listed above.  For example for 
French, the folder should be l_fr. If this folder does not exist, you should create one as shown 
below: 
instances\instance1\bifoundation\OracleBIPresentationServicesComponent\coreappl

ication_obipsn\msgdb\l_fr 

5. On the OBIEE server, start the OBIEE services. 

After successfully installing the languages for Oracle FTI, use the Language preference under the User 

Preferences in OTM to specify the users preferred language. 
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5. Installing Global Trade Intelligence (GTI) 

OTM delivers the Oracle Global Trade Intelligence (GTI) solution which includes the following 
components.  

 Oracle Trade Intelligence Extract Transform & Load (ETL): Pre-packaged ETL process deployed 

on an Oracle Data Integrator (ODI) instance 

 Oracle Global Trade Intelligence Historical Database (HD): The analytics database for the 

Oracle Global Trade Intelligence applications 

 Oracle Global Trade Intelligence Metadata: Delivered as advanced_analytics.rpd file 

 Oracle Global Trade Intelligence Canned Reports: Delivered as aa_webcat.zip 

For more details about these components and Oracle GTI, see the Oracle Global Trade Intelligence 
Reference Guide. 

Important Note: Many script names, file names, repository names, and user names used 

during the installation and created by the installation contain the word FTI. This is correct 

since GTI was designed as a part of FTI.  

Note: Prerequisites for installing Oracle GTI are that you have experience with installing 

Oracle databases, OTM/GTM administration, OBI EE administration, ODI administration, 

and experience with Oracle ETL. 

Installing Oracle GTI Historical Database (HD) 

Replicated Operational Database (ROD) Considerations 

The deployment architecture of Oracle GTI supports the following deployment choices for customers: 

1. Load Historical Database using ROD 

 

In this deployment, a ROD (that maintains a snapshot of the OTM OLTP database) is used. The 

Oracle FTI/GTI ETL jobs will connect to the ROD to load the Historical Database thereby de-

coupling the OTM OLTP database from the ETL process. 

2. Load Historical Database using OLTP (Online Transaction Processing Database). 

 

In this deployment, the Oracle FTI/GTI ETL jobs will connect directly to the OTM OLTP 
database to load the Historical Database adding to additional database workload on the OTM 

OLTP database. 

It is strongly recommended that you use a ROD to achieve performance gains and to efficiently 
balance the load on the OTM OLTP database. 

Historical Database (HD) Considerations 

The Historical Database (HD) schema can be created on a separate database. This schema can also 
share the ROD or the OLTP database. 

Creating Historical Database (HD), Users, and Packages 

Note: All users for GTI will start with “fti” and all OTM glog properties also contain “fti”. 

This is not a mistake since GTI is part of FTI. 

The create_aa_all.sql calls the CSV load utility. This utility obtains the details of an Oracle GTI 

database from the glog.properties file. The connection details for Oracle FTI/GTI are requested during 
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the OTM installation. If you did not enter any values at the time of installation, you have to modify the 

glog.properties file and edit the following properties. 

1. Edit the properties included in the section of the glog.properties file titled “## Fusion 

Transportation Intelligence (FTI) – optional”. 

2. If necessary, remove the # so that these properties are no longer commented out. 

3. Specify the appropriate values based on the explanation in the following table: 

Note: Based on your answers during the OTM installation, these properties may already be 

set or may be commented out. 

Property Description 

glog.fti.dbserver Specify the fully qualified domain name of the Oracle FTI/GTI 
database server (this will contain the HDOWNER database 
schema). 

glog.fti.database.port Specify the port number of the FTI/GTI database server. 

glog.fti.database.schema Specify the name of the schema hosting the FTI/GTI 
database. This should typically be HDOWNER unless a 
different schema name is used. 

Example: HDOWNER 

glog.database.fti.sid Specify the Oracle FTI/GTI database SID/service name. 

glog.database.fti.user Oracle FTI/GTI database user name. An example and the 
default is HDOWNER. 

glog.database.fti.password Specify the password of the HDOWNER user in the FTI/GTI 

database. 

glog.fti.connectstring Specify the database connection string for the FTI/GTI 
Historical database. 

Do not change from the default of 
jdbc:oracle:thin:@$glog.fti.dbserver$glog.fti.databa

se.port$. 

 

Creating GTI Tablespaces 

GTI requires two tablespaces: DATA and INDX. You should execute the create_aa_tablespaces.sql 

script to create the tablespaces required for the HD. 

1. On the database (as per your deployment architecture discussed above) where you want to 

install Oracle GTI, log into SQL*Plus as user SYS and run the following script: 

<otm_install_path>\glog\oracle\script8\advanced_analytics\create_aa_table

spaces.sql 

2. The script asks a series of questions: 

a. Review the default parameters listed and select Y to use the default or N to change 

them. 
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b. Enter the file size. 

 

You can use K or M. Press ENTER to use the FTI/GTI default. 

c. Please enter maximum file size. 

 

It must greater than (file_size + 250M). Hit "ENTER" if you use FTI/GTI default. 

d. Enter Y or N to set auto extend on for data files. 
 

The default is Y. 

e. Enter the directory where you want the data files to be located including trailing 

"/" or "\". 

f. Enter Y or N to create tablespaces now. 
 

The default is N. 

Creating GTI Database Users 

1. Log into the database (as per your deployment architecture discussed above) where you want 

to install Oracle GTI. 

2. Using SQL*Plus, as user SYS, run the following script from the directory: 

<otm_install_path>\glog\oracle\script8\advanced_analytics\create_aa_users

.sql 

3. You see an explanation of what the script will do followed by some questions. 

a. Press the ENTER key to continue. 

b. Enter SYS password to login as SYSDBA. 

c. Enter Connection ID for the database to which you are connection as SYSDBA.  
 

This is specified in the glog.database.fti.sid property described previously. 

4. Enter password for user HDOWNER. 

 
This is specified in the glog.database.fti.password property described 

previously. 

Creating GTI Database Structure and Public Data 

1. Log into the database (as per your deployment architecture discussed above) where you want 

to install Oracle GTI. 

2. Using SQL*Plus, as user SYS, run the following script from the directory: 

<otm_install_path>\glog\oracle\script8\advanced_analytics\create_aa_all.sql 

3. You see an explanation of what the script will do followed by some questions: 

a. Enter your Connection ID to the Oracle GTI Historical Database (HD) when 

prompted. 

 

This is specified in the glog.database.fti.sid property described previously. 

b. Enter your SYS user password for the GTI database login as sysdba. 

 

This is the HDOWNER user password of your GTI database. See the 

glog.database.fti.password property described previously. 

c. Enter GLOGOWNER user password of your OLTP database. 

 

The OLTP database is your OTM database. 
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d. Enter connection string to the OLTP database when prompted.  

 

The OLTP database is your OTM database.  

e. Enter Y or N depending on machine type (UNIX or Windows). 

f. Enter path of directory where glog.properties file is located. 

4. After the process has run, verify in the create_aa_all.log file that there are no errors. 

 

Contact Technical Support if you find any errors like “ORA-“ or “Package Body created with 
compilation errors”. Also verify that csvone_aa_W_LOCALIZED_STRING_G.log file does not 

have any errors like “ORA-“, “Caught exception”,”SP2-“, or “<Error>”. Contact Technical 

Support if you find any other errors. 

Creating Oracle Data Integrator Database Users 

Now, you create the following Oracle Data Integrator users required for GTI. When you run the 

create_odi_users.sql script, you will be prompted for the password for each user listed below. 

 ftiodimaster 

 ftiodiwork 

 ftiodistage 

Note: Make note of the new passwords you enter for the Oracle Database Intelligence 
database users. You will need these in the ODI deployment steps for GTI in the subsequent 

sections. 

Note: Even thought these users start with “fti”, they are still required for GTI. 

To create these users, complete the following: 

1. Log into the database (as per your deployment architecture discussed above) where you want 

to create the ODI related repositories for Oracle GTI. 

2. Using SQL*Plus, as user SYS, run the following script from the directory: 

<otm_install_path>\glog\oracle\script8\advanced_analytics\create_odi_user

s.sql 

3. You see an explanation of what the script will do followed by some questions: 

a. Enter SYS password to login as SYSDBA. 

b. Enter the Connection ID of the database to which you are logging in as SYSDBA.  

 

This will typically be the same database on which you installed the HDOWNER schema. 

c. Enter password for user ftiodimaster. 
 

Make note of this password because you will need it later in the GTI installation 

process. 

d. Enter password for user ftiodiwork. 

 

Make note of this password because you will need it later in the GTI installation 

process. 

e. Enter password for user ftiodistage. 
 

Make note of this password because you will need it later in the GTI installation 

process. 
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Installing Oracle Data Integrator (ODI) 

Certain files required for Oracle Data Integrator installations are available under 
<otm_install_path>/fti. If Oracle Data Integrator is installed on a different server than OTM, please 

copy these files to a folder where the installing user has write permissions. 

Note: The minimum settings required for installing Oracle Data Integrator for Oracle GTI 

are listed below. Refer to the Oracle Data Integrator Installation Manual for detailed 

instructions on how to install Oracle Data Integrator. 

Note: Installing the ODI agent in the database tier provides better performance than 

installing it in the application tier. 

Prerequisites: JDK version 1.6 installed. 

1. Execute ./runInstaller in Linux or setup.bat in Windows to start the ODI install. 

 

Installer will complete the pre-installer checks and ask for JDK home location.  

2. Enter the JDK 1.6 home directory. 

Note: JDK must be version 1.6. 

3. On the Welcome screen of the Oracle Data Integrator installation wizard, click Next >. 

4. On the Select Installation Type screen, select the Developer Installation option and 

Standalone Installation option. 

Note: Do not select the Java EE Installation option. 

5. Click Next >. 

6. On the Prerequisite Check screen, once the checks are completed, click Next >. 

7. On the Specify Installation Location screen, enter the absolute path for the Oracle home 

location (referred to later as ODI_HOME). 

Note: The specified directory must be an empty directory or an existing Oracle Data 

Integrator home location. 

8. Click Next >. 

9. On the Repository Configuration screen, select Skip Repository Configuration.  

10. Click Next >. 

11. On the Specify Agent Details screen, enter the Agent Name: FTI_AGENT. 

12. Specify Agent Port: 20910. 

13. Click Next >. 

14. On the Specify Security Updates screen, choose how you want to be notified about security 

issues: 

a. If you want to be notified about security issues through email, enter your email 

address in the Email field. 

b. If you want to be notified about security issues through My Oracle Support, select the 

My Oracle Support option. Enter your email address in the Email field and enter your 

My Oracle Support Password. 
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c. If you do not want to be notified about security issues, leave all fields empty. 

 
You will see the following message: "My Oracle Support Username/E-mail address not 

specified". 

 

Click Yes to continue. 

15. Verify the information on the Installation Summary screen. 

16. Click Save to save your configuration information to a file.  

 

This information includes port numbers, installation directories, URLs, and component names 

which you may need to access at a later time. 

17. Back in the Installation Summary screen, click Install. 

18. On the Configuration Progress screen, click Next >. 

19. On the Installation Completed screen, click Finish to complete the installation. 

 

Configuring ODI for Oracle GTI ETL 

Note: All ODI users and repositories for GTI will start with “fti” and all OTM glog properties 

also contain “fti”. This is not a mistake since GTI is part of FTI. 

Creating a New Oracle Data Integrator Repository Login 

Next, you create a login to connect to the Oracle Data Integrator repository. 

1. Open ODI Studio: 

a. In the Windows Start Menu, select Programs > Oracle Data Integrator > ODI 

Studio, or 

b. Also in Windows, launch <ODI_HOME>/oracledi/client/odi.exe or 

c. In Linux, run <ODI_HOME>/oracledi/client/odi.sh 

2. Open the New Gallery by choosing File > New. 

3. In the New Gallery window, in the Categories tree, select ODI.  

4. From the Items list, select Create a New ODI Repository Login. 

5. Click OK.  
 

The Repository Connection Information Screen opens. 

6. In the Oracle Data Integrator Connection section enter the following: 

a. Login name: A generic alias (for example: DEVREP) 

b. User: SUPERVISOR (use capitals) 

c. Password: Refer to the ODI Installation Guide for the ODI SUPERVISOR user 

password and enter that here. 

7. In the Database Connection (Master Repository) section enter the following: 

a. User: ftiodimaster 

b. Password: Enter the password for ftiodimaster user. 
 

(This is the password for the ftiodimaster user that you entered when you ran the 

create_odi_users.sql script. See Creating Oracle Data Integrator Database Users.) 

c. Drivers List: Choose Oracle JDBC Driver 
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d. URL (standard server configuration only): Enter the complete JDBC URL for the 

master repository data server. 
 

For example: jdbc:oracle:thin:@<GTI DB SERVER NAME>:<GTI DB PORT>:<GTI DB 

SID> 
 

See the following glog.properties for these settings: glog.fti.dbserver, 

glog.fti.database.port, and glog.database.fti.sid. 

e. URL (RAC configuration only): Enter the RAC SCAN listener address and the service 
name as part of the URL as follows: 

 

For example: jdbc:oracle:thin:@<RAC SCAN LISTENER ADDRESS>:<PORT 

NUMBER>/<RAC DB SERVICE NAME> 

Note: Don’t click on Test Connection button to test the connection; because the 

master repository is not yet created. 

8. In the Work Repository section, enter the following: 

a. Select the Master Repository Only option. 

b. Click OK. 

c. Select Yes to make this the default login. 

d. Click OK again. 

 

Creating and Importing the Master Repository 

Next, you create the tables and the automatically import the definitions for the new ODI master 
repository. Due to performance, it is recommended that you have separate FTI/GTI ODI repositories 
instead of incorporating them along with other ODI applications. 

 The user completing this procedure must have write access to the folder that contains the 

FTI_ETL_MASTER.zip and FTI_ETL_WORK.zip files. 

 These files are available under <otm_install_path>/fti 

 If Oracle Data Integrator is installed on a different server, please copy these files to a folder 

where the installing user has write permissions. 

To create and import the master repository, complete the following: 

1. Open ODI Studio: 

a. In the Windows Start Menu, select Programs > Oracle Data Integrator > ODI 

Studio, or 

b. Also in Windows, launch <ODI_HOME>/oracledi/client/odi.exe, or 

c. In Linux, run <ODI_HOME>/oracledi/client/odi.sh 

2. Select File > New to open a new gallery. 

3. In the New Gallery window, in the Categories tree, select ODI. 

4. From the Items list, select Master Repository Import Wizard. 

5. Click OK. 

6. In the Database Connection section, complete the following: 

a. Login information: Since you selected ODI in step 3 above, the first five fields (Login 

through Password will be pre-populated based on what you set in the previous section 

Creating a New Oracle Data Integrator Repository Login). 
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Note: Do not click on Test Connection button to test the connection; because 

the master repository is not yet created. 

b. DBA User:<System User> 

c. DBA Password: <System User Password> 

7. In the Repository Configuration section, complete the following: 

a. ID: A specific ID for the new repository. 

 

You should choose a number greater than 100 and less than 600. Always remember to 
choose different numbers for the development, QA, user acceptance, and production 

environments. This will affect imports and exports between repositories. 

b. Select the Use a Zip File check box. 

c. Export Zip File path: Choose the file FTI_ETL_MASTER.zip. 

 
This file is located in <otm_install_path>/fti/etl/odi/. 

 

If OTM is on a different server, then chose the location where you copied this file on 

the ODI server. 

d. Technology: From the list, choose Oracle. 

8. Click Finish to begin master repository creation. 

 

This process may take up to 10 minutes. 

9. Validate the JDBC URLs for source and target databases by completing the following for each 

schema listed below: 

 ORACLE_FTI: (QA or PROD or UAT) Environment’s historical database hdowner 

schema mapped to global context. Enter the JDBC URL of the FTI/GTI 

production/QA/UAT database which contains the HDOWNER schema.  
 

See the following glog.properties for these settings glog.fti.dbserver, 

glog.fti.database.port, and glog.database.fti.sid. 

 ORACLE_FTI_DEV: Development environment’s historical database hdowner schema 
mapped to development context.  

 

Note: If you do not have a development environment, you do not need to specify this 

URL. 

 ORACLE_OTM: (QA or PROD or UAT) Environment’s OTM glogowner schema mapped 

to global context. 

 

This is the JDBC URL for your OTM server. 

 ORACLE_OTM_DEV: Development environment’s OTM glogowner schema mapped to 

development context.  

 
Note: If you do not have a development environment, you do not need to specify this 

URL. If the target database is a RAC, make sure to use the SCAN listener and service 

name in the URL. 

 ORACLE_GTM (QA or PROD or UAT) Environment’s OTM/GTM glogowner schema 
mapped to global context. 

 

This is the JDBC URL for your OTM/GTM server. 



Copyright © 2001, 2015, Oracle and/or its affiliates. All rights reserved. 5-9 

 ORACLE_GTM_DEV: Development environment’s OTM/GTM glogowner schema 

mapped to development context.  
 

Note: If you do not have a development environment, you do not need to specify this 

URL. If the target database is a RAC, make sure to use the SCAN listener and service 

name in the URL.  

Note: Both the ORACLE_OTM and ORACLE_GTM connection details are required for GTI 

and both will have same connection information. 

10. To validate the URLs, complete the following for each schema listed above: 

a. Click on the Connect To Repository… link. 

b. In the Login Name list, choose the ODI repository login (See Oracle Data 

Integrator Connection ). 

c. Click OK. 

d. Click on Topology tab. 

e. Go to the Physical Architecture pane and expand Technologies > Oracle. 

f. Double-click the schema name (for example, ORACLE_FTI). 

g. Click the JDBC tab. 

h. Enter the corresponding JDBC URL for each schema. 

 

The JDBC URL should be in the form of jdbc:oracle:thin:@<DB SERVER>:<DB 
PORT>:<DB SID>. See the explanations in step 9 above to determine what URL to use 

for each schema. 

11. Next, for each schema listed above make sure connection to the data server is set up correctly 

as follows: 

a. Click Definition tab. 

b. In the Connection section, for the ORACLE_FTI and ORACLE_FTI_DEV schemas, 

enter the following: 

i. User: ftiodistage 

 

You created this when Creating Oracle Data Integrator Database Users. 

ii. Password: <password for the ftiodistage user>. 
 

This is the password for the ftiodistage user that you entered when you ran 

the create_odi_users.sql script. See Creating Oracle Data Integrator 

Database Users. 

c. In the Connection section for the ORACLE_OTM/ORACLE_GTM and 

ORACLE_OTM_DEV/ORACLE_GTM_DEV schemas, enter the following: 

i. User: glogdba 

ii. Password: <password for the glogdba user> 

 

Refer to your OTM administrator for this information. 

12. Click the Save All button. 

13. Expand Agents and double-click the FTI_AGENT agent. 

14. In the Host field, give the server name or the IP address of the machine where you 

installed ODI. 

15. Click the Save All button. 
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Creating the Work Repository 

To create a work repository, complete the following: 

1. In the Topology Navigator, go to the Repositories panel. 

2. Right-click the Work Repositories node and select New Work Repository. 

3. In the Create Work Repository wizard, specify the Oracle Data Integrator work repository 

connection details as follows: 

a. Technology: Choose Oracle. 
 

The default is Oracle. 

b. JDBC Driver: oracle.jdbc.OracleDriver 

c. JDBC URL (standard server configuration only): The complete path of the data 

server to host the work repository. 
 

For example: jdbc:oracle:thin:@<FTI DB SERVER>:<FTI DB PORT>:<FTI DB SID> 

d. JDBC URL (RAC configuration only): Enter the RAC SCAN listener address and the 

service name as part of the URL as follows: 
 

For example: jdbc:oracle:thin:@<RAC SCAN LISTENER ADDRESS>:<PORT 

NUMBER>/<RAC DB SERVICE NAME> 

e. User: ftiodiwork 
 

You created this when Creating Oracle Data Integrator Database Users. 

f. Password: Enter the password for ftiodiwork user. 

 
(This is the password for the ftiodiwork user that you entered when you ran the 

create_odi_users.sql script. See Creating Oracle Data Integrator Database Users). 

4. Click Test Connection to check the connection is working. 

5. Click Next >. 

6. Specify the Oracle Data Integrator work repository details: 

a. ID: Give a unique number to your repository, from 1 to 500. 

b. Note: It is strongly recommended that this ID is unique and not used for any other 

work repository, as it affects imports and exports between repositories. 

c. Name: Give a unique name to your work repository (for example: FTI_WORK). Try to 
have only letters or numbers. Don’t use special characters and spaces in between the 

words. 

d. Password: leave blank 

e. Work Repository Type: Choose Development from the list. 

Note: It is recommended that you select a Work Repository Type of 

Development since this type allows you to make changes to the work repository 
in the future. If you select a work repository type of Production, then you will 

not be able to edit the work repository. 

7. Click Finish. 
 

The Create Login dialog box opens. 

8. Click No. 

9. Click Save in the toolbar. 
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Importing the Work Repository 

To import the work repository, complete the following: 

1. If you connected to the master repository only, disconnect by clicking: ODI > Disconnect 

<Login Name>. (See Oracle Data Integrator Connection for this login name.) 

2. On the Designer tab, click Connect to Repository… 

3. On the Oracle Data Integrator Login screen, click the pencil icon to edit the Login Name. 

4. On the Repository Connection Information screen in the Work Repository section, select the 

Work Repository option. 

5. Search for and select the name of the Name that you entered in the previous section, Creating 

the Work Repository. 

6. Click OK on the Repository Connection Information screen. 

7. Click OK on the Oracle Data Integrator Login screen. 

8. Connect to the work repository. 

9. From Designer tab, click the Connect Navigator icon, then select Import > Work 

Repository. 

10. Specify an Import Mode of Synonym Mode INSERT_UPDATE. 

11. Select the Import From a Zip File check box. 

12. Choose FTI_ETL_WORK.zip.  
 

This file is located in <otm_install_path>/fti/etl/odi/. 

 

If OTM is on a different server, then chose the location where you copied this file on the ODI 

server. 

13. Click OK to import the work repository. 

 

This process may take up to 40 minutes. Do not close or kill the process. 

Note: During this process you may get a dialog box saying that the ID <object ID> 

does not exist. Click OK to create it. 

Starting the Oracle Data Integrator Agent Process 

Configuring the Oracle Data Integrator Agent 

To configure the Oracle Data Integrator agent, complete the following: 

Note: To encode passwords, use <ODI_HOME>\oracledi\agent\bin\encode.sh in Linux or 
<ODI_HOME>\oracledi\agent\bin\encode.bat in Windows. 

1. Navigate to <ODI_HOME>\oracledi\agent\bin 

2. Open the file odiparams.sh in Linux or odiparams.bat in Windows. 

3. Set the values for following parameters as shown below: 

Parameter Value Description 

ODI_MASTER_DRIVER oracle.jdbc.OracleDriver Must be set to this value. 
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ODI_MASTER_URL jdbc:oracle:thin:@<FTI DB 

SERVER>:<FTI DB 

PORT>:<FTI DB SID> 

Enter the same value that you set 

up previously for your FTI/GTI 

database URL. You entered this 
information at the JDBC URL 
(standard server configuration 
only): prompt in the section 
Creating a New Oracle Data 
Integrator Repository Login. 

ODI_MASTER_USER ftiodimaster Enter the same value that you set 
up previously for the ftiodimaster 
user. You created this user in 
Creating a New Oracle Data 
Integrator Repository Login. 

ODI_MASTER_ENCODED_PASS <Use encoded password> This is the encoded version of the 

password for the ftiodimaster user 
that you entered when you ran the 
create_odi_users.sql script. 

Refer to Creating Oracle Data 
Integrator Database Users. 

ODI_SUPERVISOR SUPERVISOR Enter the same value that you set 
up previously for the Login name 
instructions. You created this login 
in Creating a New Oracle Data 
Integrator Repository Login. 

ODI_SUPERVISOR_ENCODED_

PASS 

<Use encoded password> This is the encoded version of the 
Password for the SUPERVISOR user 
that you set up previously. You 

created this user in Creating a New 
Oracle Data Integrator Repository 
Login. 

ODI_SECU_WORK_REP FTI_WORK This is the Name that you specified 
when creating the work repository 
previously. You created this name 
in Creating a New Oracle Data 
Integrator Repository Login. 

 

Starting the Oracle Data Integrator Agent 

To start the Oracle Data Integrator agent, complete the following: 

1. In ODI Studio, go to the Topology Tab > Physical Architecture. 

2. Expand Agents. 

3. Double click on FTI_AGENT. 

4. Enter Host and save it.  

Note: Host is machine name/IP Address of machine where you installed ODI. 

5. Navigate to <ODI_HOME>\oracledi\agent\bin 
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6. Start the Oracle Data Integrator agent as follows: 

a. UNIX: Run ./agent.sh -NAME=FTI_AGENT 

b. Windows: Run ./agent.bat -NAME=FTI_AGENT 

c. To run in the background process on UNIX, use following command: 

nohup ./agent.sh –NAME=FTI_AGENT & 

Note: You must set the parameter of NAME to the Agent Name of the ODI agent 

(the default is FTI_AGENT) which you defined in topology manager’s physical 
architecture Agent section. 

Installing Oracle Business Intelligence Enterprise Edition (OBIEE) 

For detailed installation steps of OBIEE on your preferred operating system, please refer to the 
corresponding OBIEE installation documentation. 

Oracle GTI is officially certified only for OBIEE deployed using WebLogic. If you need to use a web 

application server of your choice, then please refer the OBIEE documentation for the compatibility of 
OBIEE on your choice of web application server and also for detailed deployment instructions. 

Note: All ODI users and repository names for GTI will start with “fti” and all OTM glog 

properties also contain “fti”. This is not a mistake since GTI is part of FTI. 

Installing OTM and GTI on Single Server 

OTM and Oracle FTI/GTI can be installed on the same server by following these guidelines. Skip this 
section if you choose to have OTM and FTI/GTI on different machines. 

The server machine must be a multi-homed system (two hostnames/IP addresses) which means a 
single server with two network cards. 

 Primary hostname: should contain the OBIEE install 

 Secondary hostname: should contain the OTM install 

Guidelines for Installing OTM and GTI on Single Server 

1. OTM should be brought down to unblock the default WebLogic Admin port (7001). 

2. Install OBIEE per the OBIEE installation instructions. See the Installing OBIEE section. 

Note: By default OBIEE uses the primary hostname and default port (7001) for 
installation. 

3. Stop OBIEE per the OBIEE installation instructions. 

4. Restart the server. 

5. Start OTM. 

6. Restart OBIEE per the OBIEE installation instructions. 

 

Creating Repository Schema Using the Repository Creation Utility 

Prior to installing OBIEE, you need to download and run the Repository Creation Utility (RCU). You can 
download this tool from the Oracle Technology Network. 

Refer the Document "Oracle® Fusion Middleware Installation Guide for Oracle Business Intelligence 

11g Release 1 (11.1.1)" section "3 Oracle Business Intelligence Requirements" and sub-section 
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"Create Database Schemas Using the Repository Creation Utility (RCU)" for details on running the 

RCU. 

1. Download the Repository Creation Utility from OTN. 

2. Run the RCU utility to create the repository schemas necessary for OBIEE and GTI. 

3. In the RCU, select the Oracle Business Intelligence Component.  

 

This action automatically selects the Metadata Services (MDS) schema (under the AS Common 
Schemas group) and Oracle Business Intelligence (BIPLATFORM) schema, which are required 

by Oracle Business Intelligence. 

4. Note the schema names and passwords created by the RCU.  

 
These will be used during the OBIEE installation. The schema names should be unique (for 

example, Yourname_MDS and Yourname_BIPLATFORM). 

Installing OBIEE 

1. Select simple install while installing OBIEE 11g. 

Refer to the chapter “Installing Oracle Business Intelligence” in “Oracle® Fusion Middleware 
Installation Guide for Oracle Business Intelligence 11g Release” document for complete details. 

Note: When the installation completes, the WebLogic server and Oracle BI server start by default 

and a browser window opens to the home page. For example, 

http://<hostname>:7001/analytics/saw.dll?Answers. 

Configuring OBIEE for Oracle GTI 

Note: All ODI users and repository names for GTI will start with “fti” and all OTM glog 

properties also contain “fti”. This is not a mistake since GTI is part of FTI. 

Once you successfully installed OBIEE, complete this section to deploy the Oracle GTI components 
(metadata & reports). This section also contains details on the various other configurations required in 
the OBIEE and OTM applications to complete the Oracle GTI deployment. Please perform the 
configuration steps in the following sequence: 

 Creating RPTAPP and OLTP Database Connections 

 Configuring GTI Metadata Repository Password 

 Configuring GTI Metadata Repository 

 Copying GTI Web Catalog to OBIEE 

 Deploying GTI Metadata Repository & Web Catalog to OBIEE 

Creating RPTAPP and OLTP Database Connections 

On the OBIEE server, create two new database connections with the name RPTAPP and OLTP: 

 RPTAPP should connect to the Oracle FTI/GTI historical database. 

 OLTP should connect to OTM database. 

To do this, complete the following: 

1. Open the <OBIEE_INSTALL_PATH>\Oracle_BI1\network\admin\tnsnames.ora file.  

Note: Only complete these steps in the exact tnsnames file listed above. 

2. For a standard database connection, add the following into the tnsnames.ora file: 
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RPTAPP = 

(DESCRIPTION = 

  (ADDRESS_LIST = 

    (ADDRESS = (PROTOCOL = TCP)(HOST = <FTI HD Host>)(PORT = <FTI HD Port>)) 

    ) 

  (CONNECT_DATA = 

    (SID = <FTI HD SID>) 

  ) 

) 

 

OLTP = 

(DESCRIPTION = 

  (ADDRESS_LIST = 

    (ADDRESS = (PROTOCOL = TCP)(HOST = <OTM OLTP DB Host>)(PORT = <OTM OLTP Port>)) 

    ) 

  (CONNECT_DATA = 

    (SID = <OTM OLTP DB SID>) 

  ) 

) 

3. For a standard database connection, update the following entries to correspond with your FTI 

configuration: 

a. Under RPTAPP, set the following: 

i. (HOST =<FTI HD Host>) should be the FTI/GTI DB server name as specified in 

numerous places: glog.fti.dbserver and ODI repository creation. 

ii. (SID = <FTI HD SID>) should be the FTI/GTI DB SID as specified in 

numerous places: glog.database.fti.sid and ODI repository creation. 

iii. (PORT = <FTI HD Port>) should be the FTI/GTI DB Port as specified in 

numerous places: glog.fti.database.port and ODI repository creation. 

b. Under OLTP, set the following: 

i. (HOST =<OTM OLTP DB Host>) should be the OTM DB server name as 

determined during the OTM install. 

ii. (SID = <OTM OLTP DB SID>) should be the OTM DB SID as determined during 

the OTM install. 

iii. (PORT = <OTM OLTP Port>) should be the OTM DB Port as determined during 

the OTM install. 

4. For a RAC database connection set the RPTAPP as shown below: 

RPTAPP = 

(DESCRIPTION = 

(ADDRESS = (PROTOCOL = TCP)(HOST = <RAC SCAN LISTENER ADDRESS>)(PORT = <SCAN 

LISTENER PORT NUMBER>)) 

(CONNECT_DATA =  

(SERVER = DEDICATED) 

(SERVICE_NAME = <RAC SERVICE NAME>)) 

) 

a. Under RPTAPP, set the following: 

i. (HOST =<RAC SCAN LISTENER ADDRESS>) should be the RAC SCAN listener 

address. 

ii. (PORT = <SCAN LISTENER PORT NUMBER>) should be the RAC SCAN listener 

port number. 

iii. (SERVICE_NAME = <RAC DB SERVICE NAME>) should be service name of the 

RAC database server. 
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b. Set the OLTP up as detailed for a standard database connection. 

5. Open the user.cmd file.  

 
This file is located in 

<OBIEE_INSTALL_PATH>\instances\instance1\bifoundation\OracleBIApplication\corea

pplication\setup. as follows: 

6. Add the following to the line REM set TNS_ADMIN=: 

<OBIEE_INSTALL_PATH>\Oracle_BI1\network\admin; 

When OBIEE loads the Oracle Global Trade Intelligence metadata, it will connect to the HD and OLTP 
databases using the RPTAPP and OTLP tnsname entries only. 

Configuring GTI Metadata Repository Password 

The metadata repository file advanced_analytics.rpd that is shipped with GTI is set with the default 

password transportationintelligence1. 

Warning: For security reasons, it is strongly recommended that you change this default password 

to a secured password before deploying it in OBIEE. 

To change the default repository password, complete the following: 

1. On a Windows machine, download and install Oracle Business Intelligence Developer Client 

Tools Installer (11.1.1.7.1). It is available for download from the Oracle Technology Network. 

Note: This must be a Windows system since the BI Administration tool is only available for 

Windows.  

2. Copy <otm_install_path>/fti/advanced_analytics.rpd to the Windows system where the 

BI Administration tool is installed. 

3. Provide the default password as shipped for advanced_analytics.rpd file. 

Note: If RPD is read-only, change it to read/write, before opening in BI Administration 

Tool. 

4. Select File->Change Password. 

5. Enter the old password. 

6. Enter the new password. 

7. Confirm the new password. 

8. Click ok. 

9. Save and close the repository. 

Note: Make note of the modified repository password as this will be needed for the following: 

 Deployment of the advanced_analytics.rpd repository file in OBIEE 

 Configuration/customization of the advanced_analytics.rpd repository 

 

Configuring GTI Metadata Repository 

Before deploying the GTI repository file, you must configure it to connect to the FTI/GTI historical 
database and the OTM OLTP database. 

Note: This must be a Windows system since the BI Administration tool is only available for 

Windows. 
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To configure these connections, complete the following: 

1. Using BI Administration Tool, open the advanced_analytics.rpd in offline mode. 

2. In Physical Layer, expand each database definition and in each connection pool specify the 

following: 

3. HDOWNER database user’s password where HDOWNER user is set 

4. GLOGDBA database user’s password where GLOGDBA user is set 

5. Save the RPD. 

6. Select No when prompted for Global Consistency. 

 

Copying GTI Web Catalog to OBIEE 

1. Copy the FTI/GTI webcatalog from the OTM server: 

<otm_install_path>/fti/aa_webcat.zip 

to the following directory on the OBIEE server: 

<OBIEE_INSTALL_PATH>\instances\instance1\bifoundation\OracleBIPresentatio

nServicesComponent\coreapplication_obips1\catalog\ 

2. Unzip the aa_webcat.zip file. 

 

The aa folder is created. 

3. Unix/Linux: You must give read/write/execute permissions to any user on aa folder. 

4. Copy the file smartway-logo.jpg available in the OTM directory below: 

<otm_install_path>/fti/ 

to the following OBIEE directories: 

 <OBIEE_INTSALL_PATH>\Oracle_BI1\bifoundation\web\app\res\s_blafp\imag

es 

 <OBIEE_INSTALL_PATH>\user_projects\domains\bifoundation_domain\server

s\AdminServer\tmp\_WL_user\analytics_11.1.1\7dezjl\war\res\s_blafp\im

ages 

Note: The 7dezjl folder might not be present in all the nodes. Instead, the folder name 
might be different. In each node, you need to find out the folder in 

/<OBIEE_INSTALL_PATH>/user_projects/domains/bifoundation_domain/servers/b

i_server1/tmp/_WL_user/analytics_11.1.1/ allowing you to navigate to 
/war/res/s_blafp/images. 

5. Modify the instanceconfig.xml as follows: 

a. Open the file: 

<OBIEE_INSTALL_PATH>\instances\instance1\config\OracleBIPresentationServi

cesComponent\coreapplication_obips1\instanceconfig.xml 

b. Add the following tag in between the <Security> </Security> tag. 

<InIFrameRenderingMode>allow</InIFrameRenderingMode> 
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Deploying GTI Metadata Repository & Web Catalog to OBIEE 

1. Copy the FTI/GTI advanced_analytics.rpd to a folder that can be accessed by the OBIEE 

server. 

2. Open a browser and log into the OBIEE EM Console.  
 

You can use the login you created in OBIEE installation to log into the EM console using the 

following URL: http://<obieeserver>:7001/em 

3. Expand the Business Intelligence node on the left and select Coreapplication. 

4. Click on the Deployment tab. 

5. Click on the Repository tab. 

6. Click on Lock and Edit Configuration to change the default settings. 

7. In the Upload BI Server Repository section, click on the Browse… button and locate your 

new RPD file. 

8. Enter the FTI metadata repository password. 

 

You created this when installing OBIEE. 

9. Reenter the password. 

10. In the BI Presentation Catalog section, update the path as follows: 

<OBIEE_INSTALL_DIR>\instances\instance1\bifoundation\OracleBIPresentation

ServicesComponent\coreapplication_obips1\catalog\aa 

11. Optional step: Mail configuration to receive mails from OBIEE: 

a. Click on Mail. 

b. Provide SMTP Server details. 

12. Click Apply in the top-right corner of screen. 

13. Click Activate Changes. 

14. Click on the Overview tab. 

15. Click the blue Restart button. 

16. Click Yes on dialog box to confirm and wait for the message that confirms successful restart.  

With this step, you have completed all the configuration steps in OBIEE. 

Note: To test that GTI is successfully configured, browse to the following URL: 

http://<obieeserver>:7001/analytics 

 

Configuring OTM for Oracle GTI 

OTM Properties 

After successfully installing and configuring ODI and OBIEE, follow the instructions below to configure 
the FTI/GTI related properties in OTM. 

Note: These properties may already be uncommented out (the # symbols are removed) 

depending on how you complete the OTM installation. If this case, just verify that the 
property values are correct. 

1. Open the file <OTM Install Dir>/glog/config/glog.properties 
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2. Remove the # symbols and enter the appropriate values for the properties listed in the table 

below: 

Note: Based on your answers during the OTM installation, these properties may already be 
set or may be commented out. 

Property Name Description 

OBIEE Specific Properties (These are set in glog.properties file.) 

aa_webserver Specify the complete URL of the OBIEE server along with the 
port number. If setting up reverse proxy server (the 
recommended approach), specify the HTTP Server here. See 

Configuring the OTM HTTP Server's Proxy Settings: for more 
details. 

Example: aa_webserver = 

http://myfti.mydomain.com:7001 

Be sure to include the http:// or https:// as applicable. 

As OTM does not pass through the URL on an internal DNS 
name, you will need to open a firewall IP and port so that 
OTM can call the external fully qualified domain name 
(FQDN). After the changes are made, you will need to restart 
the OTM web server. 

isAllowedGTIAnalytics Use this to enable/disable the Global Trade Intelligence (GTI) 
option in Oracle Transportation Management. 

Use the values TRUE or FALSE. 

glog.fti.dbserver You set this earlier in the installation process. 

glog.fti.database.port You set this earlier in the installation process. 

glog.database.fti.sid You set this earlier in the installation process. 

glog.fti.database.schema You set this earlier in the installation process. 

glog.database.fti.user You set this earlier in the installation process. 

glog.database.fti.password You set this earlier in the installation process. 

glog.fti.connectstring You set this earlier in the installation process. 

glog.security.userSession.enabled To enable navigation from OTM to FTI/GTI without an 

external single sign on (SSO) solution, set this property to 
"true" on the OTM web server. 

The default is false. 

See the Oracle Transportation Management Security Guide 
for complete details about enabling single sign on. 
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Property Name Description 

ODI Specific Properties (These are set in glog.properties file.) 

glog.odi.agent.server Specify the host name of the server that is running the ODI 
agent. 

glog.odi.agent.port Specify the port number on the server on which the ODI 
agent is running. 

glog.odi.password Specify the password of the ODI login user.  

Example: The password of SUPERVISOR user. Refer to the 
ODI installation documentation for this password. 

glog.odi.work.repository.code Specify the name of the FTI work repository deployed in the 
ODI server. 

Note: glog.odi.work.repository.code is the Work 

Repository Name that you specified while creating the work 
repository. 

Example: FTI_WORK 

glog.odi.email.from.address=ftiad

min@yourdomain.com 
Specify from e-mail address to send ETL results. 

Example:ftiadmin@yourdomain.com 

 

Deploying Multiple RPDs in a Single OBIEE11g Installation 

This section provides instructions how to deploy two repository (RPD) files in a single installation of 
OBIEE. For complete details on the OBIEE installation, see the ORACLE® FUSION MIDDLEWARE 

INSTALLATION GUIDE FOR ORACLE BUSINESS INTELLIGENCE 11G RELEASE 1 (11.1.1), chapter 2 
Recommended Installation Scenarios for Oracle Business Intelligence. Specifically, refer to the 
sub section 2.2.3.2 Installing Multiple, Standalone Oracle Business Intelligence Instances on 
a Single Computer. 

You can establish multiple instances of OBIEE on single installation of OBIEE on the same computer. 
In this process, an additional WebLogic domain is created which establishes the connection between 

Oracle BI Home and the second instance of OBIEE. 

Pre-requisites: 

Installation of OBIEE on the machine has already been completed. As a result, you have an OBIEE 
directory, which already has an instance generated, and OracleBI Home directory. 

Generating a Second Instance of OBIEE 

Complete the following steps to generate a second instance of OBIEE in single OBIEE installation 
directory: 

1. Create new schema using the RCU utility for the new instance. 
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a. Run the command rcu.bat to create the new schema. 

2. Run the batch file config.bat present in the path below to use the Configuration Assistance 

to generate another instance of OBIEE: 

Á Middlewarehome > OracleBI1>bin>config.bat 

3. Click Next until you see a window to select Create New BI System. 

4. Select the Create New BI System option. 

5. Enter a different name for Domain Name.  
 

For example: bifoundation_domain2 

6. Enter the WebLogic user name and password. 

7. Click Next. 

8. Click Next again. 

9. Enter the Connect string. 

10. Enter the schema name and password created using RCU in first step for BIPLATFORM 

Schema_Username and password. 

11. Click Next. 

12. Enter the same schema name and password created using RCU in first step for 

MDS_SCHEMA. 

13. Click on Next until you see a window which contains the Configure button. 

14. Click the Configure button. 

15. Click Finish. 

Now the second instance of OBIEE is generated in the same OBIEE installation directory. To verify the 
instance was generated, go to the following path: 

 Middlewarehom > instances 

After following the above mentioned steps, the following URLs are generated to access both of the 

instances: 

Instance1     Instance2 

 http://localhost:7001/em   http://localhost:7002/em 

 http://localhost:7001/analytics       http://localhost:9704/analytics 

 http://localhost:7001/console   http://localhost:7002/console 

This allows you to utilize two individual instances of OBIEE to host two different RPDs and their 
respective web catalog files using the respective URLs for each instance. 

Note: It is recommended to open the URLs of both instances in separate browsers. 

Manually Merging GTI and OBIA 

This section details how to manually merge GTI with Oracle Business Intelligence Applications (OBIA). 

The merging process is comprised of the two steps listed below. 

 Manually Merging OBIA Metadata with GTI Metadata 

 Manually Merging the OBIA Web Catalog with GTI Web Catalog 

Prerequisites 

The following are required prior to completing the merge process: 
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 OTM is already installed. 

 GTI is installed and configured except for the OBIEE deployment which is covered in the 

section titled “Deploying GTI Metadata Repository & Web Catalog to OBIEE”. 

 OBIA is already installed on this machine. 

Manually Merging OBIA Metadata with GTI Metadata 

Next, you need to manually merge the GTI metadata and the OBIA metadata. 

For detailed steps, refer to the section “Merging Repositories” -“Performing Full Repository Merges 
without a Common Parent” in the Oracle Business Intelligence Enterprise Edition 11g documentation. 

Note: RPDs created in a newer version of OBIEE/OBIA are not backward compatible! You 

must always merge UP to the higher version of OBIA. For example, if you have two RPDs 
and the FTI RPD is in version 11.1.1.6.8 and the OBIA RPD is version 11.1.1.7, you can 

only merge those RPDs in version 11.1.1.7. The FTI 6.3.2 RPD uses OBIEE 11.1.1.6.8. 

Note: The RPD can only be opened on a Windows machine. See the System Requirements 
and Supported Platforms for Oracle® Business Intelligence Suite Enterprise Edition > Client 

Environment Requirements. 

On a Windows machine, download and install Oracle Business Intelligence Developer Client Tools 
Installer. It is available for download from the Oracle Technology Network. 

Note: This must be a Windows system since the BI Administration tool is only available for 

Windows. 

Prerequisites 

The following variables should be changed before starting the merge process. There are several 
objects variables that overlap between OBIA and GTI. You need to rename several duplicate variables 

for use by GTI as shown below: 

1. Open the BI Administration tool: 

a. If OBIA is installed on a Windows machine the executable is located either at: 
 

All Programs >Oracle Business Intelligence > BI Administration 

 
OR 

 

OBIEE_HOME\Oracle_BI1\bifoundation\server\bin\AdminTool.exe. 

2. Open the FTI RPD using the BI Admin tool. Go to File > Open > Offline. 

3. Provide the password when prompted. 

4. Navigate to Manage > variables > Repository > Dynamic. 

5. Locate the variables CURRENT_MONTH, CURRENT_WEEK, CURRENT_YEAR, and 

CURRENT_QUARTER. 

6. Rename these variables as shown in the table below. 

Sequence 
Number 

Object Type Object Description 
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Sequence 

Number 

Object Type Object Description 

1 

Repository 

Variable CURRENT_MONTH 

There is a conflict with the CURRENT_MONTH 
object in the FTI/GTI RPD and the identically 
named variable is in the OBIA RPD. You must 
rename the FTI/FTI variable to end with FTI 

(CURRENT_MONTH_FTI). 

2 
Repository 
Variable CURRENT_WEEK 

There is a conflict with the CURRENT_WEEK 
object in the FTI/GTI RPD and the identically 
named variable is in the OBIA RPD. You must 
rename the FTI/FTI variable to end with FTI 
(CURRENT_WEEK_FTI). 

3 

Repository 

Variable CURRENT_QUARTER 

There is a conflict with the 
CURRENT_QUARTER object in the FTI/GTI RPD 
and the identically named variable is in the 

OBIA RPD. You must rename the FTI/FTI 
variable to end with FTI 

(CURRENT_QUARTER_FTI). 

4 
Repository 
Variable CURRENT_YEAR 

There is a conflict with the CURRENT_YEAR 
object in the FTI/GTI RPD and the identically 
named variable is in the OBIA RPD. You must 
rename the FTI/FTI variable to end with FTI 
(CURRENT_YEAR_FTI). 

7. Save and close the FTI RPD. 

8. Open the OBIA RPD. 

9. Navigate to Manage-Variables > Session > Variables > System. 

10. Locate the variables USER and loglevel. 

11. Delete both variables. 

Sequence 

Number 

Object Type Object Description 

5 Session Variable LOGLEVEL 
LOGLEVEL has conflicts, OBIA log level has been 
removed 

6 Session Variable USER USER has conflicts, OBIA USER has been removed 

 

Note: If you have customized the OBIA RPD to Authenticate and Authorize the users then follow 

these additional steps: 

12. IF OBIA is using the external table authentication mechanism: 

a. Update the initialization block in Manage > Variables > session > Initialization blocks 

> Authenticate. 

b. Change the query so that the user is authenticated for both FTI/GTI and OBIA. 

13. IF OBIA is using ‘ROLES’ variable from RPD to get the ‘ROLES’: 

a. Change the initialization block in Manage > Variables > session > Initialization blocks 

> GET_USER_ROLE.  

b. Changes the query so that the ROLES get assigned for both FTI/GTI and OBIA. 

 

Running the Merge Repository Wizard: 

Now, you are ready to run the Merge Repository wizard as follow: 
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1. If using a Linux/Unix machine, you must first copy 

<otm_install_path>/fti/advanced_analytics.rpd to the Windows system where the BI 

Administration tool is installed. 

2. If using a Linux/Unix machine, you must also copy OBIA RPD or Custom RPD to the 

Windows system where the BI Administration tool is installed.  

Note: For the exact name of the OBIA RPD or Custom RPD, please contact your 

OBIEE/OBIA administrator. 

3. Open the BI Administration tool: 

a. If OBIA is installed on a Windows machine the executable is located either at: 

 

All Programs >Oracle Business Intelligence > BI Administration 
 

OR 

 

OBIEE_HOME\Oracle_BI1\bifoundation\server\bin\AdminTool.exe. 

b. If OBIA is installed on a linux machine, then switch to a Windows machine which has 

the BI Administration tool installed and open the BI Administration tool. 

4. Create a new blank repository which will be used during the merge process: 

a. Create a new repository with no contents. 

b. Save it as blank.RPD in a folder. 

5. Open the OBIA RPD via File >Open.  

6. Navigate to File > Merge.  

 

The Merge Repository Wizard opens. 

7. In the Merge Repository Wizard, choose the following options: 

a. Select a Merge Type: of Full Repository Merge. 

b. For Original Master Repository:, select the newly created blank.rpd. 

c. For Modified Repository:, choose the FTI/GTI RPD which is titled 

advanced_analytics.rpd. 

d. For Current Repository:, choose the OBIA RPD. 

e. Save the Merged Repository with the name merged rpd. 

8. Click Next. 

9. In the Decision field choose all the Decisions to be current. 

a. Selecting Current keeps the object from the current repository. This is what you must 

select. 

b. If you select Modified, objects are deleted. You should NOT select Modified. 

10. Click finish. 

Note: After completing the merge, you may notice that not all components in OBIA RPD 
have transferred to the merged RPD but all components of FTI/GTI RPD have transferred. 

There may be empty folders in physical layer that are not being transferred to the merged 

metadata. You can ignore these empty folders they will have no impact on the reports. 

Manually Merging the OBIA Web Catalog with GTI Web Catalog 

In this procedure, the OBIA dashboards and reports are merged with the FTI/GTI dashboards and 
reports. 

On a Windows machine, download and install Oracle Business Intelligence Developer Client Tools 
Installer. It is available for download from the Oracle Technology Network. 
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Note: This must be a Windows system since the BI Administration tool and Catalog 

Manager is only available for Windows. 

Merging the FTI and OBIA Web Catalogs 

1. If using a Linux/Unix machine, you must first copy <otm_install_path>/fti/aa which is the 

FTI/GTI web catalog to the Windows system where the BI Administration tool is installed. 

2. If using a Linux/Unix machine, you must also copy OBIA web catalog to the Windows 

system where the BI Administration tool is installed.  

Note: For the exact name of the OBIA web catalog, please contact your OBIEE/OBIA 

administrator. 

3. Open the Catalog Manager: 

a. Windows ONLY: Open the catalog manager in windows by running either of the 
following: 

 

All Programs ->Oracle Business Intelligence -> Catalog Manager 
 

OR 

 
OBIEE_HOME\instances\instance\bifoundation\ 

OracleBIPresentationServicesComponent\ 

coreapplication_obips1\catalogmanager\runcat.cmd 

b. If OBIA is installed on a linux machine, then switch to a Windows machine which has 

the Catalog Manager installed and open the Catalog Manager. 

4. Select File > Open catalog. 

5. Open the OBIA web catalog in offline mode. 

6. Open another window of Catalog Manager. 

7. Open the FTI web catalog, aa, in the new window. 

8. Copy the shared folder from the FTI web catalog, aa. 

9. Paste it into the OBIA web catalog. 

Note: After pasting the shared folder in the OBIA Catalog in the Catalog Manager window, 

an error alert appears with no description. If you click on details button, it shows as 

a“java.lang.NullPointerException” error. You can ignore this error. No errors are seen in 
end reports due to this error. 

Deploying the New OBIA Web Catalog 

1. Linux Only: Copy the newly merged web catalog back to your linux system so that you can 

load the new catalog. 

2. Load the merged catalog in OBIEE server as follows: 

a. Open WebLogic Enterprise Manager (http:<weblogic_host>:<port>/em). 

b. Navigate to Business Intelligence > Coreapplication > deployment > 

Repository > Catalog Location. 

c. Provide the location of the merged OBIA web catalog. 

d. Restart the WebLogic server. 

Note: Refer the following document to restart the WebLogic server “Oracle® Fusion 

Middleware System Administrator's Guide for Oracle Business Intelligence Enterprise 

Edition11g Release 1 (11.1.1)” section 4 Starting and Stopping Oracle Business 
Intelligence. 
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Updating the GTI Prompts with New Variables 

Finally, you need to change the GTI prompts which have the older variables CURRENT_MONTH, 
CURRENT_WEEK, CURRENT_QUARTER, and CURRENT_YEAR to use the new prompts of 
CURRENT_MONTH_FTI, CURRENT_WEEK_FTI, CURRENT_QUARTER_FTI, and CURRENT_YEAR_FTI as 
defined in the RPD. 

1. Open OBIEE Analytics using the URL http://<obiee_host>:<port>/analytics. 

2. Navigate to Catalog > Shared Folders > GTI Dashboard Prompts. 

3. Edit the following dashboard prompts and change the default variables given there to the FTI 

specific variables of CURRENT_MONTH_FTI, CURRENT_WEEK_FTI, CURRENT_QUARTER_FTI, 

and CURRENT_YEAR_FTI. 

a. /shared/GTI Dashboard Prompts/Export_GTI Period Prompt 

b. /shared/GTI Dashboard Prompts/Import_GTI Period Prompt 

 

Creating New GTI Reports 

It is recommended that you create any new GTI reports by opening the Ad Hoc Query link (Global 
Trade Intelligence > Ad Hoc Query) in a new window. This will allow all OBIEE features to work 
properly.  

The other recommendation is to set up a reverse proxy in OTM/GTM HTTP Server for OBIEE WebLogic 

server as follows. 

Configuring the OTM/GTM HTTP Server's Proxy Settings: 

1. Open OTM/GTM HTTP Server's mod_wl_ohs.conf file. 

2. Insert the following proxy request information into the configuration file: 

 ProxyRequest Off 

 <Proxy*> 

   Order deny,allow 

   Allow from all 

 </Proxy*> 

 Location/Oracle BI EE subdirectory 

   ProxyPass http://location of Oracle BI EE server/ 

      Oracle BI EE subdirectory 

   ProxyPassReverse http://location of Oracle BI EE server/ 

      Oracle BI EE subdirectory 

 /Location 

3. Save and close the configuration file. 

4. Test the configuration by using a fully-qualified name to log into Oracle's OBIEE through 

Oracle HTTP Server. 

 

Installing Other Languages for Oracle GTI 

The translated file for GTI metadata and reports are available as part of an update to 6.3 and these 
files need to be installed as explained in the following sections. 
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Installing Other Languages for Oracle GTI Metadata 

Once you have downloaded the update containing the GTI metadata files for other languages, follow 
the procedure below to install them. 

Note: The other languages content for Oracle GTI metadata will be shipped as csv files with the 

names w_localized_string_g_<lang id>.csv available under the directoy 

<otm_install_path>/glog/oracle/script8/content_advanced_analytics 

1. On the OTM server, go to the directory <otm_install_path>/glog/oracle/script8. 

2. Load other languages for the Oracle GTI metadata data by running update_content_aa. This 

process is run at the host command line rather than from within SQL*Plus. Two command 

scripts are provided and the script you use is dependent on your operating system: 

a. UNIX shell script run: 
 

./update_content_aa.sh <otm_install_path>/glog/config 

b. Windows command line script run: 

 

update_content_aa.cmd <otm_install_path>\glog\config 

3. Review the log file called update_content_aa_<timestamp>.log for errors.  

 

This file is located in the same directory as the SQL script.  
 

Look for errors by searching key words like “ORA-“, “Caught exception”,”SP2-“, or “<Error>“ 

within the log file. 

Installing Other Languages for Oracle GTI Reports 

Once you have downloaded the update containing the GTI report files for other languages, follow the 
procedure below to install them. 

Note: The other languages content for Oracle GTI reports will be shipped as XML files available in 

language-specific folders under the directory 
<otm_install_path>/glog/oracle/script8/content_advanced_analytics. 

1. On the OTM server, go to the directory 

<otm_install_path>/glog/oracle/script8/content_advanced_analytics 

2. Copy the following folders containing the other languages translation XMLs for Oracle GTI 

reports: 

 l_de 

 l_en 

 l_es 

 l_es-mx 

 l_fr 

 l_fr-ca 

 l_it 

 l_ja 

 l_ko 

 l_pt-br 

 l_ru 

 l_zh-cn 
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 l_zh-tw 

3. On the OBIEE server, stop the OBIEE services. 

4. On the OBIEE server, place the copied folders (in Step 2) to the following directory:  

 
ORACLE_INSTANCE\bifoundation\OracleBIPresentationServicesComponent\coreapplicat

ion_obipsn\msgdb\l_xx 

Note: The ‘xx’ in the folder of l_xx may be any language listed above.  For example for 
French, the folder should be l_fr. If this folder does not exist, you should create one as shown 
below: 
instances\instance1\bifoundation\OracleBIPresentationServicesComponent\coreappl

ication_obipsn\msgdb\l_fr 

5. On the OBIEE server, start the OBIEE services. 

After successfully installing the languages for Oracle GTI, use the Language preference under the User 

Preferences in OTM to specify the users preferred language. 
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6. Database Administration 

The contents of this chapter represent our recommendations rather than requirements. When making 
any changes to an OTM database, the DBA should always consider the size and the activity pattern of 

the database, the hardware configurations, and business requirements. 

Initial Setup of Oracle Database 

Initial Parameters 

OTM provides a sample init.ora file with recommended values of some key parameters. These values 
may need to be adjusted according to available physical memory on the database server. As rule of 
thumb, the System Global Area (SGA), or the shared memory of a database, should always be 
allocated in the physical memory for fast data access. If SGA is too large and swapped to disk paging 

will occur. Paging usually overweighs the advantage of having a large SGA. We recommend the 

following values for some of initial parameters. 

DB_BLOCK_SIZE 

8192 (or at least 4096) 

 

DB_16K_CACHE_SIZE 

104857600 (100 MB) 

 

SHARED_SERVERS 

0 

 

 

JOB_QUEUE_PROCESS 

4(This is mandatory since OTM database uses scheduled jobs). 

 

LOG_CHECKPOINT_INTERVAL 

Do not set this parameter if FAST_START_MTTR_TARGET is set. Otherwise set it to 

0 or infinity. 

 

processes = 3000 

# This number affect the number of connections to the database. 

OPEN_CURSORS 

3000 

 

SESSION_CACHED_CURSORS 

100 

 

 

MEMORY_TARGET = 8G 

# MEMORY_TARGET specifies the Oracle system-wide usable memory. The database 

tunes memory to the MEMORY_TARGET value, reducing or enlarging the SGA and PGA 

as needed. 

 

cursor_sharing = FORCE 

# Allows the creation of a new cursor if sharing an existing cursor, or if the 

cursor plan is not optimal. 

 

OPTIMIZER_INDEX_COST_ADJ  

50 

Setting this parameter to encourage optimizer to favor NESTED LOOP over HASH 

JOIN. 
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OPTIMIZER_INDEX_CACHING 

50 

Setting this parameter to encourage optimizer to favor NESTED LOOP over HASH 

JOIN. 

 

STATISTICS_LEVEL 

TYPICAL 

 

query_rewrite_enabled    

true 

For using function based index. 

 

query_rewrite_integrity   

trusted 

For using function based index. 

 

Using Locally Managed Tablespaces 

Oracle Database recommends using locally managed tablespaces for all of OTM tablespaces, including 
SYSTEM tablespace. Locally managed tablespaces can improve performance by eliminating some 
recursive operations during space allocation. 

Initial Redo Log Files  

It is recommended to have three, four, or five redo log groups. Each group should have at least two 
members. We recommend that the initial size of the redo log files be 10 – 20 MB. Once the database 
is in normal operation, especially for a production database, the DBA should monitor the log switch 

frequency. If log switch occurs too often; for example, less than 10 minutes, the size of redo log files 
should be increased. 

Initial Setting of Undo 

Historically, Oracle Database has used rollback segments to manage undo. Space management for 
these rollback segments has proved to be quite complex. In 9i and later, the Oracle Database provides 
UNDO tablespace, another way to manage undoes, UNDO_MANAGEMENT=AUTO. Using this method 
DBAs do not have to deal with the complexities of managing rollback segment space and can exert 
control over how long undo is retained before being overwritten. This is the recommended method for 

OTM. 

If you decide using manual UNDO management you should set up your rollback segments following 
the guideline below. Rollback segments should be designed adequately to reduce contention and 
prevent “snapshot too old” errors. Most of the transactions of an OTM database are small and of OLTP 
type. The number of rollback segments is determined by the number of concurrent transactions in the 
database. For initial settings, the number of rollback segment should be set to at least four. Each 
rollback segments also should have equal size of INITIAL and NEXT extents with MINEXTENTS equals 

to ten. The INITIAL and NEXT extent size can be set to 2 MB. The DBA should periodically monitor the 

rollback segment usage and adjust setting or add new segments, if needed. 

Initial Setup of OTM Database 

There are several schema owners/users and database roles that need to be created in the database. 
Running create_glog_users.sql will get these roles and users created. These two scripts should be run 
by user SYS because there are EXECUTION privileges on SYS’s objects to be granted to OTM database 

users. Most of OTM database objects are under schema GLOGOWNER. OTM database object types 
include, but not limited to: 
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TABLE 

TABLE PARTITION 

INDEX 

INDEX PARTITION 

LOB 

LOB SUBPARTITION 

SEQUENCE 

TRIGGER 

VIEW 

PACKAGE 

PACKAGE BODY 

PROCEDURE 

FUNCTION 

JAVA CLASS 

JAVA SOURCE 

 QUEUE 

 TYPE 

Each OTM application table has a primary key. There are many foreign keys in OTM database to 
guarantee data integrity. Certain database maintenance work such as import may cause foreign keys 

“NOT VALIDATED”. The DBA should make sure the status of the foreign keys are “ENABLED” and 
“VALIDATED”. 

Each application table also has a footprint trigger that populates footprint columns of the table. All of 
the triggers should be “ENABLED”. 

Analyzing Tables/Gathering Statistics 

It is very important that the OTM database tables are analyzed properly. Please refer to the section of 

the Administration Guide titled “Analyzing Tables/Gathering Statistics” for more details. 

Real Application Clusters (RAC) 

OTM may be used in conjunction with Oracle Real Application Clusters. Please refer to the section 
titled “Real Application Clusters (RAC)” in the Administration Guide for more details on how to do that. 
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7. Integrating with Oracle E-Business Suite Financials 

Prior to OTM 6.3.1, OTM had two BPEL processes to perform OTM Voucher to EBS AP Invoices 
Integration. These processes were specific to 10g servers. With OTM 6.3.1, 11g servers are an option, 

so two composites were added to facilitate integration using an 11g server. The integration process is 
to transform an OTM Voucher into an EBS AP Invoice and then directly save it into the EBS database 
without EBS processing the transaction. 

The zip files containing the source code for the processes are found in the utils/integration/bpel/flows 
folder. The utils folder is in the root directory of the OTM installation. Before you deploy to the server, 
read the readme file found in the OtmVoucherToOracleApInvoice_11g.zip file, in the zipped folder: 

OtmVoucherToOracleApInvoice\deploy\README.txt. 

For more information see My Oracle Support document 1546441.1: How to Integrate Oracle 
Transportation Management with Oracle E-Business Suite Financials. 

For a complete list of My Oracle Support documents dealing with OTM-EBS integrations, see 
1546042.1: Integrating Oracle E-Business Suite with Oracle Transportation Management. 
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